Everything’s possible.

DriveWare® 7
User Guide
Setup Software
Operator’s Manual
Preface

ADVANCED Motion Controls constantly strives to improve all of its products. We review the information in this document regularly and we welcome any suggestions for improvement. We reserve the right to modify equipment and documentation without prior notice.

For the latest revision of this manual, visit the company’s website at www.a-m-c.com. Otherwise, contact the company directly at:

ADVANCED Motion Controls • 3805 Calle Tecate Camarillo, CA • 93012-5068 USA

This manual is for the exclusive use of ADVANCED Motion Controls. The reproduction, transmission or use of this document or its contents is prohibited without the expressed written permission of ADVANCED Motion Controls.

© 2018 ADVANCED Motion Controls. All rights reserved.

General Safety

You must install and operate ADVANCED Motion Controls motion control equipment so that you meet all applicable safety requirements. Ensure that you identify the relevant standards and comply with them. Failure to do so may result in damage to equipment and personal injury.

Read this entire manual prior to attempting to install or operate the drive. Become familiar with practices and procedures that allow you to operate these drives safely and effectively. You are responsible for determining the suitability of this product for the intended application. ADVANCED Motion Controls is neither responsible nor liable for indirect or consequential damages resulting from the inappropriate use of this product.

High-performance motion control equipment can move rapidly with very high forces. Unexpected motion may occur especially during product commissioning. Keep clear of any operational machinery and never touch them while they are working.
Keep clear of enclosed units, motor terminals, and transformer terminals when power is applied to the equipment. Follow these safety guidelines:

- Always turn off the main power and allow sufficient time for complete discharge before making any connections to the drive.
- Make sure that the minimum inductance requirements are met. Pulse Width Modulated (PWM) amplifiers deliver a pulsed output that requires a minimum amount of load inductance for proper operation.
- Do not rotate the motor shaft without power. The motor acts as a generator and will charge up the power supply capacitors through the amplifier. Excessive speeds may cause over-voltage breakdown in the power output stage. Note that an amplifier having an internal power converter that operates from the high voltage supply will become operative.
- Do not short the motor leads at high motor speeds. When the motor is shorted, its own generated voltage may produce a current flow as high as 10 times the amplifier current. The short itself may not damage the amplifier but may damage the motor.
- Do not make any connections to any internal circuitry. Only connections to designated connectors are allowed.

*ADVANCED* Motion Controls, the combined isosceles trapezoid/right triangle logo, and DriveWare are either registered trademarks or trademarks of *ADVANCED* Motion Controls in the United States and/or other countries. All other trademarks are the property of their respective owners.

<table>
<thead>
<tr>
<th>Document ID</th>
<th>Revision</th>
<th>Date</th>
<th>Changes</th>
</tr>
</thead>
<tbody>
<tr>
<td>MNGDUMUG-03</td>
<td>5.4</td>
<td>7/8/2008</td>
<td>Manual Format Update</td>
</tr>
</tbody>
</table>
| MNGDUMUG-04 | 5.8.5    | 1/9/2009 | - Updated Command Source window information  
- Updated Commutation window information  
- Added Status Bar section  
- Updated Help menu drive information window Software Version and Display the Drive Information  
- Changed Working with the Stoplight section to Working with the Command Toolbar, and updated Stoplight button references throughout to Enable/Disable and Stop buttons  
- Updated the Digital Oscilloscope section  
- Updated the Tuning and Commutation procedure |
| MNGDUMUG-05 | 7.0      | 7/2012  | - Added Ethernet and USB as connection options when Connecting to the Drive  
- Added Troubleshooting information  
- Added Control Loop Architecture information  
- Changed Positive Target Velocity and Negative Target Velocity event designations to Positive Velocity Limit and Negative Velocity Limit, respectively  
- Added Current Limiting Algorithm information  
- Updated Current Limits information  
- Updated Digital Inputs information  
- Added Capture Panel information  
- Updated Digital Outputs information  
- Added Network Settings information  
- Added PDO Configuration information  
- Updated for new interface structure |
| MNGDUMUG-06 | 7.1      | 6/2013  | - Added Restricted R/W Mode as an Interface Access Control Option  
- Updated Current Loop Tuning procedure for AC Induction motors  
- Added information for Absolute Encoder (BiSS C-Mode) Feedback Parameters  
- Added information for Custom Biquad Filters |
<table>
<thead>
<tr>
<th>Document ID</th>
<th>Revision</th>
<th>Date</th>
<th>Changes</th>
</tr>
</thead>
</table>
| MNDGDWUG-07  | 7.2      | 4/2014  | - Added Programmable Limit Switch information  
- Added Sequences information  
- Added Extended I/O information  
- Updated Phase Detect information |
| MNDGDWUG-08  | 7.3.0    | 3/2015  | - Updated Motor Parameters information for EnDat 2.2  
- Updated Motor Parameters information for velocity divider feature |
| MNDGDWUG-09  | 7.3.2    | 7/2015  | - Software position limits ignored during homing                                           |
| MNDGDWUG-10  | 7.4      | 10/2017 | - Updated Manual Commutation Procedure information  
- Updated Motor Parameters section for Motor Database information  
- Added Advanced Commutation information  
- Added Motor Diagnostics information  
- Added Manage Motor Database information  
- Updated Dynamic Help information |
| MNDGDWUG-11  | 7.4.1    | 1/2018  | - Added DriveLibrary as a selectable Command Source option  
- Updated Resolver Feedback Parameters information |
| MNDGDWUG-12  | 7.4.2    | 5/2018  | - Added Stepper motors as a selection option for motor type  
- Updated information on Absolute Encoder (BiSS C-Mode) Feedback Parameters |
1 Introduction

1.1 Getting Started ................................................. 2
  1.1.1 Software Files ........................................... 2
  1.1.2 Workspace Display ........................................ 2
    Menu Bar and Associated Toolbar Icons ..................... 3
    System Browser .............................................. 4
    Status Panel ............................................... 4
    Dynamic Help Browser ..................................... 4
    Status Bar .................................................. 4
    Caption Bar ................................................. 5
1.2 Using the Setup Software ..................................... 6
  1.2.1 Opening a File ........................................... 6
  1.2.2 Working with the Drive .................................. 6
    Naming the Drive .......................................... 6
    Connecting to the Drive .................................... 6
    Disconnecting from the drive ................................ 7
  1.2.3 Hot Key .................................................. 7
  1.2.4 Working with the Command Toolbar .................... 8
  1.2.5 Working with the Setup Software Windows .......... 9
    Showing/hiding the Toolbars and Caption Bar ............ 9
    Showing/hiding Panels ..................................... 9
    Arranging the Windows ..................................... 9
1.3 Getting Help .................................................. 10
  1.3.1 Dynamic Help ........................................... 10
  1.3.2 Technical Support ....................................... 10
    Software Version ........................................... 10
    Display the Drive Information ............................ 10
1.4 Saving Your Setup ............................................ 11
  1.4.1 Storing the Changes onto the Drive .................... 11
## 1.4.2 Saving the Project File onto Your Computer  
## 1.5 Exiting the Program

## 2 Connecting to the Drive  

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.1 Connecting to the Drive</td>
<td>13</td>
</tr>
<tr>
<td>2.2 Changing Communication Parameters</td>
<td>14</td>
</tr>
</tbody>
</table>

## 3 Configuring the Drive  

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>3.1 Configuration</td>
<td>16</td>
</tr>
<tr>
<td>3.1.1 Command Source</td>
<td>16</td>
</tr>
<tr>
<td>3.1.2 Command Limiter</td>
<td>19</td>
</tr>
<tr>
<td>3.2 Loop Feedback</td>
<td>20</td>
</tr>
<tr>
<td>3.2.1 Velocity Feedback Source</td>
<td>20</td>
</tr>
<tr>
<td>3.2.2 Position Feedback Source</td>
<td>20</td>
</tr>
<tr>
<td>Auxiliary Encoder Input</td>
<td>20</td>
</tr>
<tr>
<td>Auxiliary Encoder Parameters</td>
<td>20</td>
</tr>
<tr>
<td>3.3 Power-up Settings</td>
<td>21</td>
</tr>
<tr>
<td>3.4 Motor Parameters</td>
<td>22</td>
</tr>
<tr>
<td>3.4.1 Motor Selection</td>
<td>22</td>
</tr>
<tr>
<td>3.4.2 Motor Parameters</td>
<td>22</td>
</tr>
<tr>
<td>3.4.3 Feedback Type</td>
<td>24</td>
</tr>
<tr>
<td>3.4.4 Commutation</td>
<td>27</td>
</tr>
<tr>
<td>3.4.5 Braking</td>
<td>27</td>
</tr>
<tr>
<td>3.4.6 Motor Database</td>
<td>28</td>
</tr>
<tr>
<td>Manage Motor Database</td>
<td>28</td>
</tr>
<tr>
<td>3.5 AutoCommutation</td>
<td>30</td>
</tr>
<tr>
<td>3.6 Encoder Output</td>
<td>31</td>
</tr>
<tr>
<td>3.7 Inputs / Outputs</td>
<td>32</td>
</tr>
<tr>
<td>3.7.1 Analog Inputs</td>
<td>32</td>
</tr>
<tr>
<td>3.7.2 Analog Outputs</td>
<td>33</td>
</tr>
<tr>
<td>3.7.3 Digital Inputs</td>
<td>33</td>
</tr>
<tr>
<td>3.7.4 Digital Outputs</td>
<td>36</td>
</tr>
<tr>
<td>3.7.5 Extended I/O</td>
<td>36</td>
</tr>
<tr>
<td>3.7.6 Programmable Limit Switch</td>
<td>37</td>
</tr>
<tr>
<td>3.8 Limits</td>
<td>38</td>
</tr>
<tr>
<td>Section</td>
<td>Page</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>3.8.1 Current Limits</td>
<td>38</td>
</tr>
<tr>
<td>3.8.2 Velocity Limits</td>
<td>39</td>
</tr>
<tr>
<td>3.8.3 Position Limits</td>
<td>39</td>
</tr>
<tr>
<td>3.8.4 Stop</td>
<td>39</td>
</tr>
<tr>
<td>3.8.5 Voltage Limits</td>
<td>40</td>
</tr>
<tr>
<td>3.8.6 Temperature Limits</td>
<td>42</td>
</tr>
<tr>
<td>3.9 Events</td>
<td>43</td>
</tr>
<tr>
<td>3.9.1 Basic Events</td>
<td>44</td>
</tr>
<tr>
<td>3.9.2 Advanced Events</td>
<td>44</td>
</tr>
<tr>
<td>3.10 Network Settings</td>
<td>45</td>
</tr>
<tr>
<td>3.11 PDO Configuration</td>
<td>46</td>
</tr>
<tr>
<td>3.11.1 RPDOs - CAN Drive</td>
<td>46</td>
</tr>
<tr>
<td>3.11.2 TPDOs - CAN Drive</td>
<td>46</td>
</tr>
<tr>
<td>3.11.3 TPDO Events - CAN Drive</td>
<td>47</td>
</tr>
<tr>
<td>3.11.4 RPDOs and TPDOs - Ethernet Powerlink or EtherCAT</td>
<td>47</td>
</tr>
<tr>
<td>3.12 Tuning</td>
<td>48</td>
</tr>
<tr>
<td>3.12.1 Current Loop Gains</td>
<td>48</td>
</tr>
<tr>
<td>3.12.2 Gain Sets</td>
<td>48</td>
</tr>
<tr>
<td>Set Position</td>
<td>49</td>
</tr>
<tr>
<td>3.12.3 Filters</td>
<td>49</td>
</tr>
<tr>
<td>Velocity Feedback</td>
<td>49</td>
</tr>
<tr>
<td>Custom</td>
<td>49</td>
</tr>
<tr>
<td>3.12.4 Advanced Settings</td>
<td>50</td>
</tr>
</tbody>
</table>

4 Tuning and Commutation

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>4.1 Current Loop Tuning</td>
<td>53</td>
</tr>
<tr>
<td>Step 1: Inputs/Outputs Configuration setup</td>
<td>53</td>
</tr>
<tr>
<td>Step 2: Waveform Generator Setup</td>
<td>53</td>
</tr>
<tr>
<td>Step 3: Oscilloscope setup</td>
<td>53</td>
</tr>
<tr>
<td>Step 4: Tuning</td>
<td>54</td>
</tr>
<tr>
<td>Step 5: (For AC Induction Motors Only) Flux Reference Loop - Waveform Generator Setup</td>
<td>55</td>
</tr>
<tr>
<td>Step 6: (For AC Induction Motors Only) Flux Reference Loop - Oscilloscope Setup</td>
<td>55</td>
</tr>
<tr>
<td>Step 7: (For AC Induction Motors Only) Flux Reference Loop - Tuning</td>
<td>55</td>
</tr>
<tr>
<td>Step 8: (For AC Induction Motors Only) Commutation</td>
<td>56</td>
</tr>
<tr>
<td>4.2 Commutation</td>
<td>57</td>
</tr>
</tbody>
</table>
4.2.1 AutoCommutation™ ........................................ 57
  AutoCommutation™ Warnings .............................. 58
4.2.2 Manual Commutation Procedure .................. 59
  Setting over speed limits ................................. 59
  Performing Manual Commutation (Incremental Encoder,
   Sin/Cos Encoder) ........................................ 60
  Performing Manual Commutation (Absolute Encoder - BiSS,
   EnDat, Hiperface) ...................................... 61
  Re-Setting Over Speed Limits ............................ 61
4.2.3 Advanced Commutation ............................... 62
4.2.4 Phase Detect ............................................ 62
4.3 Velocity Loop Tuning .................................... 64
  Step 1: Waveform Generator setup ...................... 64
  Step 2: Oscilloscope setup .............................. 64
  Step 3: Tuning ............................................. 64
4.4 Position Loop Tuning .................................... 66
  Step 1: Waveform Generator setup ...................... 66
  Step 2: Oscilloscope setup .............................. 67
  Step 3: Tuning ............................................. 67

5 Motion Tasks .............................................. 68

5.1 Motion Tasks ............................................. 69
  5.1.1 Homing ............................................... 69
  5.1.2 Indexes ............................................... 71
    Executing an Index Task ............................... 71
    Dynamic Indexes ....................................... 72
  5.1.3 PVT .................................................. 73
    How To Construct A PVT Points File .................. 73
  5.1.4 Jogs ................................................. 75
    Executing a Jog Task .................................... 75
  5.1.5 Sequences ............................................ 75

6 Downloading the Firmware ............................. 78

  6.1 Prepare for Download .................................. 78
  6.2 Open the Firmware Download Window ................ 78
  6.3 Downloading the Firmware ............................ 79
A Tools and Functions

A.1 Digital Oscilloscope ................................................. 80
  Channel Select ....................................................... 80
  Presets .............................................................. 81
  Display ............................................................. 81
  Trigger ............................................................... 81
  Measure .............................................................. 81
  A.1.1 Waveform Generator ........................................... 82
  A.1.2 Data Capture .................................................. 82
A.2 Multimeter .......................................................... 84
A.3 User Units .......................................................... 85
A.4 Motion Panel ....................................................... 86
  Indexes ............................................................... 86
  Dynamic Index ....................................................... 86
  Jog ................................................................... 86
  PVT ................................................................. 86
  Motion Status ....................................................... 87
A.5 Motor Diagnostics .................................................. 87
  Procedure Settings ................................................ 87
A.6 Signal Definitions ................................................ 88
  Current measurements .............................................. 88
  Velocity measurements ............................................ 88
  Position measurements ............................................ 89
  Commutation ....................................................... 89
  Voltage ............................................................. 89
  Command Limiter ................................................... 89
  Temperature ......................................................... 89
  Torque ............................................................. 90
  Drive ............................................................... 90
  Feedback ........................................................... 90
  Interface Input ..................................................... 90
  Deadband Input ..................................................... 90
  PWM Input .......................................................... 90
  PLS ................................................................. 90
  Capture ............................................................. 91
A.7 Drive Status ....................................................... 92
A.8 Critical Event Activity ........................................... 93
A.9 Event Counters .................................................... 93
B  Current Limiting

B.1 Understanding the Limit Envelope .................................. 94
B.2 Current Limiting Algorithm ........................................ 98
   B.2.1 Time-Based Peak Current Limiting .............................. 99
   B.2.2 Time-Based Non-Peak Current Limiting ....................... 100
   B.2.3 Time-Based Current Recovery .................................. 101
   B.2.4 Charge-Based Peak Current Limiting ......................... 102
   B.2.5 Charge-Based Non-Peak Current Limiting .................... 103
   B.2.6 Charge-Based Current Recovery ................................ 104
   B.2.7 RMS Current Scaling ........................................... 105
B.3 Calculating Current Limits .......................................... 106
   B.3.1 Example 1: Foldback Current ................................. 107
   B.3.2 Example 2: Peak Current Recovery ......................... 108

C  Control Loop Architecture ............................................ 109

D  Filtering Velocity Feedback ........................................... 111

D.1 Effects of the Feedback Filter ...................................... 112
   D.1.1 Cutoff Frequency Set to Infinite ............................... 112
   D.1.2 Cutoff Frequency Set to 300Hz ................................. 112
   D.1.3 Cutoff Frequency Set to 50Hz .................................. 113
   D.1.4 Cutoff Frequency Set to 10Hz .................................. 113
D.2 Conclusion .............................................................. 113

E  Troubleshooting .......................................................... 114

E.1 Setup Software Safety Actions ...................................... 114
E.2 Potential External System Errors ................................... 114
E.3 Events and I/O Descriptions and Troubleshooting Methods .. 115
This document provides instructions on how to use the setup software to connect to, set up and control digital servo drives.

These instructions walk you through the commissioning steps necessary to set drive limits, tune the current, velocity, and position control loops, and assign automated functions to drive events.

The following major sections are covered:

- “Connecting to the Drive” on page 12
- “Configuring the Drive” on page 15
- “Tuning and Commutation” on page 51

Follow the procedures in this chapter to get an overview of many functions. Familiarize yourself with the files on your computer, the software workspace and controls of the software. Later chapters provide more details in using these functions.

Before proceeding, you must accomplish the following actions:

- Read the release notes and installation text files for your setup software version.
- Install the setup software.
1.1 Getting Started

After installing the setup software on your computer, you can run the application from your Start > Programs menu or desktop icon.

When you first start the setup software, you see the following choices:

- **Open** - This will allow you to browse through the files on your computer to select a previously saved project file to open, without having to connect to a drive. The project can then be configured or modified before downloading the project file into a drive.
- **Connect** - This will allow you to immediately connect to a drive. The drive can then be set up and configured for operation, and the information saved as a project file.

1.1.1 Software Files

Look in the folder in which you placed the application; by default, this location is under C:\Program Files. This folder includes the subdirectories:

- **MotorDB** holding a library of *.xml database files making up the motor database.
- **My Firmware Files** holding a library of *.aff firmware files for various drives.
- **My Projects** holding a library of *.adf project files, each with the parameters and controls specific to a particular drive-and-motor setup.

1.1.2 Workspace Display

The software provides functions, tools and status to help you set up your drive.
## Menu Bar and Associated Toolbar Icons

At the top of the screen are pull down menus and a toolbar for access to many tools and functions.

<table>
<thead>
<tr>
<th>Function</th>
<th>Menu Pull-down</th>
<th>Toolbar</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open a project file</td>
<td>File &gt;</td>
<td>Open Project</td>
<td>Ctrl+O</td>
</tr>
<tr>
<td>Save a project file to PC</td>
<td></td>
<td>Save Project</td>
<td>Ctrl+S</td>
</tr>
<tr>
<td>Save a project file as a file name</td>
<td></td>
<td>Save Project As...</td>
<td>- - -</td>
</tr>
<tr>
<td>Apply changes made to active window</td>
<td></td>
<td>Apply Changes</td>
<td>Ctrl+L</td>
</tr>
<tr>
<td>Automatically apply changes made</td>
<td></td>
<td>Auto Apply</td>
<td>Ctrl+U</td>
</tr>
<tr>
<td>Close the program</td>
<td></td>
<td>Exit</td>
<td>Alt+F4</td>
</tr>
<tr>
<td>Power up or down the bridge</td>
<td>Drive &gt;</td>
<td>Enable</td>
<td>Alt+E</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Disable</td>
<td>Alt+D</td>
</tr>
<tr>
<td>Allow motion to occur or disallow motion by sending a Stop command</td>
<td></td>
<td>Motion Ready</td>
<td>Alt+G</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Stop Motion</td>
<td>Alt+P</td>
</tr>
<tr>
<td>Change the active Configuration</td>
<td></td>
<td>Switch Configurations</td>
<td>Alt+C</td>
</tr>
<tr>
<td>Change the active Gain Set</td>
<td></td>
<td>Switch Gains</td>
<td>Alt+A</td>
</tr>
<tr>
<td>Connect to the drive or change connection settings once connected</td>
<td></td>
<td>Connect</td>
<td>Ctrl+N</td>
</tr>
<tr>
<td>Disconnect from the drive</td>
<td></td>
<td>Disconnect</td>
<td>Ctrl+D</td>
</tr>
<tr>
<td>Store project on the drive</td>
<td></td>
<td>Store to drive</td>
<td>Alt+O</td>
</tr>
<tr>
<td>Upload settings from drive</td>
<td></td>
<td>Restore from drive</td>
<td>- - -</td>
</tr>
<tr>
<td>Update drive firmware</td>
<td></td>
<td>Firmware Download</td>
<td>- - -</td>
</tr>
<tr>
<td>Display drive information</td>
<td></td>
<td>About Drive</td>
<td>- - -</td>
</tr>
<tr>
<td>Turn the Motion Engine on or off</td>
<td>Motion Engine &gt;</td>
<td>On</td>
<td>Alt+R</td>
</tr>
<tr>
<td>Reset the Motion Engine</td>
<td></td>
<td>Reset</td>
<td>Ctrl+R</td>
</tr>
<tr>
<td>Open the Scope/Tuning tool</td>
<td>Tools &gt;</td>
<td>Scope/Tuning</td>
<td>Ctrl+E</td>
</tr>
<tr>
<td>Open the Multimeter tool</td>
<td></td>
<td>Multimeter</td>
<td>Ctrl+M</td>
</tr>
<tr>
<td>Brings up the Motion Panel window.</td>
<td></td>
<td>Motion Panel</td>
<td>Ctrl+T</td>
</tr>
<tr>
<td>Assign the Disable Drive Hotkey</td>
<td>Settings &gt;</td>
<td>Hot Key Settings</td>
<td>- - -</td>
</tr>
<tr>
<td>Open the User Units window</td>
<td></td>
<td>User Units</td>
<td>Ctrl+R</td>
</tr>
</tbody>
</table>
System Browser  Navigate between the setup windows to configure the drive. Each panel contains multiple headings for specific drive parameters. Select a configuration item from the System Browser to open a window in the main workspace display.

Status Panel  The Status Panel provides real-time information on drive events and actions.

- **Drive Status** - Shows drive events (current and history) and is a useful troubleshooting tool.
- **Critical Event Activity** - Lists drive faults and fault events along with the time they occurred.
- **Event Counters** - Lists the number of times faults have occurred since the drive has been in operation.

Dynamic Help Browser  Dynamic Help tracks user movements through the software workspace and automatically navigates to the appropriate Help topic in the list. Select a topic from the Dynamic Help Panel to open a new tab with the Help information. The Dynamic Help automatic tracking feature can be toggled on or off by clicking the Pause button in the Help Browser pane. The Back and Forward buttons will navigate between previously viewed Help Topics.

Status Bar  The Status Bar provides information on the drive configuration, bridge state, connection status, and accessibility. From left to right across the bottom of the workspace window, the Status Bar provides information on:

- **Motion** - Displays motion tasks the drive is currently performing when the motion engine is enabled. Will be blank if no task is currently active.
  - **Config 0**: Configuration 0 is currently selected, and no autonomous modes are active.
  - **Config 1**: Configuration 1 is currently selected, and no autonomous modes are active.
  - **Ready**: Motion Engine is on and the drive is ready to receive commands from the Motion Engine. No motion tasks are currently active.
  - **Home**: Drive is actively in homing mode.
  - **Jog**: Drive is actively in jog mode.
  - **Index (# or name)**: Drive is running an index.
— **Waveform:** The Waveform Generator is controlling the axis.
— **AutoComm:** The AutoCommutation process is controlling the axis.

• **Bridge** - Shows the status of the drive.
  — **Enabled:** Drive is enabled (note that a Stop condition is considered enabled).
  — **Disabled:** Drive is disabled (note that a Dynamic Brake condition is considered disabled).

• **Action** - Shows the present bridge action as the result of a drive or system event. Hovering the mouse pointer over the Action status will display the event causing the action.
  — **Bridge Disabled:** The bridge is disabled.
  — **Negative Disabled:** Disable negative direction action is active.
  — **Positive Disabled:** Disable positive direction action is active.
  — **Dynamic Braking:** Dynamic brake action is active.
  — **Negative Stopped:** Negative stop is active.
  — **Positive Stopped:** Positive stop is active.
  — **Stopped:** Stop is active.

• **Comm** - Shows whether the setup software is connected to a drive. Hovering the mouse pointer over the Connection status of a connected drive will provide information about the connection type.
  — **Connected:** Software is connected to a drive.
  — **Not Connected:** Software is not connected to a drive.

• **Access** - Shows whether the setup software has full control or monitoring access. Will be blank if the drive is not connected.
  — **Read/Write:** The drive is connected and the software has Read/Write access (full control).
  — **Read-Only:** The drive is connected and the software has Read-Only access (monitoring only).

**Caption Bar**  
Displays details about the current drive configuration.

• **Command** - Shows the present Command Source (either as configured in the active Configuration window or as selected for motion, tuning, waveform, or commutation functions).

• **Gains** - Displays the presently selected Gain Set.
  — **Set 0:** Gain Set 0 is active.
  — **Set 1:** Gain Set 1 are active.

• **Loop Configuration** - Displays the present loop configuration.
  — **Position Around Velocity:** All loops are enabled.
  — **Position Around Current:** Only the position and current loops are enabled.
  — **Velocity:** Only the velocity and current loops are enabled.
  — **Current:** Only the current loop is enabled.

• **Velocity Feedback** - Shows the present velocity feedback device as configured in the Feedback window.

• **Position Feedback** - Shows the present position feedback device as configured in the Feedback window.
1.2 Using the Setup Software

The setup software provides many tools to configure and monitor the settings for the drive. Later chapters go into detail about these tools, but briefly, this section describes how to:

- Open a project file
- Name the drive
- Connect to and disconnect from the drive
- Enable and disable the power bridge
- Set the drive behavior when you disable the power bridge
- Use a Hot Key to disable the power bridge
- Show and hide the toolbars
- Move, scroll and arrange the windows

1.2.1 Opening a File

The setup software must be disconnected from the drive before performing this task.

1. To open an existing project file from your computer, perform one of the following actions
   - Select File > Open on the main menu bar.
   - Click on the Open icon on the tool bar.
2. Browse your computer to the My Projects subdirectory or wherever your project files are saved, and select a project (.adf extension).

Once opened, you can connect to the drive and if the configuration settings in the drive don’t match the configuration settings in the setup software, you can choose to either download the project file configuration settings into the drive, or upload the configuration settings from the drive into the setup software. For more information, see “Connecting to the Drive” on page 12.

1.2.2 Working with the Drive

There are several tasks you must accomplish to configure and set up the drive. Later chapters go into detail about these tasks.

**Naming the Drive** The Drive Name data field allows you to assign a unique name to the drive (such as "X-Axis"). You may enter a name up to 32 characters.

1. Select Settings from the [DriveName] heading in the System Browser.
2. In the data field, type the name of the drive.
3. Click on the OK button.

**Connecting to the Drive** You must start communicating with the drive before performing any configuration and setup. Choose one of these actions:

- Select Drive > Connect on the main menu bar.
- Click on the Connect icon on the tool bar.
When you connect, you decide whether to upload the configuration settings currently in the drive or download the current project from the setup software into the drive.

While connected to the drive, the status bar in the lower, right-hand corner of the workspace reads CONNECTED and you can perform most configuration tasks.

See “Connecting to the Drive” on page 12 for more information.

**Disconnecting from the drive**  
When it is time to stop communicating with the drive, you must disconnect from the drive. Choose one of these actions:

- Select Drive > Disconnect on the main menu bar.
- Click on the Disconnect icon 🛠️ on the tool bar.

After terminating communication with the drive, the status bar in the lower, right-hand side of the workspace reads NOT CONNECTED.

### 1.2.3 Hot Key

The Hot Key Settings window allows you to select the behavior associated with a specified Hot Key. It does not apply to user inhibits or event-related inhibits. Select Settings > Hot Key Settings on the main menu bar.

This window allows you to assign a Hot Key to either disable the bridge or stop motion.

<table>
<thead>
<tr>
<th>Disable Bridge</th>
<th>The Hot Key will issue a Software Disable. The action associated with a Software Disable may be specified in the Events window.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stop Motion</td>
<td>The Hot Key will issue a Stop command*.</td>
</tr>
</tbody>
</table>

*Stop behaves differently depending which mode the drive is in. For current mode, Stop will command zero current. For velocity mode, Stop will decelerate and command a zero velocity. For Position mode, Stop will decelerate and hold position.

When you press the Hot Key, it is the same action as disabling the drive or stopping motion through the Menu Bar or clickable icons on the Command Toolbar. You can use the Hot Key at any time. However, if the Hot Key is set to Stop Motion, it will have no function if the drive is already disabled. To assign keystrokes for the Hot Key:

1. Select Settings > Hot Key Settings from the menu bar.  
   This action displays a window allowing you to reassign the key combinations.
2. Make sure the cursor is placed in the edit box.
3. Press any of the function keys (F2-F12).
4. Click the OK button.
1.2.4 Working with the Command Toolbar

The Command Toolbar has four main functions:

- Controls whether the power bridge circuit is enabled or disabled
- Controls whether the drive is ready to respond to motion commands.
- Switches between user configurations
- Switches between gain sets

In later chapters, when you actually enable the bridge, the motor will have power and can move. You must take care so as to avoid damage to equipment or injuries to people.

**Command Toolbar Buttons**

<table>
<thead>
<tr>
<th>Icon</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Enable" /></td>
<td>Enable Drive</td>
<td>Clicking on the Enable Button will send an Enable instruction to the drive. If there are no active errors or digital inputs causing the bridge to be disabled, the bridge will become enabled, allowing the drive to react to motion commands.</td>
</tr>
<tr>
<td><img src="image" alt="Disable" /></td>
<td>Disable Drive</td>
<td>Clicking on the Disable Button will send a Software Disable instruction to the drive. If the bridge was enabled prior to clicking the button, the bridge will be disabled. This action will turn off the power bridge circuit. The Stop/Allow Motion button is greyed out when the drive is disabled. You may configure events to automatically disable the bridge from within the Events window.</td>
</tr>
<tr>
<td><img src="image" alt="Motion" /></td>
<td>Motion</td>
<td>Clicking on the Motion Button will release the drive from the stopped state. This action allows the drive to react to motion commands. In order to perform functions in the setup software such as Phase Detect, AutoCommutation, and tuning tasks, motion must be enabled. Keep in mind that when the drive has been set to allow motion commands, the drive is software enabled, but a hardware event (digital input, invalid hall state, etc.) could still prevent motion.</td>
</tr>
<tr>
<td><img src="image" alt="Stop" /></td>
<td>Stop</td>
<td>Clicking on the Stop Button will send a Stop instruction to the drive. This action prevents the drive from sending motion commands to the motor such that no movement is allowed to occur. Note that stopping motion is not the same as disabling the power bridge. The bridge will still be enabled when motion has been stopped. The behavior of a Stop command depends on the mode of operation the drive is in. If the drive is controlling velocity or position, the motor will decelerate according to the deceleration limit (specified in the Stop window). When the motor has decelerated to zero speed, it will continue to servo in this state until the Stop is released or the bridge becomes disabled. If the drive is controlling current, activating the Stop will issue a zero current command to the drive. A zero current command will continue until the Stop is released or the bridge becomes disabled. You may configure events to automatically Stop motion from within the Events window.</td>
</tr>
<tr>
<td><img src="image" alt="Configuration" /></td>
<td>Switch Active Configuration</td>
<td>Clicking on the Switch Active Configuration button will change the active user configuration from Configuration 0 to Configuration 1, or vice versa. Settings for the user configurations can be configured under Configuration 0 or Configuration 1 in the System Browser. The Caption Bar will display the currently active user configuration.</td>
</tr>
<tr>
<td><img src="image" alt="Gain Set" /></td>
<td>Switch Active Gain Set</td>
<td>Clicking on the Switch Active Gain Set button will change the active gain set from Gain Set 0 to Gain Set 1, or vice versa. Values for the gain sets can be input under Tuning &gt; Gain Set 0 or Gain Set 1 in the System Browser. The active gain set can also be assigned in the user configuration windows.</td>
</tr>
</tbody>
</table>
1.2.5 Working with the Setup Software Windows

The setup software allows for customization of the workspace display for selected features.

**Showing/hiding the Toolbars and Caption Bar**  To allow more room in the workspace, you can hide the Toolbar icons and Caption Bar. It is recommended to leave the Toolbars and Caption Bar visible.

To show/hide the toolbars:

1. Select *View > Toolbars* on the main menu bar.
2. Select or deselect the desired Toolbars, depending on your preference.
3. Alternatively, select the drop-down arrow at the end of each portion of the Toolbar, and using the Add or Remove Buttons option, choose which icons and customization selections to have visible.
4. Each portion of the Toolbar can also be dragged off into a floating menu by clicking and dragging on the Toolbar handle for each portion.

To show/hide the Caption Bar:

1. Select *View > Caption Bar* to show/hide the Caption Bar.

**Showing/hiding Panels**  To allow more room in the workspace, you can hide the System Browser, Status Panel, and the Dynamic Help panel. It is recommended to leave all the panels visible.

1. Select *View > System Browser* or *View > Status Panel* to show/hide the System Browser or Status Panel, respectively.
2. Select *Help > Dynamic Help* to show/hide the Dynamic Help panel.

**Arranging the Windows**

- To arrange open windows into a tabbed group, select either *New Vertical Tab Group* or *New Horizontal Tab Group* from the *Window* menu. Note that not all windows are able to be arranged into tabbed groups. Typically it is recommended to use the tabbed grouping option to allow the digital oscilloscope to be visible with the active gain set window to allow for real-time gain adjustments. It is also helpful to have the Dynamic Help Browser open in a tabbed group to provide useful information based on the active window.
- To close all open tabs, select *Windows > Close All Tabs* on the main menu bar.
- To re-arrange all toolbars and panels to their default locations, select *Windows > Reset Window Layout* on the main menu bar.
1.3 Getting Help

The Help topics offer assistance with the setup software. “Troubleshooting” on page 114 in this manual also offers descriptions and recommended troubleshooting techniques for some common issues.

To open the help documentation, either:

- Select Help > Help... on the main menu bar.
- Press the F1 key.

1.3.1 Dynamic Help

The Dynamic Help panel offers a direct link to the Help file topic associated with the active software window. Clicking on certain items or opening certain windows will automatically shift the Dynamic Help index to the appropriate topic. Click on the topic to open a tab containing help information.

The Dynamic Help automatic tracking feature can be toggled on or off by clicking the Pause button in the Help Browser pane. The Back and Forward buttons will navigate between previously viewed Help Topics.

Alternatively, users can navigate manually through the help index in the Help Browser panel to find the desired help topic.

1.3.2 Technical Support

If you need to contact technical support with a problem or question, please have this information readily available.

**Software Version** To display the version number of your copy of the setup software, select Help > About... on the main menu bar.

**Display the Drive Information** To display information about the drive's internal hardware and software, select Drive > About Drive from the menu bar. In the Drive Information window, click the button in the lower right corner of the window to expand/collapse detailed drive information.
1.4 Saving Your Setup

After you have configured your drive, be certain to save all parameters and settings.

1.4.1 Storing the Changes onto the Drive

The setup software must be connected to the drive before performing this task.

After you configure and adjust the drive’s settings, use the store function. The drive settings stored in the drive’s nonvolatile memory (NVM) are used by the drive after an off-on power cycle.

To save the current drive settings in nonvolatile memory, you would either:

• Select Drive > Store to Drive on the main menu bar.
• Click on the Store icon on the tool bar.

1.4.2 Saving the Project File onto Your Computer

Use this command to save the active configuration project file to its current name and directory. When you save a project for the first time, the software displays the Save As dialog box so you can name your project.

To overwrite your project file on the computer with your current changes in the setup software, you would either:

• Select File > Save on the main menu bar.
• Click on the Save icon on the tool bar.

If you want to change the name and directory of an existing project file before you save it, choose the Save As command.

1. Select File > Save as on the main menu bar.
2. Enter a file name in the dialog box.

1.5 Exiting the Program

Use this command to end your configuration session. To exit the program, either:

• Select File > Exit on the main menu bar.
• Double-click on the upper left corner of the main window.

The software will prompt you to save documents with unsaved changes.

— Apply Changes to Drive - Apply changes to the drive before exiting
— Save Project to File- Saves the current project file to the PC before exiting.
— Store Changes to the Drive NVM - Saves the current project settings to the drive non-volatile memory before exiting.
Before proceeding, you must accomplish the following actions:

- Read the data sheet for the drive and the specification sheet for the motor and be familiar with their capabilities.
- Cable your computer to the drive.
- Wire the drive to the motor.
- Provide electrical power to the drive; the drive, in turn, provides power to the motor.
2.1 Connecting to the Drive

When you first start the setup software, you see the following choices:

1. Select **Connect**.

The Connect To Drive window appears when Connect is selected from the opening window. You must initially connect to the drive using the factory default settings stored in nonvolatile memory. Once the communication settings have been configured, click **Connect**.

<table>
<thead>
<tr>
<th>Option</th>
<th>Connect To Drive Window Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>RS232</strong></td>
<td><strong>RS485</strong></td>
</tr>
<tr>
<td>Drive Address</td>
<td>63</td>
<td>63</td>
</tr>
<tr>
<td>Baud Rate*</td>
<td>115200</td>
<td>115200</td>
</tr>
<tr>
<td>Serial Port</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Communication Interface</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Interface Access Control</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Auto Detect (RS232/RS485 communication only)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>USB Device (USB communication only)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>IP Address (Ethernet communication only)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Connect</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Restore Defaults</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Help</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

If the drive has previously been configured, these settings may have changed. If connecting fails while attempting to connect over RS232, click on the Auto Detect button.
2.2 Changing Communication Parameters

Once communication is established, you may change interface settings.

1. Choose one of the following actions:
   - Select Drive > Connect from the menu bar.
   - Click on the Connect icon on the tool bar.

2. Choose your desired settings.

3. Click the OK button.

The new settings take effect immediately. In order to retain the new settings upon power-up, they must be stored in the drive’s nonvolatile memory (see “Storing the Changes onto the Drive” on page 11.)
3 Configuring the Drive

Before proceeding, you must accomplish the following actions:

- Wire the drive to the motor.
- Connect your computer to the drive.
- Use the setup software to successfully recognize the drive.

Configuration requires you to decide upon several parameters for your drive based on the requirements of your application. The drive must have information about scale factors, feedback devices, motor parameters, and limits. The setup software provides windows for you to:

- Enter the motor constants.
- Configure the primary feedback.
- Assign the user units of measurements.
- Decide which analog and digital signals will provide input and output for the drive.
- Set the limits for temperature, current, voltage, velocity and position and decide options for power-up and brake/stop behavior.
- Specify the command source.

All these parameters are collected in a project file. You can save several project files on your computer (they have the *.adf extension). From your computer, a file can be downloaded to—or uploaded from—the drive. Once in the drive, you must store the file in the drive’s non-volatile memory.

This chapter discusses each setup software window and function. Once you have completed configuration, the drive will be ready for tuning and commutation.

The Restore function loads into your computer’s project file the parameters stored in the drive’s non-volatile memory. Use Restore when you wish to revert back to the parameters last stored in the drive if you find your recent changes result in poor performance.

Select Drive > Restore from drive on the main menu bar.
3.1 Configuration

The Configuration windows are used for defining the Loop Configuration, Gain Set and Command Source and allows two separate configurations to be saved for mode switching purposes. Open the desired configuration window by selecting [DriveName] > Configuration 0 or Configuration 1. Note that Mode Switching must be enabled in order for Configuration 1 to be available to edit. Mode Switching can be enabled in the Drive Settings window ([DriveName] > Settings) by checking the Enable Second Configuration checkbox. Typically it is only necessary to define the parameters for one configuration, but for systems where switching between two configurations is desired, the setup software can switch between Configuration 0 and Configuration 1 in any of the following ways:

- Use the Switch Config icon on the Toolbar
- Set up the Digital Inputs to switch Configurations
- Configure the Power-up Settings to switch Configurations

Loop Configuration

The Loop Configuration option allows selection between the four control loop choices: Current, Velocity, Position Around Current, and Position Around Velocity. Set the loop configuration for the final application of the drive system. For instance, if the desired configuration is Position Around Velocity, it is not necessary to change the loop configuration from Current to Velocity to Position Around Velocity while tuning each control loop. See “Tuning and Commutation” on page 51 for information on tuning the control loops.

Gain Set

Most applications will not require gain switching, and therefore should use the default Gain Set 0. For advanced configurations, a particular gain set can be associated with the configuration, and can be initiated automatically each time the configuration is initiated or the drive is power cycled. If the application requires more than one configuration, a single gain set can be used on both configurations, or a separate gain set may be used for each. See “Gain Sets” on page 48 for more information.

3.1.1 Command Source

The Command Source option allows selection between any command source supported by the drive hardware and firmware. After selecting a command source, the available settings for the chosen command will appear to the right in the Configuration window.

Some command sources may require a specific Loop Configuration for proper operation. In this case, a message will appear with information on which Loop Configuration is required. The command source change cannot be applied until the compatible Loop Configuration is selected.

No Command
This assigns no command source to the drive. Typically, No Command will be automatically assigned when major control loop changes are performed. This is a protection feature to minimize sudden motor movement.

**Analog Input**

Selects an analog input as the command source for the drive.

Configuration of this input can also be done in the Analog Inputs window. All analog inputs are shown. If more than one is available, you may select it from the *Select available input box*. If an input is disabled (grayed out), that means it is already assigned to another task, and cannot be selected as a command source.

*Configuration* allows the assignment of parameter values for the applicable Analog Input.

- **Scaling**: Provides a ratio between the input command voltage and the drive output, in terms of applicable user units.
- **Offset**: Used to apply an offset to the input command signal.
- **Deadband**: Sets a deadband range in which the input command signal will have no effect. Deadband will automatically be enabled when an analog input is applied as the command source, even if the Deadband value is zero.

*Status* allows for monitoring of the input command signal.

- **Measured Value**: The value measured at the analog input.
- **Commanded Value**: The value after applying the specified scaling and offset values, measured in applicable user units.

**Step & Direction**

Selects the step and direction inputs to control the motor in a simulated stepper motor configuration.

*Configure input scaling* allows entry for the number of input pulses desired to move the motor by a given amount, defined in the second entry field. Conversion varies depending on which loop is in control; for example, input counts to amps for Current, input counts to speed units for Velocity, and input counts to position units for Position.

**PWM & Direction**

Allows the user to select from either PWM & Direction or Single Input PWM as the command source input type. The PWM & Direction command option consists of separate PWM (0-100%) and Direction inputs, while the Single Input PWM option consists of only a single PWM input signal (Direction input connections are left unconnected). When using Single Input PWM, a duty cycle in the range of 0-50% will command motion in one direction, while a duty cycle in the range of 50-100% will command motion in the opposite direction. The PWM input signal for both command selections has a range of 1kHz to 125kHz.

*Configuration* allows for parameter setup and configuration of the PWM input signal.
- **Scaling:** Assigns the command input in terms of applicable user units that will be associated with 100% PWM duty cycle. This value may be positive or negative.
- **Offset:** The offset applied after logic polarity is interpreted. If this offset places the PWM input signal outside of the available range of 0-100%, the duty cycle will saturate at its limits. This value may be positive or negative.
- **Invert PWM Logic:** Inverts the logic polarity of the PWM input.
- **Invert Direction Logic:** Inverts the logic polarity of the Direction input. This option is only available for PWM & Direction type input.

**Status** allows for monitoring of the PWM input signal.

- **Measured Value:** The value measured at the digital input. This represents the duty cycle of the input. It does not reflect the polarity of the command.
- **Commanded Value:** The value after applying the specified logic polarity, offset, and unit scaling, measured in applicable user units.

### Encoder Following

Selects the secondary encoder input to drive the motor in a master/slave configuration.

**Input Type** selects the type of input that will be used during Encoder Following.

- **Auxiliary encoder** will configure the drive to receive input commands from an auxiliary encoder.
- **Virtual encoder** will configure the drive to receive input commands via the communications channel.

*Configure input scaling* sets the number of quadrature input pulses desired to move the motor by a given number of output counts. If using an encoder for primary feedback, *Input Counts* represents the number of encoder counts to move. If using a resolver for primary feedback, *Input Counts* represents the number of resolver counts as determined by the specified resolver resolution. Values entered in either field may be positive or negative.

### Interface Input

Used for RS-485/RS-232 as the command source.

### Communication Channel

This command is assigned when the drive is being controlled by an outside source. This capability is available with network interface products. Selecting Communication Channel will display the current network settings. Clicking the *Edit* button will open the Network Settings window to change the network communication settings.

---

*Notice*

Do not connect to the drive in Read/Write mode while sending commands over the communication channel. Instead, connect to the drive in Read Only mode.
**DriveLibrary**

Selecting this option will automatically configure the current project file to operate with DriveLibrary. DriveLibrary is a high-level API for developers of motion control solutions. The DriveLibrary API defines a collection of control functions that support the majority of motion control applications. DriveLibrary applications are written and developed in C++. Users should be familiar with the C++ language in order to properly develop motion control applications in DriveLibrary.

Selecting DriveLibrary as the Command Source will automatically configure the current project file to operate with DriveLibrary. The present network settings will be displayed with an Edit button to open the Network Settings window to change communication settings if desired.

Once DriveLibrary is selected, if necessary a list will appear containing a list of the drive parameters that need to be modified in order to configure the drive for operation with DriveLibrary. Selecting Apply will accept the changes, and the project file will automatically be configured for compatibility with DriveLibrary. DriveLibrary will not be assigned as the Command Source until the parameter requirements are met.

If any attempt is made to change a drive parameter that is required for compatibility with DriveLibrary (such as disabling the Position Loop) the setup software will provide a notification window alerting the user that continuing with that action will cause DriveLibrary compatibility to be lost, and the Command Source will be set to No Command.

### 3.1.2 Command Limiter

The Command Limiter allows you to limit the change in the input command signal as seen by the drive. The resulting effect is dependent on the operating mode. This is a command smoother, not a drive limiter. In other words, it will change how the command is seen by the drive, but if an event occurs which is not affected by the command, the drive will react according to drive limits. To change drive limits, see the Limits window.

The Command Limiter has a corresponding drive event, Command Limiter Active, that will be high (active) if the Command Limiter is enabled and the command is being actively limited by the Command Limiter settings. The state of this event is dependent upon the target value only and not the measured value. The Command Limiter parameters will change automatically depending on the current Loop configuration.

**Current Mode**

- **Linear Ramp**: Limits the jerk, or change in commanded current.

**Velocity Mode**

- **Linear Ramp**: Limits the acceleration and deceleration independently for positive and negative velocities.

**Position Mode**

- **Accel/Decel**: Allows acceleration and deceleration limits to be set.
3.2 Loop Feedback

The Loop Feedback window allows specification of which feedback device is used for the velocity and/or position loop. Open the Loop Feedback window by selecting [DriveName] > Loop Feedback in the System Browser.

3.2.1 Velocity Feedback Source

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Motor Encoder</td>
<td>The velocity is derived from the motor mounted encoder. Encoder configuration is available in the Motor window.</td>
</tr>
<tr>
<td>Hall Velocity</td>
<td>The velocity is derived from the motor mounted hall sensors. When configured for hall velocity mode, the drive will define 1 count to be equal to 1 hall state change (that is, a 4-pole motor has 12 counts per revolution).</td>
</tr>
<tr>
<td>Analog Input</td>
<td>The velocity is derived from an analog input. Typically used in case of a motor mounted tachometer. The analog signal must be conditioned not to go outside the hardware limits of the drive (typically ±10V). Select which analog input to use, and configure the Scaling (ratio between the input voltage and the measured velocity) and Offset.</td>
</tr>
<tr>
<td>Interface Input</td>
<td>The velocity is provided over the communication interface. Select which interface input to use from the available inputs.</td>
</tr>
<tr>
<td>Resolver</td>
<td>The velocity is derived from the motor mounted resolver. Resolver configuration is available in the Motor window.</td>
</tr>
</tbody>
</table>

For reference, see “Filtering Velocity Feedback” on page 111.

3.2.2 Position Feedback Source

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Motor Encoder</td>
<td>The position is derived from the motor mounted encoder. Encoder configuration is available in the Motor window.</td>
</tr>
<tr>
<td>Analog Input</td>
<td>The position is derived from an analog input. Typically used in case of a load-mounted potentiometer. The analog signal must be conditioned not to go outside the hardware limits of the drive (typically ±10V). Select which analog input to use, and configure the Scaling (ratio between the input voltage and the measured position) and Offset.</td>
</tr>
<tr>
<td>Auxiliary Encoder</td>
<td>The position is derived from the auxiliary encoder input. Note that the auxiliary encoder pins on the drive may possibly be assigned to other functions (Encoder Following, Step and Direction, or High Speed Capture). If this is the case, the setup software will prompt you to reconfigure the digital input settings so that the auxiliary encoder pins are not assigned to any other function.</td>
</tr>
<tr>
<td>Interface Input</td>
<td>The position is provided over the communication interface. Select which interface input to use from the available inputs.</td>
</tr>
<tr>
<td>Resolver</td>
<td>The position is derived from the motor mounted resolver. Resolver configuration is available in the Motor window.</td>
</tr>
</tbody>
</table>

**Auxiliary Encoder Input** Most ADVANCED Motion Controls’ drives allow for an auxiliary encoder to be used to close the position loop in a dual loop application. The Auxiliary Encoder selection provides an interface to enter the auxiliary encoder information to ensure proper operation and to allow for an auxiliary index to be used for homing. In order for the auxiliary encoder to be used as the position feedback device, Auxiliary Encoder needs to be specified as the position loop feedback device in the Drive > Loop Feedback window.

**Auxiliary Encoder Parameters** Configure the auxiliary encoder by entering the following specifications:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Encoder Type</td>
<td>Select if the auxiliary encoder is linear or rotary.</td>
</tr>
<tr>
<td>Resolution</td>
<td>Enter the resolution of the auxiliary encoder device.</td>
</tr>
<tr>
<td>Feedback Polarity</td>
<td>Select the polarity of the incoming auxiliary encoder signal.</td>
</tr>
<tr>
<td>Index</td>
<td>Specify if an index is preset (required for homing to auxiliary index).</td>
</tr>
</tbody>
</table>
3.3 Power-up Settings

The Power-up window (DriveName > Power-up) is used to configure certain software settings and parameters when the drive initially receives power.

<table>
<thead>
<tr>
<th>Bridge Status</th>
<th>Selecting Software Enable will issue an Enable command upon power-up. Depending on other software settings or external hardware faults, the drive may remain disabled. Selecting Software Disable will issue a Disable command upon power-up.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuration Select</td>
<td>Select the Configuration set the software will default to upon power-up.</td>
</tr>
<tr>
<td>Phase Detect</td>
<td>Allows for the configuration of Phase Detect power-up settings. Under most circumstances, the appropriate setting is On First Enable Following Power-up. However, other options may be used depending on the configuration of your drive and motor.</td>
</tr>
<tr>
<td>Set Position</td>
<td>Selecting the Set Position checkbox will set the value of the measured position and target position to the value defined in the Preset Position field defined in the active Gain Set window.</td>
</tr>
<tr>
<td>Motion Engine</td>
<td>Selecting Enable will enable the Motion Engine upon power-up.</td>
</tr>
</tbody>
</table>
3.4 Motor Parameters

The Motor Parameters window can be accessed by going to Motor > Parameters in the System Browser. The motor data is stored in:

- The drive.
- The project file.

The Motor Parameters window is where you will input the motor ratings, motor-specific data, feedback information, and commutation information. The values entered in the Motor Parameters window will have an effect on the values entered in the Limits window.

3.4.1 Motor Selection

From within the Motor window, enter the motor information based on a default template for a selected motor type.

| Motor Type            | The type of motor used. Selections for rotary motors are Brushed, Brushless, Stepper, and AC Induction. Selections for linear motors are Voice Coil and Linear Brushless. |
|-----------------------|-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------
| Manufacturer          | The name of the motor manufacturer.                                                                                                                                                               |
| Model                 | The motor model.                                                                                                                                                                                  |

- To enter the motor information:
  - Select the Motor Type from the Select Motor drop-down options.
  - Enter the information for both Manufacturer and Model (optional).
  - Begin entering data in the Motor Parameters and Feedback Type fields (see “Motor Parameters” on page 22 and “Feedback Type” on page 24 for field descriptions).
  - Once the motor and feedback information have been entered, click the Apply button in the toolbar. The motor information will now be saved in the project file.

Rotation Direction

The motor rotation direction can be selected independently of the motor and feedback selection. Changing the rotation direction will change the direction of the motor for a given command. Typically, the rotation direction is not determined during initial motor configuration, but is changed after commutation has been established.

3.4.2 Motor Parameters

Depending on the selected Motor Type, the information available for editing will change in the Motor Parameters field. Consult the motor datasheet to determine the appropriate values.
Configuring the Drive / Motor Parameters

**Brushed, Brushless, Linear Brushless, Stepper, and Voice Coil Motor Parameters**

<table>
<thead>
<tr>
<th>Motor Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cont Current</td>
<td>The nominal (continuous) current that the motor can handle. The setup software will not allow the drive continuous current to be configured greater than this value.</td>
</tr>
<tr>
<td></td>
<td>(Note: The specified current is in units of Adc. For sinusoidally commutated motors, this is the peak of the sine wave through any phase of the motor within one electrical cycle. To calculate the RMS current, divide the DC value by 1.414. This calculation should not be used when the motor is commutated trapezoidally.)</td>
</tr>
<tr>
<td>Peak Current</td>
<td>The peak operating current that the motor can handle. This does not correspond to the de-magnetizing current, which is typically much higher than the maximum operating current. The setup software will not allow the drive peak current to be configured greater than this value.</td>
</tr>
<tr>
<td></td>
<td>(Note: The specified current is in units of Adc. For sinusoidally commutated motors, this is the peak of the sine wave through any phase of the motor within one electrical cycle. To calculate the RMS current, divide the DC value by 1.414. This calculation should not be used when the motor is commutated trapezoidally.)</td>
</tr>
<tr>
<td>Max Speed</td>
<td>Corresponds to the maximum rated speed of the motor. The setup software will not allow the drive positive velocity limit, negative velocity limit, or motor over speed to be configured greater than this value.</td>
</tr>
<tr>
<td>Motor Poles / Pole Pitch</td>
<td>(Brushless, Linear Brushless, and Stepper motors only) The number of poles, in case of rotary motors, corresponds to twice the number of electrical cycles per motor revolution. The pole pitch, in case of linear motors, corresponds to the length of one electrical cycle (360 degrees). The numerical value and units can be selected independently (the numerical value will NOT be automatically re-calculated when a different unit is selected).</td>
</tr>
<tr>
<td>Motor Resistance</td>
<td>In case of Brushed motors it corresponds to the armature resistance. In case of Brushless motors it corresponds to the phase-to-phase resistance.</td>
</tr>
<tr>
<td>Motor Inductance</td>
<td>In case of Brushed motors it corresponds to the armature inductance. In case of Brushless motors it corresponds to the phase-to-phase inductance.</td>
</tr>
<tr>
<td>Motor Ke</td>
<td>The voltage constant corresponds to the motor back-EMF constant. The numerical value and units can be selected independently (the numerical value will NOT be automatically re-calculated when a different unit is selected).</td>
</tr>
<tr>
<td>Motor Kt</td>
<td>The motor torque (Brushless) or force (Brush) constant. The numerical value and units can be selected independently (the numerical value will NOT be automatically re-calculated when a different unit is selected).</td>
</tr>
<tr>
<td>Max Motor Temp</td>
<td>Maximum allowable motor temperature (recommended if using an analog input for motor temperature).</td>
</tr>
</tbody>
</table>

**AC Induction Motor Parameters**

<table>
<thead>
<tr>
<th>Motor Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>No Load Current</td>
<td>The no-load (magnetizing) current as specified by the motor manufacturer.</td>
</tr>
<tr>
<td>Peak Current</td>
<td>The peak operating current that the motor can handle. This does not correspond to the de-magnetizing current, which is typically much higher than the maximum operating current. The setup software will not allow the drive peak current to be configured greater than this value.</td>
</tr>
<tr>
<td></td>
<td>(Note: The specified current is in units of Adc. For sinusoidally commutated motors, this is the peak of the sine wave through any phase of the motor within one electrical cycle. To calculate the RMS current, divide the DC value by 1.414. This calculation should not be used when the motor is commutated trapezoidally.)</td>
</tr>
<tr>
<td>Max Speed</td>
<td>Corresponds to the maximum rated speed of the motor. The setup software will not allow the drive positive velocity limit, negative velocity limit, or motor over speed to be configured greater than this value.</td>
</tr>
<tr>
<td>Rated Speed</td>
<td>The rated speed as specified by the motor manufacturer.</td>
</tr>
<tr>
<td>Motor Poles</td>
<td>For rotary AC induction motors, the number of motor poles as specified by the motor manufacturer. For linear AC induction motors, the distance required for one electrical cycle.</td>
</tr>
<tr>
<td>Connection</td>
<td>Specifies the type of connection used for the motor ratings.</td>
</tr>
<tr>
<td>Base Frequency</td>
<td>The rated frequency for base speed as specified by the motor manufacturer.</td>
</tr>
<tr>
<td>Rated Voltage</td>
<td>The rated motor voltage as specified by the motor manufacturer.</td>
</tr>
</tbody>
</table>
Configuring the Drive / Motor Parameters

3.4.3 Feedback Type

The Feedback Type area holds information about the motor feedback device. The feedback device and parameters listed will be dependent on the drive model and the firmware currently used in the drive.

- The primary feedback device will be shown along with the configurable parameters.
- For universal feedback drives, the present primary feedback device will be shown as a selection option.
  - To change the primary feedback device, choose the new type of feedback from the selections. A message will appear stating that a firmware change is required to support the selected feedback device. Click ‘OK’ to open the Firmware Download window to download the required firmware into the drive.
  - Once the download is complete, return to the Motor window, and the primary feedback device will reflect the firmware change.

The parameters for each type of feedback device are as follows:

**Incremental Encoder Feedback Parameters**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Polarity</td>
<td>Represents the polarity of the selected feedback device signal. AutoCommutation will determine the polarity.</td>
</tr>
<tr>
<td>Resolution</td>
<td>Represents the counts per revolution (counts/rev) for a rotary motor, or the counts per distance (counts/in or counts/mm, depending on the units selected for pole pitch) for a linear motor.</td>
</tr>
<tr>
<td>Index / Ref Marker</td>
<td>Indicates if there is an encoder index pulse.</td>
</tr>
</tbody>
</table>
### Absolute Encoder (Hiperface® or EnDat® 2.1) Feedback Parameters

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Polarity</td>
<td>Represents the polarity of the selected feedback device signal. AutoCommutation will determine the polarity.</td>
</tr>
<tr>
<td>Serial Interface</td>
<td>Selects the serial interface for the absolute encoder in use (Unassigned, Hiperface, or EnDat).</td>
</tr>
<tr>
<td>Abs Range</td>
<td>Represents the number of absolute steps per revolution for the absolute encoder. Must be a multiple of the Encoder Cycles/Rev value. This value is not influenced by the total number of turns supported by the encoder.</td>
</tr>
<tr>
<td>Resolution</td>
<td>Represents the Sin/Cos encoder cycles per revolution for a rotary motor, or the encoder cycles per distance (mm, in) for a linear motor.</td>
</tr>
<tr>
<td>Interpolation</td>
<td>The interpolation is configurable in powers of 2 from 1 to 512 lines per Sin/Cos cycle. Represents the Sin/Cos interpolation of the position loop which determines how many counts are defined per encoder cycle. The number of counts per cycle is the interpolation value multiplied by 4, giving an interpolated encoder resolution from 4 to 2048 counts per Sin/Cos cycle.</td>
</tr>
<tr>
<td>Index / Ref Marker</td>
<td>Indicates if there is an encoder index pulse.</td>
</tr>
</tbody>
</table>

### Absolute Encoder (BiSS C-Mode) Feedback Parameters

The BiSS encoder parameters can be auto-filled by clicking on the “Choose Template” button, then selecting a manufacturer from the available options. Verify that the parameters match the values on the BiSS encoder manufacturer’s datasheet. If necessary, the Polarity and Resolution can be edited to match the device in use. If the manufacturer of the BiSS encoder in use is not listed in the available template selections, the “Custom” option can be chosen to allow manual entry of the data values. Contact the manufacturer for information on how to properly proceed with configuration.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manufacturer</td>
<td>Displays the BiSS encoder manufacturer.</td>
</tr>
<tr>
<td>Polarity</td>
<td>Represents the polarity of the BiSS encoder.</td>
</tr>
<tr>
<td>Number of Turns</td>
<td>Displays the number of turns of the BiSS encoder.</td>
</tr>
<tr>
<td>Resolution</td>
<td>BiSS encoder resolution.</td>
</tr>
</tbody>
</table>
| Data Width and Justification | Displays the Single Turn and Multi Turn Data Width and Justification of the BiSS encoder. By default, these fields are hidden from view as they should not be edited when using a standard manufacturer template. To view these fields, click on the small arrow button in the Feedback Type panel. Note that the values entered are subject to the following requirements:  
  - When the single-turn data width is left justified, the single-turn data width cannot be greater than 32.  
  - The sum of the single- and multi-turn data widths cannot exceed 64.  
  - The single-turn resolution cannot be greater than the single-turn data width.  
  - The multi-turn resolution cannot be greater than the multi-turn data width.  
  - The single-turn resolution cannot be greater than 31.  
  - The sum of the single- and multi-turn resolutions cannot exceed 31.  
  - When the single-turn data is right justified, the single-turn resolution has to be equal to the single-turn data width.  
  - When the multi-turn data is left justified, the multi-turn resolution has to be equal to the multi-turn data width.  
| Velocity Divider             | A scaling factor for the velocity feedback counts. This adjusts the useful range for velocity loop gains, and is particularly beneficial for high working resolution encoders. If the working resolution is between 16 bits and 25 bits, it is recommended to use the default velocity divider of 256. For working resolutions above 25 bits, select a velocity divider of 512. |
### Absolute Encoder (EnDat® 2.2) Feedback Parameters

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Polarity</td>
<td>Represents the polarity of the selected feedback device signal. AutoCommutation will determine the polarity.</td>
</tr>
<tr>
<td>Serial Interface</td>
<td>Displays the serial interface for the absolute encoder in use (EnDat 2.2).</td>
</tr>
<tr>
<td>Encoder and Working Resolution</td>
<td>The encoder resolution used by the drive for positioning. The Working Resolution may be less than or equal to the Encoder Resolution. The sum of the Singleturn and Multiturn resolution must not exceed 31 bits. When the Singleturn resolution is changed, the Multiturn resolution will automatically be adjusted by the software to optimize the available data from the encoder.</td>
</tr>
<tr>
<td>Velocity Divider</td>
<td>A scaling factor for the velocity feedback counts. This adjusts the useful range for velocity loop gains, and is particularly beneficial for high working resolution encoders. If the working resolution is between 16 bits and 25 bits, it is recommended to use the default velocity divider of 256. For working resolutions above 25 bits, select a velocity divider of 512.</td>
</tr>
</tbody>
</table>

### 1Vp-p Sin/Cos Encoder

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Polarity</td>
<td>Represents the polarity of the selected feedback device signal. AutoCommutation will determine the polarity.</td>
</tr>
<tr>
<td>Resolution</td>
<td>Represents the Sin/Cos encoder cycles per revolution for a rotary motor, or the encoder cycles per distance (mm, in) for a linear motor.</td>
</tr>
<tr>
<td>Interpolation</td>
<td>The interpolation is configurable in powers of 2 from 1 to 512 lines per Sin/Cos cycle. Represents the Sin/Cos interpolation of the position loop which determines how many counts are defined per encoder cycle. The number of counts per cycle is the interpolation value multiplied by 4, giving an interpolated encoder resolution from 4 to 2048 counts per Sin/Cos cycle.</td>
</tr>
<tr>
<td>Index / Ref Marker</td>
<td>Indicates if there is an encoder index pulse.</td>
</tr>
</tbody>
</table>

### Resolver Feedback Parameters

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Polarity</td>
<td>Represents the polarity of the resolver. AutoCommutation will determine the polarity.</td>
</tr>
<tr>
<td>Resolution</td>
<td>Specify either Low or High resolution. Low (12-bit) means an equivalent 4096 counts/resolver cycle. High (14-bit) means an equivalent 16384 counts/resolver cycle.</td>
</tr>
<tr>
<td>Carrier Frequency</td>
<td>Displays the frequency of the resolver excitation signal.</td>
</tr>
<tr>
<td>Amplitude</td>
<td>Displays the amplitude of the resolver excitation signal.</td>
</tr>
<tr>
<td>Transformation Ratio</td>
<td>Displays the transformation ratio of the resolver excitation signal.</td>
</tr>
<tr>
<td>Multi-speed</td>
<td>Enables multi-speed or multi-turn resolvers.</td>
</tr>
<tr>
<td>Cycles/rev</td>
<td>Number of cycles per revolution or pole pairs of the resolver. Resolvers that are not multi-speed have one pole pair or cycle per revolution. Note that electrical cycles must be a multiple of resolver cycles.</td>
</tr>
</tbody>
</table>
### 3.4.4 Commutation

The commutation section allows configuration of basic commutation settings. The available settings will depend on the type of motor and feedback in use:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Commutation Sensors (Halls)</td>
<td>Indicates that commutation sensors are to be used.</td>
</tr>
<tr>
<td>Commutation Angle</td>
<td>Selects the Hall phasing angle. Note that the Hall phasing angle will be automatically selected after running AutoCommutation. If the Hall sensor phasing differs from 60º or 120º by more than 10 electrical degrees, &quot;Other&quot; will be automatically selected.</td>
</tr>
<tr>
<td>Trapezoidal / Sinusoidal</td>
<td>Selects between Trapezoidal or Sinusoidal commutation. Trapezoidal is disabled for Resolver and Absolute Encoder feedback, and is only enabled for other types of feedback if Commutation Sensors is checked and a valid Commutation Angle of 60º or 120º is selected.</td>
</tr>
<tr>
<td>Reset Commutation</td>
<td>Reset Commutation is used primarily for systems unable to complete AutoCommutation that need commutation angles set to known good angles.  - If the existing commutation setting is 120º, Reset Commutation will reset the commutation angles to the drive default angles for 120º phasing.  - If the existing commutation setting is 60º, Reset Commutation will reset the commutation angles to the drive default angles for 60º phasing.  - If the existing commutation setting is &quot;Other&quot;, Reset Commutation will change the commutation angle to 120º and reset the commutation angles to the drive default angles for 120º phasing.</td>
</tr>
<tr>
<td>External Commutation Between Phases</td>
<td>Selects the two phases the drive will output current to when using a brush type motor.</td>
</tr>
</tbody>
</table>

### 3.4.5 Braking

The *Brake* checkbox allows a brake to be assigned with an event action. The brake can be assigned to a digital output in the Digital Outputs window. Checking or unchecking the *Brake* checkbox may result in certain event actions changing. Look in the Advanced Events window to view the assignments. The following event actions will be affected:

- When "Brake" is checked, events configured for "Disable Bridge" or "Dynamic Brake" will be changed to "Apply Brake and Disable Bridge" or "Apply Brake and Dynamic Brake", respectively.
- When "Brake" is unchecked, events configured for "Apply Brake and Disable Bridge" or "Apply Brake and Dynamic Brake" will be changed to "Disable Bridge" or "Dynamic Brake", respectively.

In addition, the brake output can be configured to use delays between external braking and enabling/disabling the drive. This delay is designed to prevent loads from falling or coasting when the effects of gravity or other external forces are seen in the system.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Brake Applied Delay</td>
<td>Delay after applying external brake before disabling power bridge or performing dynamic braking.</td>
</tr>
<tr>
<td>Brake Released Delay</td>
<td>Delay before releasing external brake after enabling power bridge or discontinuing dynamic braking.</td>
</tr>
</tbody>
</table>
3.4.6 Motor Database

The Motor Database allows motor information to be saved and stored in a database for convenient access. Motor information can be saved directly from the Motor Parameters window, or imported via an .XML file. Motor information from the database can also be exported as an .XML file. Importing and exporting of motor information is accomplished in the Tools > Manage Motor Database Menu Bar window.

• To save motor information:
  — Enter the motor information into the Motor Parameters window.
  — Click the Save button in the Motor Database pane.
  — The motor information is now stored in the User Database section in the Motor Database.
  — The Motor Database is saved in the default installation folder where the "My Projects" folder is located.

• To select and load previously saved motor information:
  — Click the Select button in the Motor Database pane.
  — In the Motor Database Selection window that opens, expand the heading of the User Database category.
  — Motors are organized in the following structure: [Database Name] > [Manufacturer] > [Model]. Locate the desired motor, and click Select at the bottom of the Motor Database Selection window.
  — The desired motor information will auto-populate into the Motor Parameters fields.

• To edit previously saved motor information:
  — Load the desired motor information as described above.
  — Modify fields in the Motor Parameters window. Do not change the Manufacturer or Model fields. Changing these will save the information as a separate motor in the database.
  — Click the Save button in the Motor Database pane.
  — The motor information in the database will be updated with the new changes.

Manage Motor Database

The Manage Motor Database window is used to import, export, and delete motor information from the Motor Database. Motor information is imported or exported in .XML file format.

Contact the setup software manufacturer for assistance in creating an .XML file that is compatible with the Motor Database.

Import

Allows an .XML file that contains motor parameters for one or more motors to be imported into the Motor Database. Click Import, then navigate to the .XML file in the window that opens. The imported information will then be saved in the User Database section of the Motor Database.

Export

Creates an .XML file that contains motor parameters from the Motor Database. Check the box for the desired motor from the available options, and then click Export to choose the save
location of the .XML file. Note that information for multiple motors can be exported into the same .XML file.

**Delete**

Deletes one or more motor database entries. Check the box(es) for the motor entry to be removed from the database, then click *Delete*. Click *OK* in the warning prompt to delete the motor entry.
3.5 AutoCommutation

The AutoCommutation routine detects the motor feedback type and polarity, and then configures the drive commutation parameters appropriately.

**Before running AutoCommutation:**

- Enter in the correct motor information in the Motor Parameters window.
- Specify the correct feedback information.
- Specify limits to protect the motor.
- Tune the current loop.
- De-couple the motor from any load and secure the motor. Sudden motion will occur!

If you have not done the preceding, see the corresponding sections in this manual.

See “AutoCommutation™” on page 57 for information on how to run the AutoCommutation routine.
3.6 Encoder Output

Certain drive models that support a 1Vp-p Sin/Cos encoder or Absolute encoder feature either a Buffered Encoder Output or an Emulated Encoder Output that emit a 5V square wave that can be used to synchronize the command to other axes or to close the position loop. The buffered encoder output has a 1:1 input-to-output ratio, while the emulated encoder input-to-output ratio is configurable.

The Divide Amount field sets a value by which the interpolated encoder resolution is divided to get the emulated encoder output resolution (counts/rev). The Emulated Index Position field allows you to specify an absolute position for the output index relative to the emulated output counts. Additionally, you may select to have this index repeat for every specified number of output counts in the Emulated Index Period field. The index period is specified as the number of emulated counts between emulated indices. The index period must be zero, or divisible by 4. If zero is used, the effective period will be $2^{32}$ emulated counts.

For Sin/Cos feedback, the emulated output will be re-initialized each time the absolute position of the drive is initialized (i.e. via homing, Set Position, etc.). Until the drive position is initialized, no emulated index will be output by the drive.

For certain drive models that support resolver feedback, the emulated output will match the resolver resolution setting. For example, selecting Low Resolution (12-bit) will give an equivalent $2^{12}$ (4096) counts/rev at the output. There will be a small phase lag between the sinusoidal feedback to the drive and the emulated output due to the time required to process the emulated signal.
3.7 Inputs / Outputs

Inputs / Outputs allows configuration and diagnostics of all digital and analog programmable inputs and outputs.

The following tabs are available:

- Analog Inputs
- Analog Outputs
- Digital Inputs
- Digital Outputs

3.7.1 Analog Inputs

Each programmable analog input can be assigned a certain drive function through the Command, Feedback, or Limits windows. When a function is assigned to an analog input, the Analog Inputs window will display the assignment, the configuration settings, and the currently measured value. Analog Inputs cannot be assigned to a function in the Analog Inputs window.

Check the drive datasheet to find the number of available analog inputs.

Each assigned input can be scaled, according to the selected function, to provide an optimal range by entering a value in the "Scale" column. Entering the numerical value of the chosen function for a 1V input signal performs the scaling. An offset (in volts) can also be defined.

A programmable deadband can be configured for analog inputs assigned to the command source. The deadband sets a voltage range which will have no effect on the command. This is particularly useful when the analog command source is configured to control velocity.

The drive handles anything within the deadband range as zero, and subtracts the deadband value from all other values. For example, with a deadband setting of ±100 mV, the drive ignores any signal between -100 mV and +100 mV.

Selections become effective after clicking the Apply button.
3.7.2 Analog Outputs

Each programmable analog output can be assigned to a certain drive variable.

Each output can also be scaled, according to the selected variable, to provide an optimal range. Entering the numerical value of the chosen variable for a 1V output signal performs the scaling. An offset (in volts) can also be defined.

Check the drive data sheet to find the number of available analog outputs. A list of available output signals and their definitions can be found in "Signal Definitions" on page 88.

3.7.3 Digital Inputs

To assign a function to a digital input, drag-and-drop one or more functions from the Input Functions field to the desired digital input in the Input Assignments field. High Speed Capture functions may only be assigned to High Speed (HS) digital inputs, while other functions may be assigned to either General Purpose (GP) or High Speed digital inputs. The Capture Panel allows configuration of High Speed Capture functions once they have been assigned to a High Speed input.

The present status of each input is displayed by the LED graphic beside each digital input number (clear = Not Active, green = Active). The Active column displays the input polarity. Active Low means the input must be pulled-down for the input to be considered ON. Set the input polarity by selecting either the Active Low or Active High button at the bottom of the window. Each input can be assigned to one or more functions. If more than one function is assigned to a single input, the following priority rules apply (from highest to lowest):

1. Inhibit
2. Dynamic brake
3. Positive or negative limit
4. Phase Detection

The User Disable, User Aux Disable, and the Motor Over Temperature functions depend on the selected Action in the Events windows.

Functions can be removed from a digital input by highlighting the selected function, then hitting Delete on the keyboard, or the button in the Digital Inputs window.
Capture Panel

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Captured Signal</td>
<td>This field shows the selected signal to be captured.</td>
</tr>
<tr>
<td>Captured Value</td>
<td>This shows the last value captured by the drive.</td>
</tr>
<tr>
<td>Trigger Edge</td>
<td>You may select between Rising, Falling, or Both to set when the signal will be captured.</td>
</tr>
<tr>
<td>Trigger Mode</td>
<td>Single mode will allow the signal to be captured only once per set/reset. Continuous will allow the signal to be captured any time it is triggered while capture is set.</td>
</tr>
<tr>
<td>Set / Reset Input</td>
<td>Displays the Digital Input assigned to reset the capture signal.</td>
</tr>
</tbody>
</table>

Digital Input Definitions

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Disable</td>
<td>(Level Sensitive) Disables the drive. User Disable can be set to either Disable Power Bridge or Dynamic Brake in the Advanced Events window. The default configuration assigns Disable Bridge to this function.</td>
</tr>
<tr>
<td>Use Aux Disable</td>
<td>(Level Sensitive) Disables the drive. User Aux Disable can be set to either Disable Power Bridge or Dynamic Brake in the Advanced Events window. The default configuration assigns Dynamic Brake to this function.</td>
</tr>
<tr>
<td>User Stop</td>
<td>(Level Sensitive) Activates the User Stop event. When User Stop is active, the drive will issue a Stop command to halt motor motion.</td>
</tr>
<tr>
<td>User Positive Limit</td>
<td>(Level Sensitive) Activates the User Positive Limit event. User Positive Limit can be set to either Positive Stop or Disable Positive Direction in the Events window to cease motor motion in the positive direction. The default configuration assigns Positive Stop to this function.</td>
</tr>
<tr>
<td>User Negative Limit</td>
<td>(Level Sensitive) Activates the User Negative Limit event. User Negative Limit can be set to either Negative Stop or Disable Negative Direction in the Events window to cease motor motion in the negative direction. The default configuration assigns Negative Stop to this function.</td>
</tr>
<tr>
<td>Motor Over Temp</td>
<td>(Level Sensitive) Activates the Motor Over Temperature event. Motor Over Temperature can be assigned to a number of different setup software safety actions to prevent the motor from over-heating. The default configuration assigns Bridge Disable to this function.</td>
</tr>
<tr>
<td>Phase Detect</td>
<td>(Edge Sensitive) Activates the Phase Detect routine. Phase Detect is a function used to initialize the correct commutation angle for brushless motors lacking commutation sensors. The drive can be configured to run Phase Detect automatically on power-up in the Power-up window.</td>
</tr>
<tr>
<td>Zero Position Error</td>
<td>(Edge Sensitive) When triggered, a pulse command is sent to the position target, setting it equal to the measured position. Note: if the position command source is an absolute source such as an analog input, the target position will immediately be overwritten by the command source with the next position loop update.</td>
</tr>
</tbody>
</table>
### Configuring the Drive / Inputs / Outputs

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Set Position</strong></td>
<td>(Edge Sensitive) When triggered, a pulse command is sent to both the position measured and position target, setting both equal to the value defined in the “Preset Position” field within the position gain set. Note: if the command source and/or position feedback device is an absolute device such as an analog input, the target position and/or measured position will immediately be overwritten with the next position loop update.</td>
</tr>
<tr>
<td><strong>High Speed Capture</strong></td>
<td>(Edge Sensitive) When triggered, the assigned signal is instantly captured. The signal is held in memory until the capture function is reset. This signal can be read over the network. High Speed Capture settings are configured in the Capture Configuration window that becomes accessible once a capture is mapped to a high speed input. High speed captures can only be mapped to unused high speed inputs.</td>
</tr>
<tr>
<td><strong>Set/Reset Capture A</strong></td>
<td>(Level Sensitive) Sets or Resets Capture A. This signal must be active before the High Speed Capture function can be used. For single trigger captures, the capture is reset by toggling this input off/on.</td>
</tr>
<tr>
<td><strong>Set/Reset Capture B</strong></td>
<td>(Level Sensitive) Sets or Resets Capture B. This signal must be active before the High Speed Capture function can be used. For single trigger captures, the capture is reset by toggling this input off/on.</td>
</tr>
<tr>
<td><strong>Set/Reset Capture C</strong></td>
<td>(Level Sensitive) Sets or Resets Capture C. This signal must be active before the High Speed Capture function can be used. For single trigger captures, the capture is reset by toggling this input off/on.</td>
</tr>
<tr>
<td><strong>Home Execute</strong></td>
<td>(Edge Sensitive) Enables and initiates the selected Home routine. Note: If the Motion Engine is not enabled, this input must remain active until the homing procedure is completed.</td>
</tr>
<tr>
<td><strong>Home Switch</strong></td>
<td>(Edge Sensitive) Acts as a Home Switch when a compatible homing routing is selected.</td>
</tr>
<tr>
<td><strong>Reset Events</strong></td>
<td>(Edge Sensitive) When triggered, latching and history status events are reset. Note: Certain critical events cannot be reset via the digital input, and instead require a drive reset or network commands to reset. These events are: Drive Internal Error, Current Overshoot, Parameter Store Error, and Parameter Restore Error, Phase Detection Failure, Software Disable.</td>
</tr>
<tr>
<td><strong>Configuration Select</strong></td>
<td>(Edge Sensitive) Changes the active configuration when two configurations are used. Falling Edge = Configuration 0. Rising Edge = Configuration 1.</td>
</tr>
<tr>
<td><strong>Gain Select</strong></td>
<td>(Edge Sensitive) Changes the active gain set when two gain sets are used. Falling Edge = Configuration 0. Rising Edge = Configuration 1.</td>
</tr>
<tr>
<td><strong>Motion Execute</strong></td>
<td>(Edge Sensitive) When triggered, the selected Index or Sequence will initiate (depending on whether the drive is in Indexer or Sequencer mode). Note: the motion engine must be enabled before the drive will respond to this function.</td>
</tr>
<tr>
<td><strong>Motion Select 0,1,2,3</strong></td>
<td>(Level Sensitive) Defines the selected Index or Sequence (depending on whether the drive is in Indexer or Sequencer mode). Represents a binary number allowing up to 16 Indexes or Sequences to be independently selected. Motion Select 0 represents the least significant bit with Motion Select 3 representing the most significant bit. Active = 1. Inactive = 0. The Motion Engine must be enabled before motion can be executed.</td>
</tr>
<tr>
<td><strong>Motion Enable</strong></td>
<td>(Edge Sensitive) Enables the Motion Engine. The Motion Engine must be enabled before Indexes or Sequences can be executed.</td>
</tr>
</tbody>
</table>
3.7.4 Digital Outputs

To assign a function to a digital output, drag-and-drop one or more functions from the Output Functions field to the desired digital output in the Output Assignments field.

The present status of each output is displayed by the LED graphic beside each digital output number (clear = Not Active, green = Active). The Active column displays the output polarity. Active High means the output is pulled-down if the output is considered OFF. Set the output polarity by selecting either the Active Low or Active High button at the bottom of the window.

Each output can be assigned one or more functions. If more than one function is assigned to a single output, the functions are OR-ed, which means that if one of the functions is true, the output will be turned ON. Functions can be removed from a digital output by highlighting the selected function, then hitting Delete on the keyboard, or the button in the Digital Outputs window.

Selections become effective after clicking the Apply button.

3.7.5 Extended I/O

Certain drive models allow the allocation of additional external digital and analog I/O beyond the standard number of I/O pins available on the drive hardware. The I/O Allocations pane in the Inputs / Outputs > Extended I/O window determines the number of drive I/O that will be assigned for external I/O expansion. Selecting a value in the drop-down combo boxes will automatically assign pre-determined drive I/O for expansion purposes, and the appropriate I/O will appear labeled as such in the Digital I/O windows. Attempting to assign a drive action or event to I/O that is allocated for external I/O expansion will bring up a dialog box warning of the I/O resource conflict. For more information on expanded I/O capabilities, please contact technical support.

<table>
<thead>
<tr>
<th>Motion Mode</th>
<th>(Edge Sensitive) Toggles the drive between Indexer or Sequencer mode. Active = Sequencer; Inactive = Indexer.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Motion Reset</td>
<td>(Edge Sensitive) Resets the Motion Engine when a Motion Engine fault has occurred.</td>
</tr>
<tr>
<td>Jog Select 0, 1</td>
<td>(Level Sensitive) Defines the selected jog velocity when jogs are used. Represents a binary number allowing up to 4 jogs to be independently selected. Jog Select 0 represents the least significant bit with Jog Select 1 representing the most significant bit. Active = 1, Inactive = 0. The Motion Engine must be disabled before jogging can be executed.</td>
</tr>
<tr>
<td>Jog Forward</td>
<td>(Edge Sensitive) Activates the selected Jog speed in the forward direction. The Motion Engine must be disabled before jogging can be executed.</td>
</tr>
<tr>
<td>Jog Reverse</td>
<td>(Edge Sensitive) Activates the selected current Jog speed in the reverse direction. The Motion Engine must be disabled before jogging can be executed.</td>
</tr>
</tbody>
</table>
### 3.7.6 Programmable Limit Switch

The setup software is configurable to support two independent programmable limit switch (PLS) outputs. These allow the drive to activate digital outputs that are position dependent. The pulse time and repeatability are configurable. The following requirements must be met before the PLS outputs can be used:

- A free digital output must be available to be assigned to the PLS function.
- A compatible position loop feedback device must be configured and connected. The position loop does not need to be closed.
- An absolute position must be defined. If using an incremental encoder to close the position loop, an absolute position can be set using Homing or the Set Position function.

It is recommended to use the setup software to configure the PLS function. It is also possible to configure using direct network commands. For more information on PLS configuration using network commands, refer to the appropriate communication manual for the supported network type.

#### Programmable Limit Switch Parameters

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source</td>
<td>Allows selection of either Position Demand or Position Measured as the input signal to the PLS outputs.</td>
</tr>
<tr>
<td>Rollover</td>
<td>Selecting the Rollover checkbox will place the PLS outputs in Rotary Mode, and allow the configuration of a Rollover Count value (in user units) that specifies the position value at which the PLS position counter will return to zero. In Rotary Mode, the following requirement must be met: 0 &lt; Lower Edge &lt; Upper Edge &lt; Rollover Count.</td>
</tr>
<tr>
<td>Level</td>
<td>Specifies the active polarity of the digital output(s) mapped to the PLS.</td>
</tr>
<tr>
<td>Direction</td>
<td>Specifies the direction of motion that will trigger the PLS function (rising edge sensitive). Selecting Bidirectional will trigger the PLS in both rising edge Forward and rising edge Reverse directions.</td>
</tr>
<tr>
<td>Type</td>
<td>Sets the width of the PLS pulse to be either Position or Time based. When configured for Position, the pulse width is defined by the position values entered in the Lower Edge and Upper Edge fields. When configured for Time, the pulse width is defined by the time value entered in the Pulse Time field. For a single trigger that occurs at the same location regardless of direction, set the Lower Edge and Upper Edge fields to the same value. For different trigger locations depending on direction, set the Lower Edge to be the trigger position for the forward direction, and the Upper Edge to be the trigger for the reverse direction.</td>
</tr>
<tr>
<td>Lower Edge</td>
<td>Starting location for the PLS pulse (position user units).</td>
</tr>
<tr>
<td>Upper Edge</td>
<td>Ending location for the PLS pulse when position based, or a separate directional pulse when time based (position user units).</td>
</tr>
<tr>
<td>Pulse Time</td>
<td>Sets a fixed time width of the PLS pulse when time based.</td>
</tr>
<tr>
<td>Repeats</td>
<td>Sets the number of pulses to be repeated. Selecting the Infinite checkbox will cause the PLS pulse to continue repeating until the Rollover Count is reached (in Rotary Mode) or the maximum allowable position value is reached (in Linear Mode).</td>
</tr>
<tr>
<td>Repeat Delta</td>
<td>Sets the distance between repeated pulses (position user units). Note that when specifying a repeat pattern, the following requirement must be met: (Lower Edge + Repeat Delta) &gt; Upper Edge.</td>
</tr>
</tbody>
</table>

The parameters for PLS1 and PLS2 will become active when the Source signal has been chosen and the Enable checkbox for the respective PLS output has been selected.
3.8 Limits

Limits allows configuration of general drive parameters.

The following selections are available regardless of which loops are enabled:

- Current
- Velocity
- Position
- Stop
- Voltage
- Temperature

3.8.1 Current Limits

Use this window to set the drive output current limits within the hardware capabilities of the drive.

The specified current is in units of peak current. This is the peak value allowed to go through any phase of the motor within one electrical cycle. To calculate the RMS current, divide the peak value by 1.414. This calculation should not be used when the motor is commutated trapezoidally. For an in-depth explanation of how the drive limits current, see “Current Limiting” on page 94.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Peak Current</td>
<td>Maximum output current (limited output time).</td>
</tr>
<tr>
<td>Peak Current Time</td>
<td>The maximum time duration of peak current.</td>
</tr>
<tr>
<td>Continuous Current</td>
<td>The maximum continuous current level the drive will output.</td>
</tr>
<tr>
<td>Foldback Time</td>
<td>The time the drive will use to reduce the current to the continuous current level setting.</td>
</tr>
<tr>
<td>Current Limiting Algorithm</td>
<td>Selects between Time-Based Limiting or RMS Charge-Based Limiting (for supported drive models only). RMS Charge-Based Limiting will allow the drive to output more continuous current during motor movement. See “Current Limiting Algorithm” on page 98 for detailed information on current limiting.</td>
</tr>
<tr>
<td>Current Limit Scaling Source</td>
<td>You may assign an input to change the current limit dynamically. The scaling value can be adjusted in the I/O Configuration window (see &quot;Inputs / Outputs&quot; on page 32).</td>
</tr>
</tbody>
</table>

The drive can output its rated peak current for a maximum of 2 seconds with a foldback time within 10 seconds. This defines the maximum current capability curve. Current profiles that intersect with the maximum current capability curve will be limited to stay within this envelope.
### 3.8.2 Velocity Limits

The following velocity-related limits can be set:

<table>
<thead>
<tr>
<th>Limit</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Motor Over Speed</td>
<td>The maximum speed in which the motor should be able to go. The action following a motor overspeed event can be defined in Event Manager (active in all operating modes).</td>
</tr>
<tr>
<td>Zero Velocity Window</td>
<td>The measured velocity values, within which the motor is considered to be at zero velocity (active in all operating modes).</td>
</tr>
<tr>
<td>At Velocity Window</td>
<td>The &quot;At Velocity&quot; event will be set when the measured velocity reaches the target velocity, within the &quot;At Velocity&quot; window (active in velocity mode only).</td>
</tr>
<tr>
<td>Velocity Following Error</td>
<td>The maximum allowed velocity error (difference between target velocity and measured velocity), prior to setting the &quot;Velocity Following Error&quot; event (active in velocity mode only).</td>
</tr>
<tr>
<td>Positive Velocity Limit</td>
<td>The maximum allowed demand velocity in the positive direction (active only when the velocity loop is closed).</td>
</tr>
<tr>
<td>Negative Velocity Limit</td>
<td>The maximum allowed demand velocity in the negative direction (active only when the velocity loop is closed).</td>
</tr>
</tbody>
</table>

### 3.8.3 Position Limits

The following position-related limits can be set:

<table>
<thead>
<tr>
<th>Limit</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>In-Home Position Window</td>
<td>Defines a window around the Home Position Value, such that when the measured position is within this window, the In Home Position event will be active.</td>
</tr>
<tr>
<td>In-Position Window</td>
<td>Defines a window around the target position, such that when the measured position is within this window, the At Command event will be active.</td>
</tr>
<tr>
<td>Position Following Error Window</td>
<td>The maximum allowed position error (difference between target position and measured position) prior to setting the &quot;Position Following Error&quot; event (active in position mode only).</td>
</tr>
<tr>
<td>Max Measured Position Limit</td>
<td>Maximum allowed measured position. The Max Measured Position event will become active if the measured position exceeds this value.</td>
</tr>
<tr>
<td>Min Measured Position Limit</td>
<td>Minimum allowed measured position. The Min Measured Position event will become active if the measured position exceeds this value.</td>
</tr>
<tr>
<td>Max Target Position Limit</td>
<td>Maximum allowed target position. The Max Target Position event will become active if the target position exceeds this value.</td>
</tr>
<tr>
<td>Min Target Position Limit</td>
<td>Minimum allowed target position. The Min Target Position event will become active if the target position exceeds this value.</td>
</tr>
<tr>
<td>Disable Position Limits Checkbox</td>
<td>Allows you to disable position limits so the motor has no maximum or minimum position value.</td>
</tr>
</tbody>
</table>

Note that position limits will be ignored during homing routines. This setting can be changed via network commands.

### 3.8.4 Stop

The Stop window configures software deceleration behavior. This field controls the deceleration limit for all stop actions and direction stops. If the drive is controlling velocity or position, the load decelerates according to the user-defined deceleration limit. If the drive is controlling current, the drive will command zero current with no deceleration control.

Events that trigger the Stop function can be configured in “Events” on page 43. Be sure to use deceleration values that are realistic and physically possible given the system constraints. For example, the more inertia a motor has, the longer it will take to stop. If you try to use limits that are not physically possible, the motor may move unpredictably during the deceleration period.
3.8.5 Voltage Limits

Use this window to set the User Under- and Over-Voltage limits. These limits are restricted to fall within the hardware capability of the drive. The Nominal DC Bus Voltage should contain the normal operating DC voltage supplied to the drive. If using an AC input drive, the Nominal DC Bus voltage is equal to the AC voltage multiplied by 1.41.

**Shunt regulator operation**

The shunt regulator (if available, depending on drive model) can be enabled/disabled and its turn-on voltage can be set at any given voltage below the hardware over-voltage limit of the drive. The internal shunt resistor parameters, if present, are displayed.

If the drive has provision for connection of an external shunt resistor, the parameters for that resistor can be entered. If that provision is not available, these fields will not be available. Check the data sheet for your drive to see if an external shunt resistor can be connected.

The shunt regulator method is used to dissipate excess energy during periods of rapid deceleration. In most cases, this energy can be consumed in a matter of milliseconds. If a longer regeneration time is needed, the drive will limit the output to the resistor according to the following information.

- Measured Bus Voltage
- Shunt resistor Power
- Shunt resistor Resistance
- Shunt resistor Inductance (if unknown, use zero)

**Note**

If the stated resistor power or resistance is incorrect, the drive cannot reliably regulate the power dissipated.

**Caution**

There is a limit to the amount of current the drive can output to the shunt without damaging the circuitry. The resistance of the external resistor should be large enough to handle this current. Follow the table below to determine the absolute minimum resistance that the shunt circuitry can handle.

<table>
<thead>
<tr>
<th>Drive Power Module</th>
<th>Minimum Shunt Resistance (Ohms)</th>
</tr>
</thead>
<tbody>
<tr>
<td>015A400</td>
<td>N/A</td>
</tr>
<tr>
<td>030A400</td>
<td>20</td>
</tr>
<tr>
<td>060A400</td>
<td>10</td>
</tr>
<tr>
<td>100A400</td>
<td>10</td>
</tr>
<tr>
<td>030A800</td>
<td>Consult Factory</td>
</tr>
<tr>
<td>060A800</td>
<td>40</td>
</tr>
<tr>
<td>C060A400</td>
<td>20</td>
</tr>
<tr>
<td>C100A400</td>
<td>25</td>
</tr>
</tbody>
</table>
External shunt resistor power selection

During a regenerative event, the shunt output will initially turn on for 10ms, and the entire bus voltage is placed across the shunt resistor to allow the excess bus voltage to fall below the shunt enable threshold during normal regeneration.

This initial turn-on is independent of the shunt resistor information entered; therefore the power dissipated through your shunt resistor may exceed the rated power during the first 10ms. If using an external shunt resistor, be sure the resistor can handle this 10ms pulse.

After this initial pulse, if the bus voltage is still higher than the shunt turn on voltage, the shunt output will turn on and off rapidly in order to regulate the power dissipated. For both external and dual shunt modes, the on time and period are adjusted such that the shunt is on for approximately 3 time constants while maintaining the same duty cycle. The highest duty cycle attainable is 50%. The drive sets the on-time PWM output to a duty cycle such that:

\[
\frac{V_{bus}^2}{R} \times DC = P_{max}
\]

- \(V_{bus}\) = measured bus voltage (Vdc)
- \(R\) = shunt resistance (ohms) - specified in setup software for external shunt
- \(P_{max}\) = maximum shunt power (W) - specified in setup software for external shunt
- \(DC\) = PWM duty cycle

The period of the PWM output is set as \([V_{bus}^2/(R \times P_{max})]\) * \(T_{on}\), with \(T_{on}=2/F_s\), where \(F_s\) is the switching frequency of the drive (Hz). The average current going through the shunt resistor will be less than or equal to \(V_{bus}/2R\). The average power through the shunt resistor during this time will be less than or equal to \((V_{bus})^2/4R\).
3.8.6 Temperature Limits

The Temperature Limits tab allows configuration of an external temperature sensor. Configuration options are dependent upon the specific drive hardware. Certain drives accept an external temperature sensor in the form of either a switch or a thermistor. Use the "Sensor Type" pull down list to select the type of sensor in use.

Switch

For applications using a switch as an external temperature sensor, select whether the Motor Over Temperature event will occur when the switch is open or closed.

Thermistor

For applications using a thermistor as an external temperature sensor, input the resistance value when Motor Over Temperature will activate, and at what resistance Motor Over Temperature will become inactive. Acceptable input values range from 0 to 5000 Ω. Both negative thermal coefficient (NTC) and positive thermal coefficient (PTC) thermistors are supported. The setup software will automatically determine the thermistor type based on the values entered in the Event Action fields.

If the Event Action Active Level is greater than or equal to the Event Action Inactive Level, then:

- The Motor Over Temperature event will turn on when the resistance becomes **higher** than the Event Action Active Level.
- The Motor Over Temperature event will turn off when the resistance becomes **lower** than the Event Action Inactive Level.

If the Event Action Active Level is set less than the Event Action Inactive Level, then:

- The Motor Over Temperature event will turn on when the resistance becomes **lower** than the Event Action Active Level.
- The Motor Over Temperature event will turn off when the resistance becomes **higher** than the Event Action Inactive Level.

Other drives are capable of accepting an analog temperature sensor that can be connected to an analog input of the drive. You can configure a maximum allowable motor temperature at which point the drive will be disabled. The motor temperature level at which the drive can be re-enabled can also be configured. For a digital temperature sensor, see the digital inputs section of “Inputs / Outputs” on page 32.
### 3.9 Events

The Basic and Advanced Events windows let you configure or review actions associated with certain drive events. For a full list of drive events and recommended troubleshooting methods, see "Events and I/O Descriptions and Troubleshooting Methods" on page 115.

The diagrams below illustrate the behavior of an event and the corresponding event action.

<table>
<thead>
<tr>
<th>Event Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>No Action</td>
<td>Event Action is disabled</td>
</tr>
<tr>
<td>Disable Power Bridge</td>
<td>No power is delivered to the motor. Motor is allowed to move freely.</td>
</tr>
<tr>
<td>Disable Positive Direction</td>
<td>Disables the drive from outputting to the motor in the positive direction, while allowing commanded motion in the negative direction. The result is dependent on the mode of operation. This action is not recommended in vertical applications because the load will be free to fall once the limit is activated. For vertical loads, we recommend using 'Positive Stop'.</td>
</tr>
<tr>
<td>Disable Negative Direction</td>
<td>Disables the drive from outputting to the motor in the negative direction, while allowing commanded motion in the positive direction. The result is dependent on the mode of operation.</td>
</tr>
<tr>
<td>Dynamic Brake</td>
<td>Motor leads are virtually shorted together internally. However, the bridge enables to protect motor by regulating motor current.</td>
</tr>
<tr>
<td>Positive Stop</td>
<td>If the drive is controlling velocity or position, the load decelerates according to the deceleration limit specified in the Stop Limits window. If the drive is controlling current, the drive will command zero current with no deceleration control. Commanded motion in the positive direction has no affect. Motor continues to servo with zero command in the positive direction.</td>
</tr>
<tr>
<td>Negative Stop</td>
<td>If the drive is controlling velocity or position, the load decelerates according to the deceleration limit specified in the Stop Limits window. If the drive is controlling current, the drive will command zero current with no deceleration control. Commanded motion in the negative direction has no affect. Motor continues to servo with zero command in the negative direction.</td>
</tr>
<tr>
<td>Stop</td>
<td>If the drive is controlling velocity or position, the load decelerates according to the deceleration limit specified in the Stop Limits window. Commanded motion has no affect. Motor continues to servo with zero command.</td>
</tr>
<tr>
<td>Apply Brake then Disable Bridge</td>
<td>Brake output is turned on, and then the bridge is disabled. The delay is set in the Braking window.</td>
</tr>
<tr>
<td>Apply Brake then Dynamic Brake</td>
<td>Brake output is turned on, and then the dynamic brake is applied. The delay is set in the Braking window.</td>
</tr>
</tbody>
</table>
3.9.1 Basic Events

The Basic Events window allows for simple configuration of some common drive events. Select an Event Action from the drop-down lists for each drive event.

- **Latch**: If the latch box is checked, the selected Event Action will remain active until the event is removed or you perform one of these actions:
  - Cycle power to the drive
  - Refresh the Drive Status

3.9.2 Advanced Events

The Advanced Events window allows in-depth customization of the way the drive responds to certain drive events. Events under Advanced Settings can correspond to one of the following groups.

<table>
<thead>
<tr>
<th>Group</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fault</td>
<td>Critical events that result in the drive being disabled.</td>
</tr>
<tr>
<td>User Action</td>
<td>Event actions that are activated via a digital input or other external interface.</td>
</tr>
<tr>
<td>Software Action</td>
<td>Event actions that are a result of an internal event.</td>
</tr>
<tr>
<td>Motor</td>
<td>Events directly related to the motor.</td>
</tr>
<tr>
<td>Feedback</td>
<td>Events directly related to the motor feedback signals.</td>
</tr>
<tr>
<td>Command</td>
<td>Events related to the command source or command signal.</td>
</tr>
<tr>
<td>Current</td>
<td>Events related to the current output as measured by or limited by the drive.</td>
</tr>
<tr>
<td>Velocity</td>
<td>Events related to the velocity as measured by or limited by the drive.</td>
</tr>
<tr>
<td>Position</td>
<td>Events related to the position as measured by or limited by the drive.</td>
</tr>
<tr>
<td>Shunt</td>
<td>Applicable to drives that support a shunt regulator only. Event indicates when the shunt regulator is active.</td>
</tr>
</tbody>
</table>

Each event has several programmable attributes that can be edited by clicking on an event row:

- **Delay**: The time delay between the actual occurrence of the event and the event action.
- **Action**: The action to be taken by the drive after the response time has elapsed. For safety reasons some actions are not available with some events.
- **Recovery**: The time after which the selected event action will be removed when the cause of the event is no longer present.
- **No Repeat**: The time, after the recovery time and subsequent removal of the event action, during which the drive will NOT consider an occurrence of the event as a new occurrence. The Event Action will still be applied in case an event does occur within this window. However, that occurrence will not be counted as a new occurrence with regard to the Maximum Recoveries attribute.
- **Recoveries**: The number of occurrences of the event prior to a permanent event action. The number of recoveries can be set to a specific value, or to Latch or Unlimited.
3.10 Network Settings

The *Network > Settings* window allows configuration of network communication settings. Note that the settings entered in the Network Settings window are not necessarily the same as the connection settings used to connect to the drive. Network Settings fields may only be changed when connected over the serial interface (RS232 or USB, depending on the drive model). The window display is specific to the type of network the drive hardware is compatible with (note the type of Ethernet protocol is selected in the *Drive Name* > *Settings* window in the System Browser).

### Configurable Settings

<table>
<thead>
<tr>
<th>Network Type</th>
<th>Configurable Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CANopen</td>
<td>Address</td>
<td>Sets the CANopen Node ID (1 - 127)</td>
</tr>
<tr>
<td></td>
<td>Baud Rate</td>
<td>Selects the CAN bus speed (kbit/s).</td>
</tr>
<tr>
<td></td>
<td>Initial Mode of Operation (6060)</td>
<td>Specifies the mode of operation (6060) initial value. This is the initial mode after a communication reset or power cycle. The mode changes will be applied upon drive reset.</td>
</tr>
<tr>
<td></td>
<td>Cyclic Mode Period</td>
<td>Defines the cyclic interpolation cycle time (ms). Value should be equal to the target update rate sent by the host in cyclic position, velocity, or torque mode.</td>
</tr>
<tr>
<td></td>
<td>Guard Time</td>
<td>Guard Time and Life Time Factor (both in ms) determine a &quot;Lifetime&quot; for each NMT slave in the network (Lifetime = Guard Time x Life Time Factor). If a node does not receive a Node Guard message within its Lifetime, the node assumes communication with the host is lost and triggers a communication error event. Each node may have a different Lifetime.</td>
</tr>
<tr>
<td></td>
<td>Life Time Factor</td>
<td></td>
</tr>
<tr>
<td>RS485 / Modbus RTU</td>
<td>Drive Address</td>
<td>Sets the RS485 drive address (1 - 63)</td>
</tr>
<tr>
<td></td>
<td>Baud Rate</td>
<td>Selects the RS485 communication baud rate (kbit/s).</td>
</tr>
<tr>
<td>EtherCAT</td>
<td>Station Alias</td>
<td>Sets the Station Alias of the drive (0 - 256)</td>
</tr>
<tr>
<td></td>
<td>Initial Mode of Operation (6060)</td>
<td>Specifies the mode of operation (6060) initial value. This is the initial mode after a communication reset or power cycle. The mode changes will be applied upon drive reset.</td>
</tr>
<tr>
<td></td>
<td>Cyclic Mode Period</td>
<td>Defines the cyclic interpolation cycle time (ms). Value should be equal to the target update rate sent by the host in cyclic position, velocity, or torque mode.</td>
</tr>
<tr>
<td>Ethernet / Ethernet Powerlink / Modbus TCP*</td>
<td>Node ID</td>
<td>Sets the Node ID (1 - 255)</td>
</tr>
<tr>
<td></td>
<td>User Defined IP</td>
<td>Allows entry of a user defined IP address by selecting the checkbox.</td>
</tr>
<tr>
<td></td>
<td>Initial Mode of Operation (6060)</td>
<td>Specifies the mode of operation (6060) initial value. This is the initial mode after a communication reset or power cycle. The mode changes will be applied upon drive reset.</td>
</tr>
<tr>
<td></td>
<td>Cyclic Mode Period</td>
<td>Defines the cyclic interpolation cycle time (ms). Value should be equal to the target update rate sent by the host in cyclic position, velocity, or torque mode.</td>
</tr>
</tbody>
</table>

*When using Modbus TCP, only the User Defined IP address is configurable

**Drive Operation Mode**

On certain drives, the *Drive Operation* options in the *Drive Name* > *Settings* window are available to configure the drive for Network Mode or Stand-Alone Mode.

- **Network Mode** should be used when the drive will be controlled over the network, and will restrict the drive to use the state machine defined by the network. This means a network command is required to transition the drive out of the fault state before the bridge can be enabled.
- **Stand-Alone Mode** should be used when the drive will not be connected to a network. Stand-Alone Mode allows the drive to automatically recover from disabling events such as User Disable when the event is no longer active.
3.11 PDO Configuration

The PDO Configuration windows are available for drives that support the CANopen communication protocol and are opened by selecting the appropriate option under the Network heading in the System Browser.

The PDO Configuration windows allow the configuration of PDO mapping assignments, and the option of exporting the project file as a .DCF (CANopen drives) file by clicking the Export DCF button.

3.11.1 RPDOs - CAN Drive

The CAN drive RPDO mappings are pre-configured and cannot be changed in the setup software. However, each RPDO can be manually enabled or disabled in one of two ways:

- Click on the Load Preset button to select a pre-determined RPDO configuration.
- Select the desired RPDO in the Object Assignments box, then check or uncheck the PDO Enabled checkbox.

The PDO Settings box allows further RPDO configuration:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>COB-ID</td>
<td>Enter the COB-ID for the selected RPDO (181h - 57fh)</td>
</tr>
<tr>
<td>Transmission Type</td>
<td>Set the transmission type for the selected RPDO</td>
</tr>
</tbody>
</table>

3.11.2 TPDOs - CAN Drive

The CAN drive TPDO configuration and settings controls function in the same way as the RPDOs (“RPDOs - CAN Drive” on page 46) with the addition of RTR and period configuration.

Except for TPDO 26, the CANopen TPDO mappings are pre-configured and cannot be changed in the setup software. TPDO 26 can hold up to eight objects, or 64 bits. The number of objects that can be assigned will be limited by the size of the objects.

To map an object to TPDO 26, drag an object from the Available Objects box over to the Object Assignments field. Objects will be relegated to TPDO 26 automatically in the order in which they are assigned. To change the order of a selected object assigned to TPDO 26, use the and buttons. The button will remove the selected object from TPDO 26.

The Mapping Capacity bar displays how much space remains for objects to be assigned to TPDO 26.
3.11.3 TPDO Events - CAN Drive

The CAN drive TPDO Events tab is used to assign TPDOs to specific events. Drag TPDOs from the *Available PDOs* box to one of the event fields. By clicking on a desired event, the *Event Settings* box can then be used to further configure the event, or to remove the assigned TPDO(s).

**Timer Events**

Sets the cycle time of the assigned TPDOs. If the cycle time is set to 0, the assigned TPDOs will be transmitted continuously.

**Bit Monitor Events**

The Bit Monitor identifies an object which is observed continuously. Select an object from the *Observed Object* drop down box. If the observed bits change the TPDO(s) assigned to the Bit Monitor will be sent. The observed bits are defined by the *Bit Mask* field (0 to FFFF in hex).

**Value Events**

The Value Changed event observes an object continuously, defined by the *Observed Object* drop down box. If the object changes by the user defined value entered into the *Target Value* field the assigned TPDO(s) will be sent.

The Value Reached event observes an object continuously, defined by the *Observed Object* drop down box. If the object reaches the user defined value entered into the *Target Value* field in the selected *Direction*, the assigned TPDO(s) will be sent.

3.11.4 RPDOs and TPDOs - Ethernet Powerlink or EtherCAT

When using an Ethernet Powerlink or EtherCAT network, up to 16 words can be mapped to the RPDO and TPDO. A 16-bit object will take up 1 word, and a 32-bit object will take up 2 words. Objects can be assigned in one of two ways:

- Click on the *Load Preset* button to select a pre-determined RPDO or TPDO configuration.
- Drag-and-drop objects from the *Available Objects* field to the *Object Assignments* field. Use the , , and buttons to change the order or remove assigned objects.
3.12 Tuning

The selections under Tuning in the System Browser are used to set the control loop gains and configure filters and other tuning tools.

3.12.1 Current Loop Gains

There are two options for current loop (torque and flux) parameters:

- **Proportional Gain and Integral Gain**: Set the gain values according to conventional PI tuning rules.
- **Proportional Gain and Motor Pole**: Use for zero-placement in the current loop algorithm. The proportional gain setting is the overall gain of the current loop algorithm. When the Motor Pole value matches the actual motor electrical pole (the inverse of the motor electrical time constant), a critically damped response can be obtained with the largest overall proportional gain.

The Calculate button can be used to automatically set the current loop gains based on the values entered in the Motor and Limits windows. Typically these values will provide a good starting point and further gain adjustment is required for optimal tuning. Make sure proper motor and application data are entered prior to using this function.

3.12.2 Gain Sets

For a motion control system to work properly, the drive must be correctly tuned to the motor and/or system. This is accomplished with a set of gain values for each of the control loops in the drive. Most applications will not require gain switching, and therefore should use the default Gain Set 0. However, more than one set of gains may be required as the machine mechanics may change shape (effecting inertia) or the system is loaded or unloaded. The setup software allows the configuration of two separate sets of gain values, Gain Set 0 and Gain Set 1. Each gain set can be assigned to either Configuration 0 or Configuration 1 in the Configuration window.

To set the gain values, access the Gain Set windows by clicking on Tuning > Gain Set 0 or Gain Set 1 from the System Browser. Note that Gain Switching must be enabled in order for Gain Set 1 to be available to edit. Gain Switching can be enabled in the Drive Settings window (Drive > Settings). For a step-by-step guide to tune the drive to the system, see "Tuning and Commutation" on page 51.

The Gain Set values can be set according to conventional PID tuning rules:

<table>
<thead>
<tr>
<th>Gain Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Proportional Gain (Kp)</td>
<td>Increase for faster response and increased stiffness. Excessive proportional gain can cause overshoot and oscillation.</td>
</tr>
<tr>
<td>Integral Gain (Ki)</td>
<td>Increase to eliminate steady-state error and increase accuracy (i.e. amount torque/force per deflection). Excessive integral gain can cause instability and jitter.</td>
</tr>
<tr>
<td>Derivative Gain (Kd)</td>
<td>Increase to dampen response and reduce overshoot. Excessive derivative gain results in a more sluggish response. Depending on the feedback source, it may cause excessive jitter and noise.</td>
</tr>
</tbody>
</table>
Configuring the Drive / Tuning

Set Position  The Set Position function will change the value of the measured position and target position to the values defined in the "Preset Position" field. It is recommended to use the Set Position feature to avoid unexpected motor movement when enabling the bridge, as a large difference between the measured and target position may cause the motor to spin rapidly upon receiving power.

3.12.3 Filters

The Filters selections (Tuning > Filters) allow configuration of additional gain parameters that can be used for more in-depth loop tuning behavior. Note that the values entered in the Filters windows will effect both Configuration 0 and Configuration 1:

Velocity Feedback

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Feedback Filter Cut-off Frequency</td>
<td>Sets the cutoff frequency for the velocity feedback filter. This low-pass filter reduces velocity ripple (due to digitization). However, this will also affect closed loop performance. A typical setting is between 50 Hz and 1500 Hz.</td>
</tr>
<tr>
<td>Low Speed Smoothing (incremental encoder feedback only)</td>
<td>When using a standard incremental encoder, Low Speed Smoothing stabilizes the velocity loop during low-speed movement. To tune the low speed gain, use the Waveform Generator to command a low speed (1 or 2 rpm) and look at the velocity measured with the oscilloscope. Adjust the low speed gain to minimize the velocity spike as seen by the scope. Alternatively, this gain can be used to reduce jitter when position is tuned around the velocity loop.</td>
</tr>
</tbody>
</table>

Custom  The Custom Filters window allows the specification of biquad filter coefficients for different locations in the servo drive’s control loop. A separate biquad filter can be enabled for both Configuration 0 and Configuration 1. See “Control Loop Architecture” on page 109 for biquad filter locations. Note that only one biquad filter can be enabled at a given time for each Configuration. Determination of biquad coefficients is accomplished using a data computing language such as MATLAB or a similar programming environment. Most servo applications will not require the use of custom biquad filters. Implementation of the digital filter in the drive is according to Direct Form II, which results in a transfer function in z domain:

\[ Y_{BQ}(z) = \frac{K(b_0 z^2 + b_1 z + b_2)}{z^2 - a_1 z - a_2} \]

Note that numbers may be rounded due to the fixed-point representation. It is the responsibility of the user to determine system stability when user-specified coefficients are used.
The Advanced Settings window (Tuning > Advanced Settings) allows configuration of the Velocity and Position Integrator Decay functions.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Integrator Decay</td>
<td>Enabling Integrator Decay will reduce the integrator output each sampling cycle by the specified rate (0-100%) of the Integral Gain. This prevents the integrator from commanding a high current while trying to resolve a small error signal in high stiction applications. When Velocity Integrator Decay is enabled, decay will trigger if the velocity error going into the integrator is within the specified decay Active Window. When Position Integrator Decay is enabled, decay will trigger if the position error is within the specified decay Active Window.</td>
</tr>
</tbody>
</table>
Before proceeding, you must accomplish the following actions:

- Configure the limits and events parameters
- Connect the motor power and feedback

Drive tuning is a multi-step process that involves proper tuning of up to three different servo loops. Before tuning, the drive should have the appropriate parameters and limits configured as per the "Limits" on page 38. Following are the summary tasks you must perform; later in this chapter you will find the actual procedures with individual steps.

---

**Caution**

Sudden motion may occur! Tuning should only be performed after you have specified motor information, drive limits and events, and user units.

1. **Current Loop Tuning**: Once the drive parameters are configured properly, the current loop must be tuned. This is the innermost loop and forms the basis of all motion. You can select to have the current loop gains calculated based on motor and application data. This will typically provide a good starting point although some applications may require further refinement of the tuning parameters.

---

**Notice**

Make sure the drive is disabled before selecting Calculate Gains.

2. **AutoCommutation™**: This routine collects data on the motor and feedback parameters and asks the user to verify that they match what is entered into the Motor Data page. Some applications may have motors that cannot perform this routine due to mechanical constraints. See "Manual Commutation Procedure" on page 59 if you must perform manual commutation.

---

**Notice**

It is crucial to make sure the motor is unloaded during commutation; any load applied to the motor will skew the results of the routine.
3. **Velocity Loop Tuning:** If you want to operate the drive in velocity mode, you must tune the current loop and set up the drive to commutate the motor (steps 1 and 2). A very tight current loop inside of a relatively tight velocity loop may cause audible noise. If maximum bandwidth is not necessary, de-tuning the current loop usually removes most of the audible noise. The velocity loop will have to be adjusted any time the current loop tuning is changed.

4. **Position Loop Tuning:** You can either tune the position loop around the velocity loop, or around the current loop. Generally, it is much easier to tune a position loop around a velocity loop because only the proportional gain is needed. When tuning position around the current loop, a high derivative gain may be necessary on top of both proportional and integral gains.

For a diagram of how the setup software control loop architecture is implemented, see "Control Loop Architecture" on page 109.
4.1 Current Loop Tuning

Before beginning current loop tuning, make sure that the motor is free to move and de-coupled from the load, as sudden motion may occur. The motor and drive limits information must be correctly specified in the Motor and Limits windows before tuning the current loop. For current loop tuning, the Loop Configuration in the active Configuration can be set to any of the available options.

It is recommended to disable the drive by clicking on the Disable icon on the toolbar before beginning tuning. The procedure below will prompt you to enable the drive when necessary for tuning.

**Step 1: Inputs/Outputs Configuration setup**

1. Select Inputs/Outputs > Digital Inputs from the System Browser.
2. If an external Inhibit/Enable circuit is used during setup, assign the digital input that will be used to the User Disable function, and set the proper polarity (e.g., active high or active low).
3. If no external Inhibit/Enable circuit is to be used during setup, then the Enable/Disable icons on the toolbar will be used to control drive enabling.

**Step 2: Waveform Generator Setup**

1. Open the Scope/Tuning tab by clicking on the Scope/Tuning icon from the toolbar.
2. In the Waveform Generator pane, select the waveform Target as Current Loop.
3. Select the Square waveform Type.
4. Set Frequency to 100 Hz. If your motor has low inertia and is very responsive, use 150 Hz or 200 Hz.
5. Ensure Offset is zero.
6. Ensure Symmetry is 50%.
7. Set the waveform Amplitude to an appropriate value. Begin with 10% of the drive continuous current rating or 50% of the motor continuous current rating, whichever is lower.
8. Click the ON button to turn on the Waveform Generator.

**Step 3: Oscilloscope setup**

1. Select the Current oscilloscope preset from the Presets drop-down menu in the Scope/Tuning tab, or to manually configure the settings follow the steps below.
2. Change the channel 1 signal to Current Target.
3. Change the channel 2 signal to Current Measured.
4. Change the Trigger Source to Current Target with the Level set to zero.
5. Ensure Trigger Mode is Normal.
6. Change Time/Div to either 1 msec or 500 μsec.
Step 4: Tuning

1. With the Scope/Tuning window still open, select Tuning > Current Loop Gains from the System Browser.

2. To set starting values for the Current (Torque) Loop proportional (Kp) and integral (Ki) gains, click the Calculate button to calculate gains that utilize the values entered into the Motor Parameters, Feedback, and Limits windows. The specified motor inductance, resistance, and bus voltage determine the accuracy of the calculated values. If accurate data is not available, begin with Proportional Gain = 1 and the Integral Gain = 0.

3. Enable the drive by clicking the Enable icon. The motor should emit an audible noise but remain still.

4. Proper current loop tuning starts with zero integral gain while increasing the proportional gain until a 'knee' is formed (with no overshoot) in the Current Measured trace.

5. At this point, the proportional gain is done and the Integral gain must be slowly increased to close the steady state error between the Current Target and Current Measured traces.

6. Tuning changes with signal amplitude. Therefore you should now re-adjust the current amplitude in the Waveform Generator tab according to your most common application current requirements and re-tune. Contouring applications generally use small signal transients while point-to-point applications use larger signal transients.

7. When current loop gain adjustments are complete, disable the drive.

8. Turn off the Waveform Generator to remove the command signal from the drive by clicking the OFF button in the Waveform Generator pane.

9. Click Store on the toolbar to store the parameters to the drive's nonvolatile memory.

10. For Brushed or Brushless motors, no further current loop tuning is required. Skip to "Commutation" on page 57 to continue the Tuning and Commutation process. For AC Induction motors, continue to Step 5.

For reference, see "Current Limiting" on page 94.
Step 5: (For AC Induction Motors Only) Flux Reference Loop - Waveform Generator Setup

The preceding Steps 1 through 4 must also be performed for AC Induction motors.

1. Open the Scope/Tuning tab by clicking on the Scope/Tuning icon from the toolbar.
2. In the Waveform Generator pane, select the waveform Target as Flux Reference Current.
3. Select the Square waveform Type.
4. Set Frequency to 1 Hz.
5. Ensure Offset is zero.
6. Ensure Symmetry is 50%.
7. Set the waveform Amplitude to the No Load Current (as entered on the Motor Parameters page).
8. Click the ON button to turn on the Waveform Generator.

Step 6: (For AC Induction Motors Only) Flux Reference Loop - Oscilloscope Setup

1. Change the channel 1 signal to Flux Ref. Current Target.
2. Change the channel 2 signal to Flux Ref. Current Measured.
3. Change the Trigger Source to Flux Ref. Current Target with the Level set to zero.
4. Ensure Trigger Mode is Normal.
5. Change Time/Div to 100 msec.

Step 7: (For AC Induction Motors Only) Flux Reference Loop - Tuning

1. With the Scope/Tuning window still open, select Tuning > Current Loop Gains from the System Browser.
2. To set starting values for the Flux Loop proportional (Kp) and integral (Ki) gains, click the Calculate button that calculates gains that utilize the values entered into the Motor Parameters, Feedback, and Limits windows. The specified motor inductance, resistance, and bus voltage determine the accuracy of the calculated values.
3. Enable the drive by clicking the Enable icon. The motor should emit an audible noise but remain still.
4. Proper loop tuning will look similar to the figure below. Adjust Kp and Ki accordingly to remove any overshoot.

![Diagram](image)

5. When flux reference loop gain adjustments are complete, disable the drive.
6. Turn off the Waveform Generator to remove the command signal from the drive by clicking the OFF button in the Waveform Generator pane.

7. Click Store on the toolbar to store the parameters to the drive's nonvolatile memory.

**Step 8: (For AC Induction Motors Only) Commutation**

1. For AC Induction motors, all that is required for motor commutation is to command a DC current into the current loop.

2. Open the Scope/Tuning tab by clicking on the Scope/Tuning icon from the toolbar.

3. Select the waveform Target as Current Loop.

4. Select the DC waveform Type.

5. Set the waveform Amplitude to an appropriate value.

6. Click the ON button to turn on the Waveform Generator.

7. Enable the drive by clicking the Enable icon. The motor should spin quickly and smoothly in a constant direction. If the motor does not spin, or spins very slowly, it is likely the feedback polarity will need to be changed. Disable the drive. From the System Browser, select Motor > Parameters and change the feedback polarity, then Apply the change. Return to the Scope/Tuning window, and command the same DC current into the drive. The motor should now spin quickly and smoothly.

8. No further motor commutation is required for AC Induction motors. Skip to "Velocity Loop Tuning" on page 64 to continue the tuning process.
4.2 Commutation

Motor commutation is dependant on the type of motor and feedback available from the motor. Brushed motors have a commutator built into the motor housing; therefore the drive does not have to be configured to commutate them. Brushless DC (Trapezoidal), and AC (Sinusoidal), motors require a correctly configured drive to commutate.

Commutation of a permanent magnet servomotor is the process that maintains an optimal angle between the permanent magnet field and the electromagnetic field created by the motor current(s). This process ensures optimal torque or force generation at any motor position, regardless of speed, for brushless motors.

There are two ways to configure a digital drive to commutate a motor:

- **AutoCommutation™**: Most applications can use the AutoCommutation routine for configuring a drive to a specific motor. This routine will detect the feedback devices attached to the motor and ask the user to verify them against the motor’s datasheet.
- **Manual Commutation** requires more time, and may not be as accurate as AutoCommutation. You will have to perform this method if:
  - Your motor is mechanically restrained such that it is not free to move 2 revolutions + 1 electrical cycle in both directions (3 electrical cycles for a Brushless linear motor).
  - Your motor or load has a significant amount of inertia.
  - Your motor cannot be unloaded, or is a vertical load.
  - Your motor has a high degree of stiction.

### 4.2.1 AutoCommutation™

The AutoCommutation routine detects the motor feedback type and polarity, and then configures the drive commutation parameters appropriately.

Brushless and linear motors with insufficient travel distance (two revolutions plus one electrical cycle for rotary motors, or three electrical cycles for linear motors) or large amounts of inertia will require the Manual Commutation Procedure instead. AutoCommutation detection is not required for brush-type motors.

**Before you run AutoCommutation, be sure you:**

- Enter in the correct motor information in the Motor window page.
- Specify the correct feedback information.
- Specify limits to protect the motor.
- Tune the current loop.
- De-couple the motor from any load and secure the motor. Sudden motion will occur!

If you have not done the preceding, see the corresponding sections in this manual.
For brushless, stepper, and linear motors with sufficient travel distance, proceed as follows:

1. In Motor > Parameters, ensure that Sinusoidal Commutation is selected in the Commutation section of the window.
2. Open the AutoCommutation window (Motor > AutoComm).
3. If the drive is disabled, click the Enable icon to enable the drive.
4. Click Start AutoCommutation to begin the process. During the AutoCommutation process, monitor the distance traveled in each direction. The motor will move at 60 electrical degrees per second. Rotary motors will turn two revolutions plus one electrical cycle in each direction. Linear motors will move three electrical cycles in each direction. Motors with a high pole count will take a longer time to complete.
5. When AutoCommutation is complete, select whether the motor has moved the proper distance or has not moved the proper distance. If the motor did not move the proper distance, verify the pole count or pole pitch in the motor parameters window.
6. Once the motor has properly completed the AutoCommutation routine, verify the proper commutation and synchronization settings:
   - Commutation:
     - Trapezoidal - The drive uses Hall Sensors to commutate trapezoidally.
     - Sinusoidal - The drive uses a feedback device to perform sinusoidal commutation.
     - External Commutation (Brush) - The drive does not commutate the motor. Commutation is performed externally.
   - Synchronization: (It is recommended to synchronize on the index any time that an index exists. This will allow the drive to home to an index. If a different method of synchronization is selected other than on the index, the drive will not be able to home to an index.)
     - None - No synchronization is performed.
     - Halls - each hall cycle - Synchronization is performed on every rising edge of Hall A.
     - Index - Synchronization is performed on the rising edge of the encoder index pulse.
7. Click Apply from the toolbar to save the AutoCommutation parameters.
8. Click the Store Settings icon to store parameters to non-volatile memory.

AutoCommutation™ Warnings  After running AutoCommutation, it is possible that a warning (or warnings) may appear due to wiring errors or discrepancies between the information on the Motor Data page and the results of AutoCommutation.

Follow these steps to successfully complete AutoCommutation:
1. Review the information in the AutoCommutation warning box, then select OK.
2. Select 'Edit Motor Data’ from the options in the lower right hand corner.
3. Click ‘OK’ in the Pre-Loaded data dialog box.
4. On the Motor Data page, the relevant information will have been changed to correspond with the AutoCommutation results. Click ‘OK’, then click ‘OK’ in any dialog boxes to return to the AutoCommutation window.
5. Select ‘Accept’ in the AutoCommutation window. If the 'Accept' button is still grayed out, consult the general guidelines in the following table to diagnose and correct any AutoCommutation warnings, then re-run AutoCommutation.

<table>
<thead>
<tr>
<th>AutoCommutation Warning Text</th>
<th>Warning Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Primary Feedback Polarity Opposite from Motor Data</td>
<td>AutoCommutation detected that the feedback polarity of the primary encoder is the opposite of what is specified on the Motor Data page. This does not necessarily indicate an error, only that the observed polarity is different. In this case, it is best to trust AutoCommutation.</td>
</tr>
<tr>
<td>Different Feedback Devices from Motor Data</td>
<td>AutoCommutation detected a feedback device (usually Hall Sensors) that was not specified on the Motor Data page. Check motor data to be sure accurate information was entered.</td>
</tr>
<tr>
<td>Other Hall Phasing</td>
<td>AutoCommutation found Hall Sensor spacing that is outside the normal range for 60 degree or 120 degree Hall spacing. This does not necessarily indicate an error. It is acceptable to run with other Hall spacing.</td>
</tr>
<tr>
<td>Invalid Hall Sensors</td>
<td>AutoCommutation detected inconsistent Hall Sensors. This usually means one or more Hall Sensors are shorted or not properly connected. Check Hall wiring between motor and drive.</td>
</tr>
<tr>
<td>Inconsistent Index Transitions</td>
<td>AutoCommutation did not find the index signal consistently during its travel. Check to make sure the index signal of the encoder is properly wired to the drive. Can also indicate a noise issue. Check to make sure cables are properly shielded.</td>
</tr>
<tr>
<td>Inconsistent Encoder Transitions</td>
<td>AutoCommutation did not find encoder transitions during its travel. Check to make sure that the encoder’s A and B channels are properly wired to the drive, and that the encoder is properly powered. Can also indicate a noise issue. Check to make sure cables are properly shielded.</td>
</tr>
</tbody>
</table>

4.2.2 Manual Commutation Procedure

The large majority of applications do not require this method for configuring a drive to commutate the motor. However, because some applications cannot use the AutoCommutation routine, each drive defaults to a standard switching sequence that will commutate one of the six motor phase wiring combinations for a given feedback wiring configuration.

Before you perform manual commutation, be sure you have:

- Entered in the correct motor information in the motor data page.
- Specified the correct feedback information.
- Specified limits to protect the motor.
- Tuned the current loop.
- De-coupled the motor from any load and secured the motor. Sudden motion will occur!

Setting over speed limits
1. From the System Browser, go to the Limits > Velocity window, and set the maximum speed you wish the motor to spin for this test. Set this fairly high but not so fast it is dangerous if the motor spins away.

2. From the System Browser, go to the Events > Advanced window. In the Motor group, set the Motor Over Speed event Action to Disable Power Bridge and Unlimited Recoveries.

**Performing Manual Commutation (Incremental Encoder, Sin/Cos Encoder)**

1. Ensure Trapezoidal Commutation is selected in the Commutation window.

2. If the drive is enabled, click the Disable icon to issue a Software Disable and disable the drive.

3. Check the Drive Status panel for any faults or user inhibits that may be disabling the drive or preventing operation, and take corrective action to clear them. Software Disable should remain applied.

4. In the Motor > Manual Commutation window, it is recommended to use the default settings for Current, Rate, and Offset in the Drive Parameters and Procedure Settings and Status panes.

5. Enable the drive. Click and hold the Move Positive or Move Negative button in the Measurement pane. The needle in the diagram will begin to revolve. The measured commutation settings will appear as solid lines in the diagram.

6. Once the needle has travelled a complete rotation, release the Move... button. (Optionally, after completing a full rotation in one direction, click and hold the Move... button in the opposite direction for another full rotation to increase resolution.) If the measured commutation settings (solid lines) do not match up with the configured commutation...
settings (dashed lines), change the Commutation Sequence from the Drive Parameters pane so that the solid lines line up with the dashed lines.

7. To set the proper Encoder Direction, click and hold the Move Positive button. As the needle rotates, pay attention to the Position counter field. If the value is increasing as the needle moves forward, Encoder Direction should be set to Standard. If the value is decreasing as the needle moves forward, Encoder Direction should be set to Inverted.

8. Apply the commutation settings by clicking the Apply button in the Toolbar.

Performing Manual Commutation (Absolute Encoder - BiSS, EnDat, Hiperface)

1. If the drive is enabled, click the Disable icon to issue a Software Disable and disable the drive.
2. Check the Drive Status panel for any faults or user inhibits that may be disabling the drive or preventing operation, and take corrective action to clear them. Software Disable should remain applied.
3. In the Motor > Manual Commutation window, it is recommended to use the default settings for Holding Current, Holding Time, and Commanded Phase Angle in the Procedure Settings pane.
4. Enable the drive. Click the Start button. The motor should begin to rotate slowly (the current and position can be monitored in the Status pane).
5. Once the configured Holding Time has been reached, the Calculated Null Torque Angle (NTA) will be displayed in the Drive Settings pane. The Feedback Polarity will also be automatically adjusted to the correct setting, if necessary.
6. Apply the commutation settings by clicking the Apply button in the toolbar.

Re-Setting Over Speed Limits

1. In the Limits > Velocity window set the desired application Motor Over Speed.
2. In the Events > Advanced window, configure the desired event actions for the application.
3. Click the Store Settings icon on the toolbar to store the parameters to the drive non-volatile memory. The drive is now ready either for tuning the outer loops, or final commissioning and use.
4.2.3 Advanced Commutation

The Advanced Commutation window provides setup and commutation information for more advanced or non-typical commutation configurations or environments. Most applications will not require any adjustment of the Advanced Commutation values.

Note that not all of the Advanced Commutation parameters listed below are available for every drive. Only the commutation parameters specific to the drive and feedback device in use will be displayed in the setup software.

Changing settings in the Advanced Commutation window will automatically adjust settings that are also available in other windows (i.e. wiring polarities, commutation type, synchronization source, etc.).

<table>
<thead>
<tr>
<th>Commutation Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Wiring</td>
<td>Configures motor and feedback rotation and wiring information</td>
</tr>
<tr>
<td>Rotation Direction</td>
<td>Specifies the direction of motor rotation</td>
</tr>
<tr>
<td>Wiring Polarity</td>
<td>Specifies the polarity of the motor wiring</td>
</tr>
<tr>
<td>Feedback Polarity</td>
<td>Specifies the polarity of the feedback device connections. The proper setting for Feedback Polarity is necessary to prevent a motor runaway condition.</td>
</tr>
<tr>
<td>Phase Registration</td>
<td>Displays the counts per electrical cycle of the motor, and the Null Torque Angle at Zero Count. The NTA is configurable when using an absolute encoder.</td>
</tr>
<tr>
<td>Halls</td>
<td>For drives using Hall Sensors for commutation, displays the Hall Sensor phase centers.</td>
</tr>
<tr>
<td>Commutation</td>
<td>Configures the drive for Sinusoidal or Trapezoidal commutation. Also enables or disables Synchronization via an Index or Halls, and allows the configuration of Null Torque Angle values for the First Edge and Second Edge.</td>
</tr>
</tbody>
</table>

4.2.4 Phase Detect

Phase Detect is required for use with brushless and stepper motors with encoder feedback and without hall sensors. This routine must be performed before the motor can properly be commutated each time the drive power is cycled, or anytime sinusoidal commutation is lost.

The Phase Detect window will not be available in all cases, as the Phase Detect routine is not required for setup in all scenarios.

Notice

The reason is that without hall sensors, the motor position is initially unknown, and therefore cannot be properly commutated until a positioning routine is followed. Phase Detect will require motor motion for several seconds, and can be set up to be performed via a digital input, or automatically on power-up.

Be sure to enter motor data and run AutoCommutation if possible before running Phase Detect. Couple the motor to the load before you perform Phase Detection. Phase Detect is also used with absolute feedback devices (i.e., resolver or absolute encoder). This form of Phase Detect does not require motor motion.

- **Power-up Option**: Under most circumstances, the appropriate setting in the [Drive-Name] > Power-up tab is On First Enable Following Power-up. However, other options may be used depending on the configuration of your drive and motor.
• **Disable Events:** The positive and/or negative limit switches may be disabled in the *Phase Detect* window by checking the disable checkboxes under *Configuration*. This will prevent the limit switches from causing a premature phase detect failure.

• **Settling Time:** For Phase Detect to complete successfully, the absolute position must be determined when the motor is at a standstill. For motors with high inertia or low friction, the motor may take a longer time to come to a stop after the initial Phase Detect movement. Entering a Settling Time value greater than the amount of time that the motor takes to settle will allow Phase Detect to complete successfully in these cases. Depending on the motor, typical settling time values may range from one second to several seconds. The current that the drive will command to hold the motor at a standstill for the Settling Time duration will be the maximum continuous current value allowed by the hardware, or the software Peak Current level (if set below the hardware continuous current). If the Settling Time is longer than the the software Peak Current Time, then the commanded current will foldback to the software Continuous Current value.

• **Restrict Motion:** Unrestricted motion is recommended if the system will allow it for the best chance of successful Phase Detection. Unrestricted motion Phase Detection can be used against a hard stop. Restrict Motion should be used when sudden motor motion of up to ±1/2 electrical cycle is unacceptable in the system. Enable the Restrict Motion checkbox, and enter a motion value within the physical limits. The required motion for the Phase Detect routine is no more than ±1/2 of an electrical cycle. Phase Detect can complete successfully with less motion, but the success rate will be reduced.

• **Pulse Current:** This is the current used to excite the motor during a restricted motion Phase Detect. It should be large enough to move the motor (and load) smoothly, but not so much that the motor overshoots. A good starting current is one quarter of the RMS current to be used in your application. If you are trying to perform Phase Detect with no load on the motor, very little current will be required.

To perform Phase Detection, use the following procedure:

1. You may wish to monitor the following status events: Phase Detection, Phase Detection Complete, and Phase Detection Fault. These can be monitored with the Drive Status panel or can be assigned to digital outputs and monitored with a controller.

2. Configure the Phase Detect settings for Settling Time and Disable Positive/Negative Limits for what is appropriate for the system. For a restricted motion Phase Detect, select the Restrict Motion checkbox, and enter a motion value within the physical limits of the system, and an appropriate Pulse Current value.

3. Click the Phase Detect Button. Motion will occur, before the drive will hold the motor in a fixed location. This process may repeat multiple times while the drive collects data. If a restricted motion window has been defined, the motion will be confined within that window. Otherwise, Phase Detect will command several small moves of 45 electrical degrees.

4. Check Drive Status to make sure the Phase Detect routine was successful.

5. If Phase Detect was unsuccessful, the routine may automatically repeat again. It may be necessary to vary the Pulse Current and motion parameters to ensure successful Phase Detection.
4.3 Velocity Loop Tuning

Tuning of the velocity loop should only be performed after current loop tuning and motor commutation. Velocity loop tuning is dependent on the mechanical load, and therefore will change with any mechanical system changes. Velocity loop tuning should be performed with the motor installed in the system and connected to the load. Make sure that the load is free to move as sudden motion may occur. For velocity loop tuning, the Loop Configuration setting in the active Configuration must be set to either Velocity or Position around Velocity.

It is recommended to disable the drive by clicking on the Disable icon on the toolbar before beginning tuning. The procedure below will prompt you to enable the drive when necessary for tuning.

**Step 1: Waveform Generator setup**

1. Open the Scope/Tuning tab by clicking on the Scope/Tuning icon from the toolbar.
2. Select the waveform Target as Velocity Loop.
3. Select the Square waveform Type.
4. Set Frequency to around 1-3 Hz. The frequency should be slow enough to achieve commanded velocity, but fast enough to prevent the system from reaching a mechanical limit.
5. Ensure Offset is zero.
6. Ensure Symmetry is 50%.
7. Set the waveform Amplitude to approximately 10% of motor nominal speed.
8. Click the ON button to turn on the Waveform Generator.

**Step 2: Oscilloscope setup**

1. Select the Velocity Scope Preset, or to manually configure the settings follow the steps below.
2. Change the channel 1 signal to Velocity Target.
3. Change the channel 2 signal to Velocity Measured.
4. Change the Trigger Source to Velocity Target with the Level set to zero.
5. Ensure Trigger Mode is Normal.

**Step 3: Tuning**

1. With the Scope/Tuning tab still open, select Tuning > Gain Set 0 or Gain Set 1 from the Sysytem Browser, depending on which Gain Set is currently used for the active Configuration.
2. Begin by setting all the velocity loop gains to zero (Kp-Proportional, Ki-Integral, Kd-Derivative, Aff-Feedforward).
3. Enable the drive by clicking the Enable icon.
4. Proper Velocity loop tuning starts with zero integral gain while increasing the proportional gain until a "knee" is formed (with no overshoot) in the Velocity Measured
trace as shown below. There may or may not be an error between the Target and Measured traces, the key is to have a smooth knee shape.

5. At this point the Proportional gain is left alone and the Integral gain is increased slowly until the "knee" begins to deform as shown below. It is OK if the waveform does not start to distort until the integral gain is very high. When the distortion occurs, back off the Integral gain until the knee becomes smooth again.

6. Next, in order to improve the smoothness of the response, it may be beneficial to adjust the velocity feedback filter cutoff frequency in the Tuning > Filters window. The Filter Frequency is used to dampen oscillations and noise in the velocity measurements. For most systems, the ideal cutoff frequency will be somewhere between 50Hz and 1500Hz.

7. Most systems will be tuned properly at this point. If your system requires fine-tuning, you may adjust the derivative and feed-forward gains. If the motor starts to make audible noise, increase the Low Speed Smoothing in the Loop Filters window until the vibration and noise stops.

8. When tuning is complete, disable the drive by clicking the Disable icon on the toolbar. Turn off the Waveform Generator by clicking the OFF button in the waveform generator pane.

9. Click Store on the toolbar to store the parameters to the drive’s nonvolatile memory.
4.4 Position Loop Tuning

Position loop tuning is dependant on the mechanical load, and therefore will change with any mechanical system changes. Position loop tuning should be performed with the motor installed in the system.

The position loop can be closed around velocity or current (torque) mode. If it is closed around velocity mode, the position loop algorithm output becomes the new velocity set point. If it is closed around torque mode, the position loop algorithm output becomes the new current (torque) set point. There are some important differences in the tuning process and application of these two approaches:

- **Position around Velocity:** This mode is most common in "contouring" application, where a position trajectory must be tracked very closely. The velocity loop provides additional "stiffness", and keeps the dynamic position errors minimal, since the system now reacts to not just position errors, but also velocity errors (which can be interpreted as position error changes). It is important to start with a stable yet responsive velocity loop. Typically, it is sufficient to just use the position loop proportional gain. Feedforward gain can be added to improve tracking performance (i.e. minimize the difference between commanded and actual position). It is best to use a small step command as a reference signal during tuning.

- **Position around Current (Torque):** This mode is most common in point-to-point applications, where actual motion between start and end point is not very critical. In this case, velocity loop tuning can be avoided. This can be advantageous if the velocity feedback is poor (e.g., low resolution encoder, poor encoder quadrature, etc.). In this case, the tuning process requires that the position loop proportional and derivative gain are increased simultaneously, unless the system has sufficient friction, in which case no derivative gain is necessary. Once a stable response is achieved, integral gain can be added to improve stiffness. It is best to use a triangular waveform or a step command with the Command Limiter enabled as a reference signal during tuning.

For position loop tuning, the Loop Configuration setting in the active Configuration must be set to either **Position around Current** or **Position around Velocity**.

It is recommended to disable the drive by clicking on the Disable icon on the toolbar before beginning tuning. The procedure below will prompt you to enable the drive when necessary for tuning.

**Step 1: Waveform Generator setup**

1. Open the Scope/Tuning tab by clicking on the Scope/Tuning icon from the toolbar.
2. Select Position Loop as the waveform Target.
3. Select the Square waveform Type.
4. Set Frequency to around 1-3 Hz. The Frequency should be slow enough to allow the motor to settle in position.
5. Set Offset to zero.
6. Ensure Symmetry is 50%.
7. Leave the Amplitude at zero for the moment.
8. Click the ON button to turn on the Waveform Generator.
Step 2: Oscilloscope setup

1. Select the Position Scope Preset, or to manually configure the settings follow the steps below.
   1. Change the channel 1 signal to **Position Target**.
   2. Change the channel 2 signal to **Position Measured**.
   3. Change the Trigger Source to **Position Target** with the Level set to zero.
   4. Ensure **Trigger Mode** is Normal.
   5. Change **Time/Div** to 20-50 msec.

Step 3: Tuning

1. With the Scope/Tuning window still open, select **Tuning > Gain Set 0** or **Gain Set 1** from the System Browser, depending on which Gain Set is currently used for the active Configuration.
2. In the Gain Set tab, set all gains to zero (Kp-Proportional, Ki-Integral, Kd-Derivative, Vff-Velocity Feedforward, and Aff-Acceleration Feedforward).
3. The **Set Position** function is used to set the measured and target position to the value defined in the **Preset Position** field. It is recommended to set the Preset Position to zero before beginning tuning to avoid any unexpected jumps when the drive is enabled. Enter "0" in the Preset Position field, then click the **Set** button.
4. Enable the drive by clicking the Enable icon. Set the waveform **Amplitude** between 1/8 and 1/2 revolution for a rotary motor. Use the Proportional Gain, Integral Gain, and Derivative Gain sliders or arrow buttons in the Position Loop window to adjust the Position Measured waveform on the oscilloscope and match the Position Target as closely as possible without excessive overshoot. It is not necessary to adjust the Velocity or Acceleration Feed-forward Gains.
5. Readjust the Gains as Necessary.
6. When position loop gain adjustments are complete, disable the drive by clicking the Disable icon on the toolbar. Turn off the Waveform Generator by clicking the **OFF** button in the waveform generator pane.
7. Click the Store icon on the toolbar to store parameters to the drive's nonvolatile memory.
The Base Motion and Motion Engine selections of the System Browser are used to configure motion tasks. These features are used when it is desired to distribute motion to the drive, offloading the HMI, PC or PLC from calculating motion trajectories. This functionality provides greater flexibility to modify the drive behavior for the application.

Before executing any Motion Tasks, be sure to have:

- Entered in the motor and feedback parameters.
- Configured the drive limits and events.
- Tuned the necessary control loops and successfully completed AutoCommutation.
5.1 Motion Tasks

Motion Tasks are commands in the drive that will cause pre-defined motion on the axis. The tasks will generate trajectories that will be fed into the position loop. Motion Tasks may be performed on the benchtop or with a load on the motor. There are five types of Motion Tasks available for configuration in the setup software.

- Homing
- Indexes
- PVT
- Jogs
- Sequences

5.1.1 Homing

Homing is a Motion Task that defines Absolute Position to the drive with respect to the machine typically involving a sensor or switch located at a known position. The Home Task is not required to be used in applications with an absolute feedback device. The absolute position can be defined in the case of an absolute feedback device through the Phase Detect routine. Note that position limits will be ignored during homing routines. This setting can be changed via network commands.

Many different homing routines are supported. These routines rely on signals such as limit switches, home switches, and encoder indexes to accurately position the load.

To open the Home window, select Base Motion > Home from the System Browser. Set the Homing Speeds and Acceleration, then configure the Homing Method.

<table>
<thead>
<tr>
<th>Home Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fast Velocity</td>
<td>Value of the maximum velocity that can be commanded during search for first switch.</td>
</tr>
<tr>
<td>Slow Velocity</td>
<td>Value of the maximum velocity that can be commanded during search for Home. The slower the velocity, the more accurate the homing routine should be.</td>
</tr>
<tr>
<td>Homing Acceleration</td>
<td>Value of the acceleration and deceleration for motion.</td>
</tr>
<tr>
<td>Home Position</td>
<td>Position value set as the Home location.</td>
</tr>
<tr>
<td>Index</td>
<td>Selects whether an Index pulse is used on motor feedback for Homing.</td>
</tr>
<tr>
<td>Home Switch</td>
<td>Selects whether a Home Switch is in use.</td>
</tr>
<tr>
<td>Limit Switch</td>
<td>Selects whether a Limit Switch is in use.</td>
</tr>
<tr>
<td>Direction</td>
<td>Selects whether motion during the Home Task will begin in the positive or negative direction.</td>
</tr>
</tbody>
</table>

If no switches, index, or direction are selected, the homing routine will default to "Current Position". The "Current Position" homing routine will set the measured position equal to the specified home position value (typically zero) when executed.
The example below uses the index, the falling home switch edge and the positive limit switch to define the homing routine. The direction in which homing ends is in the negative direction as shown by the arrow.

For this particular routine, there are three possible scenarios. The scenarios are described as shown from top to bottom.

1. The home switch is inactive. Motion begins in the positive direction. When the home switch is encountered, motion starts in the negative direction. Homing completes at the first index pulse after the falling edge of the home switch.
2. The home switch is active. Motion begins in the negative direction. Homing completes at the first index after the falling edge of the home switch.
3. The home switch is inactive. Motion begins in the positive direction. When the positive limit switch is encountered, motion starts in the negative direction. Homing completes at the first index after the falling edge of the home switch.

**Homing method**  The set of drawings below illustrate the different components used to define the different homing routines. The components are grouped in the diagram to show events relative to motor/load position.

**Load and physical limits:** The square near the middle of the drawing shows the load object that is to be moved. The end points represent physical limitations or barriers in which the load cannot travel past. The left side is in the negative direction with the right side in the positive direction.

**Direction of travel:** The vertical line on the right side represents the starting position. The load travels in the direction of the arrow. In the drawing shown, the load would begin traveling in the negative direction and then switch directions to move in the positive direction. The circle represents the home position. This position is captured before the motor decelerates to zero velocity.

**Index Pulse:** Each vertical line represents one index pulse.

**Limit and Home Switches:** As shown, the switch can be either high or low. The vertical lines represent a toggle point.
5.1.2 Indexes

An Index task is defined by a set of basic parameters that define a profiled move. Up to 16 separately defined Index tasks can be configured (Index 0 - Index 15). An Index task can be either of the following types:

- **Absolute** - Commands a pre-defined move to an absolute position.
- **Relative** - Commands a pre-defined move relative to the current position.

To configure an Index task, select *Motion Engine > Indexes > Index 0...15* from the System Browser. Each Index task (Index00 - Index15) can be assigned a unique identifier in the *Name* field in the Indexes window, and any further labels or important information can be added in the *Comment* Field. Select the Index Type (Absolute or Relative) from the drop-down menu, then configure the Index task by setting values for the following parameters:

<table>
<thead>
<tr>
<th>Index Parameter</th>
<th>Description</th>
</tr>
</thead>
</table>
| Position/Distance | - (Absolute Index) The target position for the task.  
- (Relative Index) The target distance for the task relative to the current position. |
| Velocity | Value of the maximum velocity of the profile that can be commanded. The motion may not reach the maximum velocity depending on the values set for Acceleration, Deceleration, and Position/Distance. |
| Acceleration | Value of the acceleration for the profile. The profile will continue at this rate until Velocity is reached or the profile enters the deceleration phase. |
| Deceleration | Value of the deceleration for the profile. The profile will continue at this rate until the axis reaches zero velocity. The profile starts decelerating at a position so that the axis is at zero velocity at the Position value. |
| Dwell | After completion of motion the axis will dwell for this period of time. The task is still active during dwell time. |
| Start Location | Define a starting position for the index task. |

Click *Apply* to save the Index configuration once the values are entered.

**Executing an Index Task**

To perform an Index task, note that the drive and the Motion Engine must be enabled. The active drive Configuration should be set to Position around Velocity, and the Absolute Position Valid status must be active via the Homing, Phase Detect, or Set Position functions. Homing parameters are configured in the *Base Motion > Home* window in the System Browser. See "Homing" on page 69 for information on how to configure the Homing routine.

1. Configure an Index task from the Indexes window as described above.
2. Enable the drive by clicking the Enable icon on the toolbar. Select *Motion Engine > Run* from the menu bar or click the Motion Engine On icon on the toolbar to enable the Motion Engine.
3. Select *Tools > Motion Panel* from the menu bar to display the Motion Panel controls.
4. Use the drop-down arrow at the top-right of the Motion Panel window to select Indexes.
5. In the Motion Panel window, select a configured Index task from the *Motion* drop-down box in the *Identification* section. The selected index parameters will then be displayed in the Motion Panel.
6. Click the Home icon on the Motion Panel toolbar to home the drive.
7. To execute the selected Index task, click one of the following.

<table>
<thead>
<tr>
<th>Index Motion Commands</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Repeatedly Execute Motion in Reverse (Loop Reverse) - Relative Indexes only</td>
</tr>
<tr>
<td></td>
<td>Execute Motion in Reverse (Reverse) - Relative Indexes only</td>
</tr>
<tr>
<td></td>
<td>Execute Motion (Forward)</td>
</tr>
<tr>
<td></td>
<td>Repeatedly Execute Motion (Forward Loop) - Relative Indexes only</td>
</tr>
<tr>
<td></td>
<td>Loop over Forward and Reverse Motion (Cycle Motion) - Relative Indexes only</td>
</tr>
</tbody>
</table>

8. For a looped Index task, once the desired motion has occurred click the Halt Motion icon at the top of the Motion Panel to complete the move.

**Dynamic Indexes**

Dynamic Index tasks are configurable within the Motion Panel window. Both Absolute and Relative Index tasks can be defined using the Dynamic Index tool. The drive and the Motion Engine must be enabled to perform a Dynamic Index task. The active drive Configuration should be set to Position around Velocity, and the Absolute Position Valid status must be active via the Homing, Phase Detect, or Set Position functions. Homing parameters are configured in the Base Motion > Home window in the System Browser. See “Homing” on page 69 for information on how to configure the Homing routine. To execute a Dynamic Index task:

1. Enable the drive by clicking the Enable icon on the toolbar. Select Motion Engine > Run from the menu bar or click the Motion Engine On icon on the toolbar to enable the Motion Engine.
2. Select Tools > Motion Panel from the menu bar to display the Motion Panel controls.
3. Use the drop-down arrow at the top-right of the Motion Panel window to select Dynamic.
4. In the Motion Panel window, select the Index Type (Absolute or Relative).
5. Enter the desired motion parameters (Position, Velocity, Accel, Decel, and Dwell) into the Motion Panel.
6. Click the Home icon on the Motion Panel toolbar to home the drive if necessary.
7. To execute the selected Dynamic Index task, click one of the following.

<table>
<thead>
<tr>
<th>Dynamic Index Motion Commands</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Repeatedly Execute Motion in Reverse (Loop Reverse) - Relative Indexes only</td>
</tr>
<tr>
<td></td>
<td>Execute Motion in Reverse (Reverse) - Relative Indexes only</td>
</tr>
<tr>
<td></td>
<td>Execute Motion (Forward)</td>
</tr>
<tr>
<td></td>
<td>Repeatedly Execute Motion (Forward Loop) - Relative Indexes only</td>
</tr>
<tr>
<td></td>
<td>Loop over Forward and Reverse Motion (Cycle Motion) - Relative Indexes only</td>
</tr>
</tbody>
</table>

8. For a looped Dynamic Index task, once the desired motion has occurred click the Halt Motion button at the top of the Motion Panel to complete the move.
5.1.3 PVT

Typically, Position-Velocity-Time (PVT) is used to stream motion data between multiple axes for coordinated motion. Arbitrary position and velocity profiles can be executed on each axis. A PVT command contains the position, velocity, and time information of the motion profile’s segment end points. The servo amplifier performs a third order interpolation between segment end points. This results in a kind of partial trajectory generation where both host controller and servo amplifier generate a specific portion of the overall move profile trajectory. The host controller calculates position and velocity of intermittent points on the overall trajectory, while the servo amplifier interpolates between these intermittent points to ensure smooth motion. The actual position loop is closed within the amplifier. This reduces the amount of commands that need to be sent from host controller to amplifier, which is critical in distributed control systems. The number of segments and the time duration of each segment need to be selected based upon required accuracy and network bandwidth.

Suppose the motor is at rest and the values $P_1$, $V_1$, and $T_1$ are entered in the buffer to represent a PVT point $S_1 = (P_1, V_1, T_1)$. If the profile is executed, the drive will attempt to move the motor a distance of $P_1$ in $T_1$ seconds with a final velocity of $V_1$. The path of motion is calculated by using the difference between the initial and the target position and velocity points, and running them through a third order equation to produce a smooth motion profile. The figure below shows an example which involves multiple PVT points $S_1, S_2, S_3, ..., S_n$ and displays how smooth motion between these points can be produced.

![PVT Plot](image)

How To Construct A PVT Points File  A PVT file can be constructed using any simple-text editor (such as Microsoft® NotePad). Each line in the file represents a PVT point by specifying position, velocity, and time separated by semicolons.

Position and velocity are specified in user units (see "User Units" on page 85) whereas time is always in milliseconds. Furthermore, velocity is specified on an absolute basis whereas time is
specifies on an incremental basis with the largest allowable increment being 65535 milliseconds. Position must be absolute.

CAN standard supports a time step up to and including 255 milliseconds.

Enter the desired PVT points in a text file and load that data into the Motion Panel. When first saving a PVT file, be sure to replace the default *.txt extension with *.pvt when specifying the file name.

If using the Repeatedly Execute Motion (Forward Loop) option with a PVT file, be sure that the first PVT point in the file can follow logically after the last point in the PVT file, and that they contain the same position value. Lastly, when looping through several PVT points with small incremental times, be aware of the fact that the PVT buffer may have time to empty out all of its points before the PVT Generator has time to refill the buffer. Such an event will result in no more than the PVT Buffer Empty status becoming active and is the result of restrictions on the RS232 baud rate used by the software to communicate with the drive.

There is no limit to the number of PVT points you can place in the PVT file. These files are useful to repeat a desired sequence several times or to save the data for future use.

1. To get started, select the Open PVT File button.
2. Navigate to your PVT file (make sure it has a *.pvt extension).
3. The file name is displayed below the Open PVT File button.
4. To execute the selected PVT file, click one of the following.

<table>
<thead>
<tr>
<th>PVT Motion Commands</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Execute Profile (Run)</td>
</tr>
<tr>
<td></td>
<td>Loop over Profile (Repeat)</td>
</tr>
</tbody>
</table>

5. For a looped PVT command, once the desired motion has occurred press the Halt Motion button at the top of the Motion Panel to complete the move.

An example of a PVT file with correct formatting, named pvt_points_file.pvt, is shown below.

```
PVT Points File Example
```

---

**ADVANCED MOTION CONTROLS**

MNDGWWUG-12
5.1.4 Jogs

Jogs are Position Mode Motion Tasks that command motion at a defined constant velocity with infinite distance. Four separate Jog velocities can be defined (Velocity 0, 1, 2, and 3).

To configure a Jog Task, select Base Motion > Jog from the System Browser, then enter values for the following parameters:

<table>
<thead>
<tr>
<th>Jog Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Velocity (0,1,2,3)</td>
<td>Value of the maximum velocity of the profile that can be commanded.</td>
</tr>
<tr>
<td>Acceleration</td>
<td>Value of the acceleration for the profile. Shared by all Jog Velocity parameters. (Note: Value may be rounded after entry to account for drive unit conversion).</td>
</tr>
<tr>
<td>Deceleration</td>
<td>Value of the deceleration for the profile. Shared by all Jog Velocity parameters. (Note: Value may be rounded after entry to account for drive unit conversion).</td>
</tr>
<tr>
<td>Display Time</td>
<td>Sets the Jog graph time duration. For estimation/graphing purposes only, does not affect actual duration of Jog motion.</td>
</tr>
</tbody>
</table>

Click Apply to save the Jog parameters.

**Executing a Jog Task** To perform a Jog Task, the drive must be enabled. Note that the Motion Engine must be disabled before a Jog Task can be executed. If the Motion Engine is currently turned on, select Motion Engine > Run from the menu bar or click the Motion Engine ON icon on the toolbar to turn off the Motion Engine.

1. Configure a Jog Task from the Jog window as described above.
2. Enable the drive by clicking the Enable icon on the toolbar.
3. Select Tools > Motion Panel from the menu bar to display the Motion Panel controls.
4. Use the drop-down arrow at the top-right of the Motion Panel window to select Jog.
5. In the Motion Panel window, select the desired Jog Velocity. The selected Jog parameters will then be displayed in the Motion Panel.
6. To execute the selected Jog Task, click and hold one of the following.

<table>
<thead>
<tr>
<th>Jog Motion Commands</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Execute Motion in Reverse (Reverse)</td>
<td></td>
</tr>
<tr>
<td>Execute Motion (Forward)</td>
<td></td>
</tr>
</tbody>
</table>

7. The Jog motion will continue as long as the motion task button is held down. Release the motion task icon when the desired motion is complete.

5.1.5 Sequences

A Sequence is a set of steps that are Motion Tasks and Control Functions linked together and executed in a sequential order. With the exception of Jogs, any Motion Task can be used in a Sequence. Control Functions are all the non-motion steps that impact the flow of a sequence.

The setup software allows up to 16 different Sequences to be saved and stored to the project file and drive NVM. The Storage Used field will automatically update with the amount of memory used by the configured Sequences. Each Sequence can be given a unique name or number as an identifier, and selected by using the Seq ID drop-down menu or by choosing the desired Sequence from the System Browser tree view.
Each step in a Sequence is a distinct state of the Sequence. Steps are organized into one of the following groups: Motion, Sequence, If/Then, Wait For, and Set/Clear. Drag-and-drop step items from the Functions pane over to the Sequence list area in the Sequence pane to create a Sequence. The order of steps within a Sequence can be changed by using the ↑, ↓, or × buttons in the Sequence window.

**Functions**

<table>
<thead>
<tr>
<th>Motion</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Home</td>
<td>Runs the currently configured Homing routine.</td>
</tr>
<tr>
<td>Index</td>
<td>Runs an Index routine. After dropping the Index function into the Sequence list area, select the desired Index routine from the Identification pane. Indexes may be pre-configured or configured directly in the Sequence window.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Sequence</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start</td>
<td>Used to start a new Sequence, allowing Sequences to be chained together.</td>
</tr>
<tr>
<td>End</td>
<td>Used to end a Sequence. Note that it is not required to place an End function as the last step of a Sequence.</td>
</tr>
<tr>
<td>Label</td>
<td>Assigns a label to a point in a Sequence. After dropping the Label function into the Sequence list area, the label name can be entered in the Label Step pane. Labeled steps within a Sequence can be called out in other Sequence control functions within the same Sequence.</td>
</tr>
<tr>
<td>Jump To</td>
<td>Commands the Sequence to jump to a pre-configured Label within the same Sequence. Note that the labeled step in the Sequence must be configured before it can be selected in the Jump step. After dropping the Jump function into the Sequence list area, select the labeled point to jump to from the Jump to Step pane.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>If/Then</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Event / Input / Logic Bit</td>
<td>If/Then commands are used as test statements within a Sequence. Events, Digital Inputs and Logic Bits are selectable as test items. After dropping the desired test function into the Sequence list area, select the item to be tested from the If Event drop-down menu, and select whether to test if the item state is Set or Clear (Active or Inactive). The action the test step will take can then be selected from the then: drop-down menu. Some actions will only be available if the appropriate step has already been configured. For example, the option to “Jump To” a specific point in the Sequence will only be available if a Label has already been configured.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Wait For</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Event / Input / User Bit / Time / Value</td>
<td>Wait For commands will hold a Sequence from progressing to the next step for either a defined time period or until a specified event or action has occurred. A Time-out duration and subsequent Action can be entered for Wait For commands that are waiting for an event or action to occur. The setup software allows Wait For commands for certain drive Events, Digital Inputs, User Bits, and Measured and Target Position Values. The configurable Action taken at the end of the Time-out duration if the specified event has not occurred can be one of the following options: End the current Sequence, Start a new Sequence, Jump to a labeled point within the current Sequence, or Continue to the next step in the current Sequence.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Set/Clear</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Output</td>
<td>Commands a specified Digital Output to either trigger or clear.</td>
</tr>
<tr>
<td>Logic Bit</td>
<td>Commands a specified Logic Bit to either trigger or clear.</td>
</tr>
</tbody>
</table>

**Break Points**

- Up to two Break Points can be added to an inactive or active Sequence to pause the Sequence at a desired location. The Sequence will remain paused until either the Run or Single-Step button is selected to restart the Sequence progression.
- Break Points are added or removed by clicking on the white space between the Sequence # and the Sequence Step name in the Sequence list area.
**I/O Assignments**

- The I/O Assignments pane lists all the Digital Inputs and Outputs that may be selected for use in a Sequence.
- Digital Inputs or Outputs that are already assigned to other drive functions will be marked as "In Use".

**Invalid Sequence Steps**

- In the case where a step in any of the sequences has not been properly configured or initialized, a red flag icon will be visible next to the invalid step in the step list. All invalid sequence steps must be corrected before any sequences can be executed.
- If an invalid sequence step exists, the red flag button at the bottom of the Sequences window will automatically open the first sequence that contains an invalid step.
Each time the manufacturer releases a new setup software version or issues a firmware patch, you should update the firmware on your existing digital drives. When you work closely with the manufacturer, particularly for custom products, firmware changes may be required several times throughout your development process.

### 6.1 Prepare for Download

1. Connect to the drive.
2. Open the Connection Settings window by going to Drive > Connect, and changing the connection setting to a high baud rate.
3. Make sure the parameters are correct in both the setup software and the drive.
4. Store parameters to the drive’s nonvolatile memory.

### 6.2 Open the Firmware Download Window

Select Drive > Firmware Download on the menu bar to open the Firmware Download window.

This window allows changes and upgrades to the drive run-time firmware. For example, you may need to upgrade when a new version of software is to be used with an older drive or when a new drive needs a previous version to work in a system.

Check the Current Information window to view which firmware is currently in the drive. If the firmware file name matches the recommended name in the Select Firmware window, a firmware upgrade is unnecessary and you may click the cancel button. If the two names are different, you should update the firmware.

**Browse Folder/Browse File:** If the drive firmware is not installed in the default directory, you may need to browse for it. Use these buttons to navigate to where the firmware file is located.
6.3 Downloading the Firmware

1. Select the recommended firmware file.
2. Click on the Download button.
   This process may take several minutes depending on your connection.
3. The Close the dialog box when download completes box is checked by default so that you will return to the main workspace after firmware upgrade completes.
4. If the 'Bridge State on Power-up' option in the Power-up Control tab in Limits and Options is set to Enable, you will see a dialog window during the download asking if you would like to reset the drive after the firmware download is complete:
   Be aware that resetting the drive in this case will cause the power bridge to be enabled after the download is complete, unless there is a hardware limiting event active (invalid halls, digital inputs, etc). If you choose not to reset the drive, the bridge will be disabled upon download completion, and the drive will not go through its normal power-up sequence.
5. When the upgrade is complete, store the parameters to nonvolatile memory.
6. Read the release notes for information about new features and issues.

---

**Caution**

Do not power down or lose your connection during the process. If this happens, you may have to restart the download, or in extreme cases, send the drive back to the manufacturer.
This appendix describes helpful tools provided by the setup software.

A.1 Digital Oscilloscope

The digital scope is a powerful tool used for tuning and diagnostics. You can select from more than forty different signals to monitor while testing or troubleshooting your machine. Slower baud rates can affect the scope performance.

To open the digital oscilloscope, do one of the following:

- Select Tools > Scope/Tuning on the menu bar.
- Click on the Scope/Tuning icon on the tool bar.
- Select Control Loops > Scope/Tuning from the System Browser.

The oscilloscope provides real-time feedback and adjustment during tuning and setup. This multichannel digital scope behaves similarly to a traditional oscilloscope but provides access to internal drive signals. You can show up to eight channels at any time depending on the bandwidth used for each channel. The units used in the vertical division setting depend on the selected signal.

Standard prefixes such as $\mu$ (micro-), m (milli-), k (kilo-), M (mega-), are used for scaling factors. The bridge does not need to be enabled to use the scope. All that is required is that the drive be powered up and connected.

**Channel Select**  The Channel Select section provides selection of oscilloscope signals.

- **Add Signal:** Adds a new channel to the scope (if available) and allows you to select a corresponding signal of your choice. This button will be disabled (grey) if all oscilloscope channels are used.
- **Change:** Changes the currently selected signal to another one of your choice.
- **Remove:** Removes the selected channel from the scope.

A list of available channels and their definitions can be found in the “Signal Definitions” on page 88.
**Presets**  
Automatically configured oscilloscope settings that are frequently used when tuning the drive. Each preset has pre-determined unit and time per division scaling. Click on the corresponding button to either load a preset or save the existing layout as a preset. The presets will be reset to the defaults when DriveWare is closed and re-opened.

- **Current**: Configures the oscilloscope settings for monitoring a target current command and the measured drive output current.
- **Velocity**: Configures the oscilloscope settings for monitoring a target velocity command and the measured motor velocity.
- **Position**: Configures the oscilloscope settings for monitoring a target position command and the measured motor position.

**Display**  
The Display section provides configuration of the oscilloscope display settings.

- **Time/Div**: Shows the horizontal scaling time per division for the corresponding signal as seen in the digital scope display.
- **Scale**: Shows the units per division for the corresponding signal as seen in the digital scope display.
- **Offset**: Shows the offset associated with the signal as seen in the digital scope display.
- **Horizontal Location**: Allows adjustment of the horizontal (time-based) level at which the scope triggers.

**Trigger**  
The Trigger section provides configuration of the oscilloscope settings.

- **Source**: Displays the currently selected signal to be used as a trigger.
- **Level**: Allows you to select the level at which you want the scope to trigger.
- **Slope**: Sets the trigger slope to positive slope or negative slope.
- **Mode**: Sets the trigger mode to one of the following:
  - Normal Mode: The scope triggers according to the settings specified.
  - Single: The scope triggers once, according to the settings specified, after Run/Stop button is selected.
  - Auto: The scope triggers automatically, ignoring the settings specified.
  - Roll: The scope triggers in a continuous roll. Note: you will be limited to 200 msec/Div minimum while in roll mode.

**Measure**  
The Measure section provides real-time measurement between any two signals displayed on the oscilloscope.

- **Time**: This allows you to measure time differences between any two points on the scope display. Click the Time checkbox to display two vertical lines on the scope plot. The difference in time between the two lines is displayed in the box to the right of the checkbox. Left click to drag each line or right click to drag both.
- **Signal Level**: Select a channel for measurement from one of the two dropdown boxes. You may use either of the two dropdown menus to select a channel. The difference between the lines is displayed next to the channel selection dropdown; the selected channels units apply. Depending on whether the Time checkbox is selected, the values measured will either be horizontal time/div or vertical units/div. Left click to drag each line or right click to drag both.
A.1.1 Waveform Generator

The Waveform Generator is used to generate an internal signal during drive tuning and other procedures, eliminating the need for external signal sources during tuning. The Waveform Generator is in the Scope/Tuning window.

- **Target:** Select the destination for the waveform signal. Not Connected means the waveform signal will not be used. Command Limiter means the command signal will be limited as defined in the Command Limiter section of the active Configuration.
- **Type:** Select a DC (constant), square wave, triangle wave, or sinusoidal waveform.
- **Frequency:** Select the frequency of the waveform signal. This becomes inactive when "DC" is selected for the waveform type.
- **Amplitude:** Corresponds to the amplitude of the waveform signal (equivalent to half of the peak-to-peak value). Disabled in the case where a DC waveform is selected. Clicking on the [ ] button will set the amplitude to zero.
- **Offset:** Adds an offset to the selected waveform. If a DC waveform is selected, the offset corresponds to the DC signal amplitude.
  - When the Position Loop is enabled, the [ ] button will set the offset equal to the measured position.
- **Symmetry:** Corresponds to the duty cycle or symmetry of the waveform signal. This becomes inactive when DC is selected for the waveform type.

A.1.2 Data Capture

The Digital Oscilloscope includes an export feature that allows a user to capture oscilloscope data in a .CSV format. In order for the export feature to appear, the setup software must be connected to a drive. The Data Capture button at the bottom right of the Oscilloscope will be visible once connected. Selecting the Data Capture button will begin capturing oscilloscope data, and will open a Save As… dialog window that will specify where to save a .CSV file that will contain the data for the active oscilloscope signals. Once the desired oscilloscope data has been capture, click the End Capture button to stop the data export. The .CSV file will now be saved, and will organize the oscilloscope data for the active signals during the capture time frame as shown in the example below:

<table>
<thead>
<tr>
<th>Time</th>
<th>Position Target</th>
<th>Position Measured</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>1746</td>
<td>1676</td>
</tr>
<tr>
<td>20</td>
<td>1962</td>
<td>1899</td>
</tr>
<tr>
<td>40</td>
<td>2137</td>
<td>2082</td>
</tr>
<tr>
<td>60</td>
<td>2280</td>
<td>2237</td>
</tr>
<tr>
<td>80</td>
<td>2393</td>
<td>2362</td>
</tr>
<tr>
<td>100</td>
<td>2464</td>
<td>2447</td>
</tr>
<tr>
<td>120</td>
<td>2498</td>
<td>2492</td>
</tr>
<tr>
<td>140</td>
<td>2493</td>
<td>2499</td>
</tr>
<tr>
<td>160</td>
<td>2446</td>
<td>2469</td>
</tr>
<tr>
<td>180</td>
<td>2365</td>
<td>2397</td>
</tr>
<tr>
<td>200</td>
<td>2240</td>
<td>2283</td>
</tr>
<tr>
<td>220</td>
<td>2088</td>
<td>2133</td>
</tr>
</tbody>
</table>
Depending on the Trigger Mode selected, the Data Capture feature will function as given below:

- **Single**: File will contain 100 points for each signal. The data will include 50 points before / after the trigger.
- **Normal**: File is continuously filled with data 100 points at a time. The data is not continuous because it captures only 50 points before / after each trigger. Time starts over with each update.
- **Auto**: File is continuously filled with data 100 points at a time. The data is not continuous because it captures only 50 points before / after each update with some dead time. Time starts over with each update.
- **Roll**: File is continuously filled with data points. The data is continuous; however, the maximum capture rate is 10 points per 200ms.
A.2 Multimeter

The Multimeter allows you to monitor a multitude of signal types including positions, velocities, torques, and voltages. Use the Change Signal button to select the signal to monitor and display.

A resettable counter keeps track of the maximum and minimum values found, and shows the current maximum and minimum values in the corresponding display gauges. These values will update automatically if higher or lower values are detected. The Reset button below each display gauge will erase and reset the current maximum and minimum values.

You must be connected to a drive to use the Multimeter functions.

To open the multimeter, do one of the following:
- Select Tools > Multimeter on the menu bar.
- Click on the multimeter icon on the tool bar.

Up to four Multimeter windows can be opened at any given time. The Multimeter windows can be dragged, docked, and nested to multiple locations within the software workspace. Click and hold on the Multimeter window title bar, and drag the window to the desired location.

To see a list of available signals for the multimeter, see “Signal Definitions” on page 88.

Note

The multimeter samples signals at a rate of once every 250 ms or four times per second. If you want to measure a faster signal, use the Digital Scope.
A.3 User Units

The User Units window allows the specification of the general units to be used throughout the application. A variety of units are selectable. The User Units window also allows the definition of custom units.

The User Units window is found under Settings > User Units in the menu bar or by clicking on the User Units icon in the toolbar.

- Select the type of unit to be used for each data type (Torque, Position, Velocity, etc.) and the Load type (Rotary or Linear) from the drop-down menus. A scaling ratio between Feedback and Load units can also be defined.
- Selecting the Custom Units checkbox will allow the definition of custom units and labels. A scaling ratio between standard and custom units can also be defined.
The Motion Panel controls are opened by selecting *Tools > Motion Panel* from the menu bar. The Motion Panel is used to select and execute motion tasks that have been pre-defined in the Home, Jog, and Indexes windows, or to define parameters for a single index task with the Dynamic Index tool. The Motion Panel is also used to execute PVT commands.

The Motion Panel provides a set of control buttons for various motion functions. Note that Jogs only allow forward or reverse motion, and cannot be set for automatic looping.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Home Icon]</td>
<td>Execute the Home Method (home)</td>
</tr>
<tr>
<td>![Halt Icon]</td>
<td>Halt Motion (halt)</td>
</tr>
<tr>
<td>![Loop Reverse Icon]</td>
<td>Repeatedly Execute Motion in Reverse (loop reverse)</td>
</tr>
<tr>
<td>![Reverse Icon]</td>
<td>Execute Motion in Reverse (reverse)</td>
</tr>
<tr>
<td>![Forward Icon]</td>
<td>Execute Motion (forward)</td>
</tr>
<tr>
<td>![Forward Loop Icon]</td>
<td>Repeatedly Execute Motion (forward loop)</td>
</tr>
<tr>
<td>![Cycle Motion Icon]</td>
<td>Loop over Forward and Reverse Motion (cycle motion)</td>
</tr>
</tbody>
</table>

**Indexes**  
For more information on Indexes, see “Indexes” on page 71.
- Selects a pre-defined Index task (Index00 - Index15). Only Indexes that have already been defined in the corresponding Index window will be available for selection.
- The Index parameters will be displayed in the Motion Panel window.
- The available Motion Panel Index controls will depend on the type of index selected (Absolute or Relative).

**Dynamic Index**  
For more information on Dynamic Indexes, see “Indexes” on page 71.
- Configure parameters for a single index task within the Motion Panel window.
- Both Absolute and Relative Index tasks can be defined with the Dynamic Index tool.

**Jog**  
For more information on Jogs, see “Jogs” on page 75.
- Selects a pre-defined Jog task (0 or 1).
- The corresponding Jog velocity, accel, and decel will be displayed in the Motion Panel window.
- The Motion Engine does not need to be enabled to execute Jog tasks.

**PVT**  
For more information on PVT and how to construct a PVT points file, see “PVT” on page 73.
- Used to execute PVT commands from a PVT points file. Note that the Motion Engine must be turned off to use the PVT generator.
- A PVT file can be constructed using Notepad or a similar text editor program. Each line in the file represents a PVT point by specifying position, velocity, and time separated by semi-colons.
• Before running a PVT file, it is recommended to connect at the highest baud rate available, and to minimize the number of applications running in the background. Also close any unnecessary windows in DriveWare as they will slow down the rate at which the drive receives PVT points, possibly resulting in a PVT buffer error.

**Motion Status**

• Displays the real-time measured values for Position, Velocity, Torque (% of continuous current limit as defined in the Current Limits window), and position error.
• The Motion Status panel also displays the current state of the Motion Engine.

<table>
<thead>
<tr>
<th>Status</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disabled</td>
<td>The Motion Engine is not active. Enable the Motion Engine by using the toolbar icon or select Run from the Motion Engine menu bar selection.</td>
</tr>
<tr>
<td>Ready</td>
<td>The Motion Engine is enabled and ready to execute an Index or Sequence.</td>
</tr>
<tr>
<td>Executing</td>
<td>The Motion Engine is executing motion.</td>
</tr>
<tr>
<td>Loading</td>
<td>A Sequence or Index program is loading.</td>
</tr>
<tr>
<td>Halting</td>
<td>A Halt command has been asserted during an Index or Sequence move.</td>
</tr>
<tr>
<td>Not Home’d</td>
<td>Absolute Position is not valid. A Homing routine or Set Position function must be used before a motion task can be executed.</td>
</tr>
<tr>
<td>Bridge Wrong</td>
<td>The drive is disabled or stopped. The drive must be enabled before running a motion task.</td>
</tr>
<tr>
<td>Fault on Test</td>
<td>The If/Then test produced an error.</td>
</tr>
<tr>
<td>Single Step</td>
<td>A Sequence is being executed in Single-Step mode.</td>
</tr>
<tr>
<td>Break Point</td>
<td>A Sequence has stopped at a Break Point.</td>
</tr>
</tbody>
</table>

**A.5 Motor Diagnostics**

The *Motor Diagnostics* window is used to assist in system troubleshooting and diagnostics. Typically, the *Motor Diagnostics* procedure is ran while monitoring signals on the digital oscilloscope or Multimeter (i.e., comparing the *Commanded Phase Angle* to the measured position).

**Procedure Settings**

• The *Motor Diagnostics* procedure will move the motor at the entered *Holding Current* at the *Commanded Phase Angle* entered in the window for the amount of time entered in the *Holding Time* field.
• The drive must be enabled and clear of any disabling faults or event actions in order to run the *Motor Diagnostics* routine. Click the *Start* button to run the procedure. The routine will end automatically after the *Holding Time* has completed.
A.6 Signal Definitions

The following tables show all of the signals that can be measured using the Oscilloscope and Multimeter. These signals may also be used as analog outputs in compatible drives.

**Current measurements**

<table>
<thead>
<tr>
<th>Value</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current Target (Iq)</td>
<td>This is the commanded torque-producing current. Current limit settings are ignored.</td>
</tr>
<tr>
<td>Current Demand (Iq)</td>
<td>The commanded torque-producing current, after current limits have been applied. This value is zero when the drive is inhibited.</td>
</tr>
<tr>
<td>Current Measured (Iq)</td>
<td>The actual measured torque-producing current being delivered to the motor. Ideally, this value should be as close as possible to the demand current.</td>
</tr>
<tr>
<td>Id - Target</td>
<td>This represents the flux producing stator current in an AC induction motor. Id should equal zero when using a permanent magnet motor.</td>
</tr>
<tr>
<td>Id - Demand</td>
<td>This represents the flux producing stator current in an AC induction motor. Id should equal zero when using a permanent magnet motor.</td>
</tr>
<tr>
<td>Id - Measured</td>
<td>This represents the flux producing stator current in an AC induction motor. Id should equal zero when using a permanent magnet motor.</td>
</tr>
<tr>
<td>Current Phase A</td>
<td>The measured current in motor phase A. The sum of all three phases should add up to zero.</td>
</tr>
<tr>
<td>Current Phase B</td>
<td>The measured current in motor phase B. The sum of all three phases should add up to zero.</td>
</tr>
<tr>
<td>Flux Ref. Current Target</td>
<td>The commanded flux reference current ignoring limits. The flux reference current is the current induced in the rotor of an AC induction motor.</td>
</tr>
<tr>
<td>Flux Ref. Current Demand</td>
<td>The commanded flux reference current, after limits have been applied. The flux reference current is the current induced in the rotor of an AC induction motor.</td>
</tr>
<tr>
<td>Flux Ref. Current Measured</td>
<td>The measured flux reference current. The flux reference current is the current induced in the rotor of an AC induction motor.</td>
</tr>
</tbody>
</table>

For Iq and Id, “I” represents the peak of the current sine wave for an individual phase in a three phase motor.

Depending on the drive type, motor type, and motor settings, some of the signals may not be available.

**Velocity measurements**

<table>
<thead>
<tr>
<th>Value</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Velocity Target</td>
<td>This is the commanded velocity ignoring velocity limit settings.</td>
</tr>
<tr>
<td>Velocity Demand</td>
<td>The commanded velocity, after velocity limits have been applied. This value is zero when the drive is inhibited.</td>
</tr>
<tr>
<td>Velocity Measured</td>
<td>The velocity as measured by the velocity feedback device (after filtering).</td>
</tr>
<tr>
<td>Velocity Feedback</td>
<td>The velocity as measured by the velocity feedback device (before filtering).</td>
</tr>
<tr>
<td>Velocity Error</td>
<td>The difference between the motor's target velocity and measured velocity.</td>
</tr>
<tr>
<td>Velocity Reference</td>
<td>This is the commanded velocity before velocity loop input filtering or velocity offset.</td>
</tr>
<tr>
<td>Velocity Offset</td>
<td></td>
</tr>
</tbody>
</table>
## Position measurements

<table>
<thead>
<tr>
<th>Value</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Position Target</td>
<td>This is the commanded position ignoring position limit settings.</td>
</tr>
<tr>
<td>Position Demand</td>
<td>The commanded position, after position limits have been applied.</td>
</tr>
<tr>
<td>Position Measured</td>
<td>The position as measured by the position feedback device.</td>
</tr>
<tr>
<td>Position Error</td>
<td>The difference between the motor's target position and measured position.</td>
</tr>
<tr>
<td>Position Reference</td>
<td>This is the commanded position before position loop input filtering or position offset.</td>
</tr>
<tr>
<td>Position Offset</td>
<td></td>
</tr>
</tbody>
</table>

## Commutation

<table>
<thead>
<tr>
<th>Value</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sync Error</td>
<td>Synchronization is used with brushless motors to verify the commutation angle is valid for the measured position. When synchronization occurs, the drive compares the expected position to the measured position. If the two are not aligned, the drive cannot reliably commutate and a synchronization error results.</td>
</tr>
<tr>
<td>Hall State</td>
<td>The decimal equivalent of the binary combination of the three hall states where Hall A is bit 0 and Hall C is bit 2. (5V = 1, 0V = 0). It is important to note that the binary value is inverted for PCB drive models. For example, a standalone drive may read a Hall State of 1-1-1, while a PCB-mounted drive would read a Hall State of 0-0-0 in the same situation.</td>
</tr>
<tr>
<td>Phase Angle</td>
<td>The present number of degrees of the rotor inside one electrical cycle. Also may be called Electrical Angle.</td>
</tr>
<tr>
<td>Sync. Capture</td>
<td>The encoder count captured at the Synchronization edge. This will vary depending on the Sync edge chosen from AutoCommutation (Hall or Index edge).</td>
</tr>
<tr>
<td>Stator Angle</td>
<td>The present number of degrees of the stator inside one electrical cycle. This value is equal to the phase angle plus the slip angle.</td>
</tr>
</tbody>
</table>

## Voltage

<table>
<thead>
<tr>
<th>Value</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analog Output</td>
<td>The present voltage applied to the analog output.</td>
</tr>
<tr>
<td>DC Bus Voltage</td>
<td>The voltage the drive can output during the ON state of a PWM cycle. This is generally equivalent to the DC or rectified AC supply voltage to the drive. The DC Bus Voltage may be greater than the supply voltage when the motor is in a state of regeneration.</td>
</tr>
<tr>
<td>Voltage Phase A</td>
<td>The voltage, with respect to DC bus ground, applied to motor phase A</td>
</tr>
<tr>
<td>Voltage Phase B</td>
<td>The voltage, with respect to DC bus ground, applied to motor phase B.</td>
</tr>
<tr>
<td>Voltage Phase C</td>
<td>The voltage, with respect to DC bus ground, applied to motor phase C.</td>
</tr>
<tr>
<td>Analog Input</td>
<td>The voltage measured on the analog input pin with respect to signal ground.</td>
</tr>
</tbody>
</table>

## Command Limiter

<table>
<thead>
<tr>
<th>Value</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Command Limiter Input</td>
<td>The commanded signal before being profiled by the command limiter.</td>
</tr>
</tbody>
</table>

## Temperature

<table>
<thead>
<tr>
<th>Value</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Motor Temp.</td>
<td>The calculated motor temperature after being measured on the selected input and scaled according to the specified scaling value.</td>
</tr>
</tbody>
</table>
### Torque

<table>
<thead>
<tr>
<th>Value</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Torque Measured</td>
<td>The torque applied by the motor. This value is calculated from measured current, as delivered to the motor from the drive, and the motor torque constant entered in the Motor Data window.</td>
</tr>
</tbody>
</table>

### Drive

<table>
<thead>
<tr>
<th>Value</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drive Position</td>
<td>The position as measured by the drive in counts.</td>
</tr>
<tr>
<td>Drive Velocity</td>
<td>The velocity as measured by the drive in counts per second.</td>
</tr>
<tr>
<td>Raw ADC One</td>
<td>The full scale raw value of the ADC used for Analog Input 1</td>
</tr>
<tr>
<td>Raw ADC Two</td>
<td>The full scale raw value of the ADC used for Analog Input 2</td>
</tr>
<tr>
<td>Raw ADC Three</td>
<td>The full scale raw value of the ADC used for Analog Input 3</td>
</tr>
<tr>
<td>Raw ADC Four</td>
<td>The full scale raw value of the ADC used for Analog Input 4</td>
</tr>
</tbody>
</table>

### Feedback

<table>
<thead>
<tr>
<th>Value</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Primary Feedback</td>
<td>This signal is used by the drive for commutation purposes, and may differ from the measured position. For determining measured position, reference the Position Measured signal.</td>
</tr>
<tr>
<td>Aux. Feedback</td>
<td>The position as measured by the auxiliary feedback port. Only valid when Auxiliary Encoder is configured as a feedback device.</td>
</tr>
</tbody>
</table>

### Interface Input

<table>
<thead>
<tr>
<th>Value</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interface Input</td>
<td>The decimal value read from the interface input.</td>
</tr>
</tbody>
</table>

### Deadband Input

<table>
<thead>
<tr>
<th>Value</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Deadband Input</td>
<td>The commanded input before deadband is utilized. Measured in units of current, velocity, or position depending on configuration.</td>
</tr>
</tbody>
</table>

### PWM Input

<table>
<thead>
<tr>
<th>Value</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>PWM Duty Cycle</td>
<td>This represents the duty cycle of the input when the drive is configured for PWM as a command.</td>
</tr>
</tbody>
</table>

### PLS

<table>
<thead>
<tr>
<th>Value</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>PLS Input</td>
<td></td>
</tr>
<tr>
<td>PLS Pulse 1 State</td>
<td></td>
</tr>
<tr>
<td>PLS Pulse 2 State</td>
<td></td>
</tr>
</tbody>
</table>
## Capture

<table>
<thead>
<tr>
<th>Value</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Position Capture</td>
<td></td>
</tr>
<tr>
<td>Aux. Input Capture</td>
<td></td>
</tr>
</tbody>
</table>
A.7 Drive Status

The Drive Status panel shows drive events (current and history) and is a useful troubleshooting diagnostics tool. Click on the Drive Status tab in the Status Panel to view the Drive Status information.

The Drive Status pane shows data in three categories:

- Drive protection
- System protection
- System Status

For a description of drive events and recommended troubleshooting methods, see “Events and I/O Descriptions and Troubleshooting Methods” on page 115.

Use the icons at the top of the pane to select viewing options.

### Event States

<table>
<thead>
<tr>
<th>Icon</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Expand All Icon]</td>
<td>Expand All</td>
<td>Show all sub-categories.</td>
</tr>
<tr>
<td>![Collapse All Icon]</td>
<td>Collapse All</td>
<td>Hide all sub-categories.</td>
</tr>
<tr>
<td>![Reset Events Icon]</td>
<td>Reset Events</td>
<td>Clear the Drive Status window of any history events.</td>
</tr>
<tr>
<td>![Show Inactive Icon]</td>
<td>Show Inactive</td>
<td>Show or hide the inactive status events.</td>
</tr>
<tr>
<td>![Show History Icon]</td>
<td>Show History</td>
<td>Show or hide the status history events.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Icon</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Active Icon]</td>
<td>Active</td>
<td>An event that is active but not assigned to an action. This includes events assigned to No Action in the Event Manager window and pure status events that cannot be assigned an action.</td>
</tr>
<tr>
<td>![Disabling Event Icon]</td>
<td>Disabling Event</td>
<td>An event that is active and assigned to an action. An action either inhibits motion partially or disables motion completely according to the action assigned in the Event Manager window.</td>
</tr>
<tr>
<td>![History Icon]</td>
<td>History</td>
<td>An event which is not presently active, but was active at some point after the last time the drive was powered on or the last time the Reset Events button was used.</td>
</tr>
<tr>
<td>![Inactive Icon]</td>
<td>Inactive</td>
<td>An event that is not presently active, and has not been active since after the last time the drive was powered on or the last time the Reset Events button was used.</td>
</tr>
</tbody>
</table>
A.8 Critical Event Activity

The Critical Event Activity window is a list of drive protection events along with the time they occurred. The critical event activity window contains entries such as Short Circuit and Current Overshoot.

Click on the Critical Event Activity tab to view the Critical Event Activity information.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Refresh Icon]</td>
<td>Refresh</td>
<td>Refresh the Event Activity log.</td>
</tr>
<tr>
<td>![Export Icon]</td>
<td>Export</td>
<td>Export the Event Activity log to a text file.</td>
</tr>
</tbody>
</table>

A.9 Event Counters

Lists the total operating time of the drive and the number of times faults have occurred since the drive has been in operation.

Click on the Event Counters tab to view the Event Counters information.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Refresh Icon]</td>
<td>Refresh</td>
<td>Refresh the Event Counter values.</td>
</tr>
<tr>
<td>![Export Icon]</td>
<td>Export</td>
<td>Export the Event Counter values to a text file.</td>
</tr>
</tbody>
</table>

Event Counters automatically stores to the drive approximately once every nine minutes. If the drive power is shut off within this time frame and a manual store to NVM is not performed, the counter will not be incremented.
This topic explains current limiting for digital servo drives. The basic concepts of current limiting are introduced first, followed by a detailed explanation of some underlying formulas.

**B.1 Understanding the Limit Envelope**

Digital drives limit current output according to a well-defined software and hardware current limit envelope. These envelopes consist of Peak Current, for a specified amount of Peak Current Time, followed by a foldback to Continuous Current for an amount of time specified by the Foldback Time Constant.

**Foldback & current limit envelope**

1. The current limit envelope is shown in red.
2. You use drive setup software to configure the software envelope while the hardware envelope is fixed and defined by drive hardware limitations.
3. The Peak Current Time and Foldback Time Constant of the hardware envelope is the same for all drives, fixed at 2 and 10 seconds, respectively. The current values, however, depend upon the hardware with Peak Current and Continuous Current always equal to the maximum peak and continuous current rating of the drive.
The drive always compares each point on the user specified software envelope against each point on the hardware envelope and takes the lesser of the two to generate the actual application envelope. An example of this, where the hardware envelope almost entirely overrides the software envelope, is shown in Table 1. In this example, a constant 100% peak current command (shown in white) was given to the drive. Because, beyond the first two seconds, the hardware envelope (2 seconds Peak Current Time and 10 second Foldback Time Constant) is less demanding than the software specified envelope (65 second Peak Current Time and 65 second Foldback Time Constant), hardware current limiting is applied.

<table>
<thead>
<tr>
<th>Drive Hardware Limits</th>
<th>Peak Current (A)</th>
<th>12</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Continuous Current (A)</td>
<td>6</td>
</tr>
<tr>
<td>Drive Software Configuration</td>
<td>Peak Current (A)</td>
<td>12 (100%)</td>
</tr>
<tr>
<td></td>
<td>Continuous Current (A)</td>
<td>6 (100%)</td>
</tr>
<tr>
<td></td>
<td>Peak Current Time (Seconds)</td>
<td>65</td>
</tr>
<tr>
<td></td>
<td>Foldback Time Constant (Seconds)</td>
<td>65</td>
</tr>
</tbody>
</table>

Table 1
In order to have the software envelope entirely hold true, it must be specified such that it remains equal to or within the hardware envelope of the drive. Table 2 shows an example of a software configuration that will hold true in application (i.e. not be overridden by hardware limitations). For convenience, the drive hardware envelope has been superimposed (in red) on the image of Table 2.

<table>
<thead>
<tr>
<th>Drive Hardware Limits</th>
<th>Peak Current (A)</th>
<th>12</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Continuous Current (A)</td>
<td>6</td>
</tr>
<tr>
<td>Drive Software Configuration</td>
<td>Peak Current (A)</td>
<td>12 (100%)</td>
</tr>
<tr>
<td></td>
<td>Continuous Current (A)</td>
<td>6 (100%)</td>
</tr>
<tr>
<td></td>
<td>Peak Current Time (Seconds)</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td>Foldback Time Constant (Seconds)</td>
<td>5</td>
</tr>
</tbody>
</table>

Table 2
On the other hand, Table 3 shows the result of a user configured software envelope that falls outside of the allowed hardware envelope. The image in Table 3 shows how the drive will follow the specified software envelope up until it intersects the hardware envelope.

<table>
<thead>
<tr>
<th>Drive Hardware Limits</th>
<th>Drive Software Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Peak Current (A)</td>
<td>Peak Current (A)</td>
</tr>
<tr>
<td>Continuous Current (A)</td>
<td>Continuous Current (A)</td>
</tr>
<tr>
<td>12</td>
<td>12 (100%)</td>
</tr>
<tr>
<td>6</td>
<td>6 (100%)</td>
</tr>
<tr>
<td>Peak Current Time (Seconds)</td>
<td>2</td>
</tr>
<tr>
<td>Foldback Time Constant (Seconds)</td>
<td>12</td>
</tr>
</tbody>
</table>

Table 3
B.2 Current Limiting Algorithm

In order to understand the current limiting algorithm used by digital servo drives, it is necessary to first understand the different current limiting regions. The graph in Figure B.1 breaks the available current into three different regions.

**Current Limiting Regions**

- **Continuous Region**: The commanded current is less than or equal to the continuous current limit. The available current is equal to the commanded current.
- **Peak Region**: The commanded current is between the continuous and peak current limits. The available current is equal to the commanded current for a limited time (Peak Time).
- **Foldback Region**: Commanded current is between the continuous and peak current limits of the drive. The available current is less than the commanded current. The available current decreases over time until it equals the continuous current limit. The rate of this decrease is equal to:

\[ \text{Slope} = \frac{I_p - I_c}{t_f} \]

- \(I_p\) Peak current limit
- \(I_c\) Continuous current limit
- \(t_f\) Foldback time

**FIGURE B.1 Current Limiting Regions**
B.2.1 Time-Based Peak Current Limiting

The full peak value of current is available to begin with. When a current command is equal to the peak current limit, the current begins to foldback to the continuous limit after $T_p$, following the same slope as given in Figure B.1 on page 98. Once the available current has reached the continuous current limit after $t_f$, the available current will be limited to the continuous current limit until the commanded current is dropped below the continuous level.

**FIGURE B.2 Time-Based Peak Current Limiting**

Current-Time

---

$\text{Current Limiting} / \text{Current Limiting Algorithm}$
B.2.2 Time-Based Non-Peak Current Limiting

When the commanded current is between the peak and continuous current limits, the available current will begin to foldback at the intersection with the slope from Figure B.2 on page 99. The larger the commanded current, the sooner the available current will begin to foldback.

**FIGURE B.3 Time-Based Non-Peak Current Limiting**
B.2.3 Time-Based Current Recovery

Initially, the full peak value of current is available. A commanded current above the continuous level causes the available current to foldback to the continuous level as shown in the first graph of Figure B.4. When the commanded current drops below the continuous current limit value ($A_1$ in the first graph), the available current will then begin to recover along the slope of the foldback line towards the peak current level, as shown in the second graph of Figure B.4. The relationship between the commanded current and the recovered current is given as:

$$A_2 = \frac{1}{2} A_1$$

Using this relationship, you can calculate the amount of time recovered, $\Delta t$, by using the following equation:

$$\Delta t = \frac{A_1}{2(I_p - I_c)}$$

**FIGURE B.4** Time-Based Current Recovery - Foldback and Commanded Current

Note that current must be commanded below the specified continuous value to start recovering from a foldback condition.
B.2.4 Charge-Based Peak Current Limiting

The charge is full to begin with. When a current greater than the continuous current limit is commanded, the charge begins to decay. The loss of charge is determined by the area under the curve as shown in Figure B.5. The larger the command, the faster the charge will decay. When the charge decreases to zero, the available current will be limited to the continuous current limit until the charge is restored.

**FIGURE B.5 Charge-Based Peak Current Limiting**
B.2.5 Charge-Based Non-Peak Current Limiting

When the commanded current is between the peak and continuous current limits, the commanded current will be available for a longer period when compared to limiting at peak command. Note that the slope of the line during foldback is the same for both cases.

**FIGURE B.6 Charge-Based Non-Peak Current Limiting**
B.2.6 Charge-Based Current Recovery

After losing some value of charge, the charge may be recovered when the commanded value is dropped less than the continuous current limit. The amount of charge recovered depends on the magnitude of the commanded current and the amount of time in which it is commanded. The amount of charge recovered can be calculated by measuring the area within the curve as shown during the charge recovery phase in Figure B.7.

**FIGURE B.7 Charge Recovery**
B.2.7 RMS Current Scaling

RMS Current Scaling uses the charge-based algorithm described above. The only difference is the value of the continuous current the drive is capable of outputting. The continuous RMS limit can be used when the motor is moving so that the electrical cycle frequency is greater than the upper frequency assigned to that drive. The upper frequency is typically around 5Hz or 150 RPM for a 4-pole motor. The continuous RMS value is the continuous DC value multiplied by the square root of two.

\[ I_{crms} = \sqrt{2} \cdot I_{cdc} \]

When the electrical cycle frequency drops below the upper frequency, the continuous current drops below the RMS value. When the motor is moving at slow speeds, the continuous current is equal to the DC value of the current.

**FIGURE B.8 RMS Current Limiting**
B.3 Calculating Current Limits

Availability of output current greater than continuous current depends on the level of an internal charge reservoir. Upon power-up, the drive begins with a full reservoir having a charge equal to:

\[ Q_P = 2(I_P - I_C)(t_P + t_F) \]

- \( Q_P \) = Peak Reservoir Charge
- \( I_P \) = Peak Current
- \( I_C \) = Continuous Current
- \( t_P \) = Peak Current Time
- \( t_F \) = Foldback Time Constant

A drive with a fully charged reservoir can always output peak current. However, any time the target output current goes above the Continuous Current setting of the drive the reservoir begins to discharge. The rate of discharge is given as:

For \( I_T > I_C \)

\[ 2(I_P - I_C)C/s \]

- \( I_T \) = Target Current (units of amps)
- \( C \) = coulombs
- \( s \) = seconds

Once the reservoir discharges past a threshold necessary to output peak current, the amount of current available to output begins to foldback linearly (assuming hardware limits do not override software limits) from \( I_P \) to \( I_C \) according to the Foldback Time Constant \( (t_F) \).

When the reservoir becomes empty, no more than Continuous Current can be output by the drive. The peak current threshold can be calculated as:

\[ Q_{Th} = (Q_P \times t_F) / (t_P + t_F) \]

which is simply the amount of charge that would be depleted over a complete current foldback. The reservoir recharges (up to a maximum of \( Q_P \)) anytime the target output current drops below the Continuous Current setting. The rate of charge depends upon how far the target output current is below the Continuous Current as given by:

For \( I_T < I_C \)

\[ (I_C - I_T)C/s \]

As a result, the reservoir will recharge most rapidly when the target output current is zero (no command or drive inhibited).
B.3.1 Example 1: Foldback Current

What is the output current of a drive enabled in the foldback state (0 < Q < Q_{Th}) if the drive is configured according to the parameters in “Table 2” on page 96? Assume that the charge reservoir has been tracked since power-up and is known to be half empty (Q = Q_p/2) at the instant it is enabled. Because current limits are set within hardware limits the current foldback will be linear and easily represented by the first order equation:

For 0 < t < t_x,

\[ I_F = Mt + I_0 \]

- \( I_F \) = the foldback current
- \( M \) = the rate of foldback
- \( t \) = is time (drive enabled at \( t = 0 \))
- \( I_0 \) = the initial current output

Starting with \( I_0 \), the initial amount of current available beyond continuous current will be the maximum difference between peak and continuous current (\( I_P - I_C \)) weighed against the percentage of charge \( Q \) available relative to \( Q_{Th} \). Using \( I_C \) as a baseline, this is formulated as,

For 0 < Q < Q_{Th},

\[ I_0 = (I_P - I_C)Q/Q_{Th} + I_C \]

Taking the drive parameters of Table 2, \( I_0 \) is calculated as follows.

\[
I_0 = (I_P - I_C) \times \left[ (Q_p/2)/[(Q_p \times t_p)/(t_p + t_F)] \right] + I_C \\
= (12 - 6) \times (2 + 5)/10 + 6 \\
= 10.2 \text{ A.}
\]

The rate of foldback can be formulated as

\[ M = (I_C - I_P)/(t_F) \]

Again using the parameters of Table 2, this gives \( M = (6 - 12)/5 = -1.2 \). Lastly, we need to calculate the time at which foldback ends. Knowing that foldback always ends with \( I_C \), we can use the line equation we just generated to calculate \( t_x \) by solving for time as follows:

\[
t_x = (I_F - I_0)/M \\
= (6 - 10.2)/-1.2 \\
= 3.5
\]

Combining all our results, this yields the formula:

For 0 < t < 3.5,

\[ I_F = -1.2t + 10.2. \]
B.3.2 Example 2: Peak Current Recovery

If recovery time is the only interest, there's an easy way to calculate the amount of time required to recover maximum peak current. This is shown in the following example.

How long will it take to recover maximum peak current on a drive which, from power-up, is depleted for $t_D$ seconds, where $t_D < t_p + t_f$?

Assume the current command is initially held at a constant current of $I_H$, where $I_H > I_C$, for $t_D$ seconds and then held constant at $I_L$, where $I_L < I_C$, for $t_R$ seconds. These parameters are illustrated as:

- Depletion of the reservoir always happens at the rate $2(I_P - I_C)$ which means the amount of charge depleted over $t_D$ will be $Q_D = 2(I_P - I_C) \times t_D$.
- Similarly, for a recharge time of $t_R$, the charge recovered will be $Q_R = (I_C - I_L) \times t_R$.

In order to fully recharge the reservoir, the amount of charge depleted must match the amount recovered such that $Q_R = Q_D$ or $(I_C - I_L)t_R = 2(I_P - I_C)t_D$. The final step is to solve for $t_R$ as shown below.

$$t_R = \frac{2(I_P - I_C)t_D}{(I_C - I_L)}$$

The concept of peak current recovery can be approached a little differently by matching the area of two squares. This method tends to be more intuitive and is easy to visualize. The previous figure illustrates a typical current limiting envelope (in red) with an example current command (in green) and two square areas marked $A_D$ and $A_R$. Note that the area of $A_D$ is equal to $(I_P - I_C) \times t_D$ while the area of $A_R$ is equal to $(I_C - I_L) \times t_R$. Now, from Example 2, we know that the charge recovered should match the charge depleted. Given this, we can equate areas as given below:

- $Q_R = Q_D$
- $(I_C - I_L)t_R = 2(I_P - I_C)t_D$
- $A_R = 2A_D$

Thus, in order to completely recover peak current, the area of the square $(I_C - I_L) \times t_R$ must double the area of the square $(I_P - I_C) \times t_D$. 
The following diagram shows how the various PID and feed-forward terms are implemented in the control loop for Position around Velocity around Current (Torque) tuning. Other drive configurations are possible as well.
The velocity loop feedback filter uses a single pole low-pass filter to attenuate changes in velocity feedback. This helps to avoid responding to high frequency "spikes" in velocity, resulting in a smoother response to velocity commands.
D.1 Effects of the Feedback Filter

The figures below show how the filter affects measured velocity and, in turn, motor response. For this example, a 10Hz, 100,000-count/sec sine wave is commanded by the drive. This will be considered the worst-case move required for the application. The motor uses a 2000 line encoder, and has a low inertia load coupled to the motor shaft. The current loop and velocity loop gains are tuned aggressively for a fast response.

D.1.1 Cutoff Frequency Set to Infinite

![Graph showing velocity profile with infinite cutoff frequency.]

With no feedback filter, the velocity measured and velocity feedback are equal. The velocity loop responds instantly to all measured changes in velocity. The resulting velocity profile is distorted. A loud audible noise is heard from the motor.

D.1.2 Cutoff Frequency Set to 300Hz

![Graph showing velocity profile with 300Hz cutoff frequency.]

At this level, the audible noise is no longer present and the response is smooth. The two waveforms are nearly identical. This is the optimum setting because it results in no distortion and no phase lag.
D.1.3 Cutoff Frequency Set to 50Hz

At this level, the response is still smooth, but phase lag is apparent as the two waveforms begin to separate.

D.1.4 Cutoff Frequency Set to 10Hz

With the cutoff frequency set to 10Hz, there is an obvious difference between the two waveforms. The response is also noticeable in the motor shaft. The phase lag results in the motor motion becoming unstable.

D.2 Conclusion

The velocity loop cutoff frequency filter allows you to tune with higher velocity loop gains, which results in a faster response. Most applications will benefit from a velocity feedback filter cutoff frequency between 50Hz and 1500Hz. Too high of a cutoff frequency may result in audible noise from the motor. Too low of a cutoff frequency will cause significant phase lag and may lead to instability. The cutoff frequency should be adjusted during velocity loop tuning. For the worst-case move, the motor should follow the command smoothly, and there should be little or no phase lag between the velocity feedback and velocity measured traces.
E.1 Setup Software Safety Actions

The following table provides a brief explanation of how certain safety actions are effected in the drive hardware and software configuration.

<table>
<thead>
<tr>
<th>Drive Safety Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disable Bridge</td>
<td>No power is delivered to the motor. Motor is allowed to move freely.</td>
</tr>
<tr>
<td>Dynamic Brake</td>
<td>Motor leads are shorted together internally. The drive regulates the switching of the bottom side power devices to protect the motor from over current.</td>
</tr>
<tr>
<td>Apply Brake</td>
<td>This event action activates the Brake Active event which is typically mapped to a programmable digital output. This output is used to indicate when an external brake should be active in a system.</td>
</tr>
</tbody>
</table>

E.2 Potential External System Errors

The following is a list of potential non-drive-related system errors, and how the setup software and drive are equipped to automatically protect drive hardware.

<table>
<thead>
<tr>
<th>System Error</th>
<th>Drive Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Loss of Logic Power</td>
<td>The bridge will be disabled. The brake output device will open, engaging the brake.</td>
</tr>
<tr>
<td>Loss of Supply and Logic Power</td>
<td>The bridge will be disabled. The brake output device will open, engaging the brake.</td>
</tr>
<tr>
<td>Logic Power is too Low</td>
<td>The bridge will be disabled. The brake output device will open, engaging the brake.</td>
</tr>
<tr>
<td>Communication Connection is Disconnected</td>
<td>Results in a &quot;Communication Channel Error&quot;, which should be configured by the user for Dynamic Brake (or Disable Bridge). The brake output device will open, engaging the brake. The timeout value and host watchdog must be properly configured by the host/controller.</td>
</tr>
<tr>
<td>Communication Signal Times Out</td>
<td>Results in a &quot;Communication Channel Error&quot;, which should be configured by the user for Dynamic Brake (or Disable Bridge). The brake output device will open, engaging the brake. The timeout value and host watchdog must be properly configured by the host/controller.</td>
</tr>
<tr>
<td>Encoder/Halls Cable is Disconnected</td>
<td>If Hall Sensors are disconnected, will result in a &quot;Hall State Error&quot;. The drive will fail Phase Detect on power up, and result in a &quot;Phase Detect Error&quot;. If the encoder cable becomes disconnected while motion is commanded, a following error or continuous current foldback event will result, depending on the configuration and command. Faults should be configured by the user for Dynamic Brake or Disable Bridge.</td>
</tr>
<tr>
<td>Faulty Encoder Signals</td>
<td>Results in a &quot;Phase Synchronization Error&quot;, which should be configured by the user for Dynamic Brake or Disable Bridge.</td>
</tr>
<tr>
<td>Disconnected Motor Wires</td>
<td>The drive does not directly detect that the motor wires are disconnected. The &quot;Current Loop Saturated&quot; and following error faults are secondary errors that are generated. It is recommended to use the faults as a possible indication of a disconnected motor.</td>
</tr>
</tbody>
</table>
The following is a list of possible drive events and I/O signals, a brief description of the cause, issue, or behavior, and some recommended actions to take to remove the event if necessary.

<table>
<thead>
<tr>
<th>Event</th>
<th>Description</th>
<th>Likely Cause</th>
<th>Recommended Actions</th>
</tr>
</thead>
</table>
| Absolute Position Valid    | An absolute motor position has been established by one of the drive’s positioning methods.                  | 1) A homing routine has been initiated and completed successfully  
2) An absolute position has been established by execution of the Set Position command  
3) Phase Detect routine has completed successfully (only applies to drives with absolute feedback devices) | Status Only, no action needed.                                              |
| At Command                 | Velocity Mode: The measured velocity has reached the target velocity, within the At Velocity Window.  
Position Mode: The measured position has reached the target position, within the In-Position Window.  
Torque Mode: The measured current is within range of the target current. In general, the At Command window will be 1/100 of the hardware peak current limit. | The drive has reached the commanded position within the range of the At Command window. | Status Only, no action needed.                                                                 |
| Brake Active               | A drive event may be configured to activate an external brake. This is accomplished by assigning the event action and by assigning a digital output to “Apply Brake”. | The drive’s Apply Brake action is enabled. If assigned to a digital output, the digital output will be active also. This occurs when an active event has its action assigned to Apply Brake.  
Note: SynqNet drives control the brake through the SynqNet interface. | Check all active events. Check the settings for the event actions to see which event actions are assigned to Apply Brake. |
| Bridge Active              | The drive’s power bridge is enabled.                                                                                | The drive has been enabled.                                                                                                     | Status Only, no action needed.                                              |
| Capture Complete           | The Capture routine has completed.                                                                                             | The High Speed Capture function has been initiated and completed successfully.                                  | Status Only, no action needed.                                              |
| Command Limiter Active     | The command is currently being profiled by the Command Limiter.                                                         | The Command Limiter has been enabled.                                                                                   | Status Only, no action needed.                                              |
| Communication Channel Error| The drive has experienced an interruption of communication on the communications interface. Note: Normal setup software communication interruption/loss will not trigger this error.  
RS485/232:  
If the drive is configured via index 0x04 for heartbeat this error will be thrown if the consumer heartbeat time is not reset within the defined time interval.  
CAOpen:  
If the drive is configured for node / life guarding, the event will be thrown if the drive does not receive a node guard pulse within the specified time interval.  
If configured for heartbeat, the drive will throw the error if the host fails to reset the timer within the specified time interval.  
EtherCAT:  
The EtherCAT RPDO watchdog has been activated. This occurs when EtherCAT state machine is operational and the drive has not received an RPDO in more than 10 cycles.  
If configured for heartbeat, the drive will throw the error if the host fails to reset the timer within the specified time interval. | The drive has experienced an interruption of communication on the communications interface. Note: Normal setup software communication interruption/loss will not trigger this error.  
RS485/232:  
If the drive is configured via index 0x04 for heartbeat this error will be thrown if the consumer heartbeat time is not reset within the defined time interval.  
CAOpen:  
If the drive is configured for node / life guarding, the event will be thrown if the drive does not receive a node guard pulse within the specified time interval.  
If configured for heartbeat, the drive will throw the error if the host fails to reset the timer within the specified time interval.  
EtherCAT:  
The EtherCAT RPDO watchdog has been activated. This occurs when EtherCAT state machine is operational and the drive has not received an RPDO in more than 10 cycles.  
If configured for heartbeat, the drive will throw the error if the host fails to reset the timer within the specified time interval. | 1) Communication cable has been disconnected  
2) Host software has not been properly initialized  
1) Check communication cable connections  
2) Check to ensure host software is properly initialized. |
| Configuration Select       | The active drive Configuration has switched.                                                                            | A digital input has been configured to switch drive Configurations.                                                                                     | Status Only, no action needed.                                              |
| Continuous Current Foldback| The drive has been commanded to output greater than continuous current and has folded back to the continuous value. The peak and continuous currents will be either the software or hardware limits. When this event is active, the drive is supplying continuous current. | The drive current has folded back to the continuous value.                                                                                         | This is application dependent. Default event action is "no action" which is informational only.  
Can be configured to perform an event action (i.e. disable bridge). |
| Current Limit Active       | The drive is applying current limiting based on the software settings specified, or is limiting according to the hardware limits of the drive. | The drive is being commanded to output current that exceeds software or hardware limits.  
This is application dependent. Default event action is "no action" which is informational only.  
Can be configured to perform an event action (i.e. disable bridge). | This is application dependent. Default event action is "no action" which is informational only.  
Can be configured to perform an event action (i.e. disable bridge). |
<table>
<thead>
<tr>
<th>Event</th>
<th>Description</th>
<th>Likely Cause</th>
<th>Recommended Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current Loop Saturated</td>
<td>The PWM output is at maximum duty cycle, and cannot deliver any more current under the given conditions.</td>
<td>1) The bus voltage is insufficient for a given motor / current level</td>
<td>1) Make sure there is sufficient bus voltage.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2) The motor's resistance is high</td>
<td>2) Make sure motor resistance is not high.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3) The motor leads are not properly connected</td>
<td>3) Turn the power off and make sure the motor leads are properly connected.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>4) The logic supply voltage is outside of the specified tolerance for the drive</td>
<td>4) Measure the logic supply voltage and compare to the allowed logic supply tolerance for the drive</td>
</tr>
<tr>
<td>Drive Internal Error</td>
<td>The drive has experienced an internal error while executing its firmware.</td>
<td>Defective drive</td>
<td>Contact technical support.</td>
</tr>
<tr>
<td>Drive Over Temperature</td>
<td>The drive has reached its maximum allowed temperature. The drive will disable when this occurs, and will be re-enabled when sufficiently cooled.</td>
<td>1) Inadequate heat sinking / ventilation</td>
<td>1) Ensure adequate heat sinking / ventilation.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2) Excessive and repeated overcurrents</td>
<td>2) Ensure that motor exceeds minimum inductance requirements.</td>
</tr>
<tr>
<td>Drive Reset</td>
<td>The drive's internal processor was reset. NOTE: This event will occur every time the drive is power cycled.</td>
<td>1) The drive was power cycled</td>
<td>1) None if the drive was power cycled (status only)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2) A glitch in power caused a processor reset</td>
<td>2) Check logic power coming to drive.</td>
</tr>
<tr>
<td>Dynamic Brake Active</td>
<td>A drive event may be configured to activate the dynamic brake. This is accomplished by assigning the event action and by assigning a digital output to &quot;Dynamic Brake&quot;.</td>
<td>The drive’s Dynamic Brake action is enabled. If assigned to a digital output, the digital output will be active also. This occurs when an active event has its action assigned to Dynamic Brake.</td>
<td>Check all active events. Check the settings for the event actions to see which event actions are assigned to Dynamic Brake.</td>
</tr>
<tr>
<td>Feedback Sensor Error</td>
<td>1) For a resolver drive, indicates that the resolver signals are excessively noisy or outside of the range required by the drive. 2) For sin/cos indicates the sin/cos signals are excessively noisy or the product of the sin and cos signals is outside of the range required by the drive. Note that Feedback Sensor Error does not trigger for Brush type motors using Sin.Cos feedback.</td>
<td>Resolver: 1) Resolver not connected 2) Faulty grounding / shielding of feedback connector 3) Resolver specs don't match drive Sin/Cos: 1) Sin/Cos encoder not connected 2) Faulty grounding / shielding of feedback connector</td>
<td>Resolver: 1) Check resolver connection 2) Check grounding / shielding of feedback connector 3) Check resolver specs against drive specs Sin/Cos: 1) Check the amplitude of sin/cos signals coming into drive 2) Check grounding / shielding of feedback connector</td>
</tr>
<tr>
<td>Gain Select</td>
<td>The active drive Gain Set has switched. A digital input has been configured to switch Gain Sets.</td>
<td>Status Only, no action needed.</td>
<td>Status Only, no action needed.</td>
</tr>
<tr>
<td>Hall State Error</td>
<td>The drive is seeing an invalid Hall state on the Hall sensor inputs. Note that this event is only valid when Hall sensors are used. Invalid Hall states are as follows where each binary digit represents a Hall sensor input. Hall sensor inputs are either high (1) or low (0). 120 degree phasing: -111 (7 in decimal representation) -000 (0 in decimal representation) 60 degree phasing: -101 (5 in decimal representation) 010 (2 in decimal representation)</td>
<td>1) Broken or disconnected Hall sensor(s)</td>
<td>1) Check hall sensor wiring 2) Move the motor by hand and verify that each of the individual Hall sensors are changing. If one or more of the Hall sensors are not changing, this could mean the Hall sensor is bad.</td>
</tr>
<tr>
<td>High Speed Capture</td>
<td>The High Speed Capture Function has been activated.</td>
<td></td>
<td>Status Only, no action needed.</td>
</tr>
<tr>
<td>Home Active</td>
<td>The drive's internal homing routine is active.</td>
<td>Homing was invoked either through a digital input, network interface, or the setup software.</td>
<td>Status Only, no action needed.</td>
</tr>
<tr>
<td>Home Done</td>
<td>The drive's internal homing routine has finished successfully.</td>
<td>Homing was invoked and completed.</td>
<td>The start homing command (invoked with digital input, network interface, or setup software) can now be removed.</td>
</tr>
<tr>
<td>Home Execute</td>
<td>The Homing routine has been activated.</td>
<td>The drive was commanded to execute a Home command either through a digital input, network interface, or the setup software.</td>
<td>Status Only, no action needed.</td>
</tr>
<tr>
<td>In Home Position</td>
<td>The motor is in the home position.</td>
<td>The motor is in the home position.</td>
<td>Status only, no action needed.</td>
</tr>
<tr>
<td>Index Active</td>
<td>An Index motion task is currently active and has control of the axis. No other motion tasks can be executed while this is active.</td>
<td></td>
<td>Status only, no action needed.</td>
</tr>
<tr>
<td>Index Busy</td>
<td>An Index motion task is currently active and has control of the axis. No other motion tasks can be executed while this is active.</td>
<td></td>
<td>Status only, no action needed.</td>
</tr>
<tr>
<td>Index Done</td>
<td>The Index motion task has completed, including dwell time, and no longer has control of the axes.</td>
<td></td>
<td>Status only, no action needed.</td>
</tr>
<tr>
<td>Event</td>
<td>Description</td>
<td>Likely Cause</td>
<td>Recommended Actions</td>
</tr>
<tr>
<td>------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------------</td>
<td>---------------------------------------</td>
</tr>
<tr>
<td>Index Motion Done</td>
<td>An index motion task has reached the target position for the task. The axis may still be in motion depending on the system. No other motion tasks can be executed while this is active.</td>
<td>The drive was commanded to execute an index task either through a digital input, network interface, or the setup software.</td>
<td>Status only, no action needed.</td>
</tr>
<tr>
<td>Jog Active</td>
<td>A jog task is currently active and has control of the axis. No other motion tasks can be executed while this is active.</td>
<td>The drive was commanded to execute a jog task either through a digital input, network interface, or the setup software.</td>
<td>Status only, no action needed.</td>
</tr>
<tr>
<td>Jog Forward</td>
<td>The Jog Forward Task is currently active.</td>
<td>The drive was commanded to execute a Jog Forward task either through a digital input, network interface, or the setup software.</td>
<td>Status only, no action needed.</td>
</tr>
<tr>
<td>Jog Reverse</td>
<td>The Jog Reverse Task is currently active.</td>
<td>The drive was commanded to execute a Jog Reverse task either through a digital input, network interface, or the setup software.</td>
<td>Status only, no action needed.</td>
</tr>
<tr>
<td>Log Entry Missed</td>
<td>The drive attempted to write to the fault log counter, but was unable to.</td>
<td>An internal error prevented the drive from writing to the fault log counter.</td>
<td>If error persists, contact technical support.</td>
</tr>
<tr>
<td>Maximum Measured Position Limit</td>
<td>The measured position has exceeded the maximum value set by software. The Max Measured Position Limit can be found in the Limits and Events &gt; Position Limits tab. NOTE: THE LIMITS ARE DISABLED VIA SOFTWARE BY DEFAULT; VALID ONLY IF &quot;DISABLE POSITION LIMITS CHECK BOX IN THE POSITION LIMITS TAB IS UNCHECKED.</td>
<td>The measured position exceeds the measured position limit.</td>
<td>This is application dependent. Default event action is 'no action' which is informational only. Can be configured to perform an event action (i.e. disable bridge).</td>
</tr>
<tr>
<td>Minimum Measured Position Limit</td>
<td>The measured position has exceeded the minimum value set by software. The Min Measured Position Limit can be found in the Limits and Events &gt; Position Limits tab. NOTE: THE LIMITS ARE DISABLED VIA SOFTWARE BY DEFAULT; VALID ONLY IF &quot;DISABLE POSITION LIMITS CHECK BOX IN THE POSITION LIMITS TAB IS UNCHECKED.</td>
<td>The resulting measured position exceeds the measured position limit.</td>
<td>This is application dependent. Default event action is 'no action' which is informational only. Can be configured to perform an event action (i.e. disable bridge).</td>
</tr>
<tr>
<td>Motion Engine Abort</td>
<td>The Motion Engine has aborted a motion task.</td>
<td>The Motion Engine has been stopped via a digital input.</td>
<td>Status only, no action needed.</td>
</tr>
<tr>
<td>Motion Engine Error</td>
<td>The Motion Engine is in a fault state.</td>
<td>1) A disabling event may be present that is preventing the bridge from enabling or not allowing motion to occur.</td>
<td>1) Check the Drive Status panel and the Status Bar to see if any events are causing a disabling action. 2) Run the homing routine. 3) Examine all saved Sequences for flagged errors.</td>
</tr>
<tr>
<td>Motion Engine Executing</td>
<td>The Motion Engine is enabled and running a motion task.</td>
<td>The Motion Engine was commanded to run a motion task in the setup software either via the toolbar, a digital input, enable on Power-up, or through the network.</td>
<td>Status only, no action needed.</td>
</tr>
<tr>
<td>Motor Over Speed</td>
<td>The motor's measured velocity is higher than the motor overspeed limit set by software. The Motor Over Speed value can be found in the Limits and Events &gt; Velocity Limits tab.</td>
<td>1) The drive is in current mode and the commanded current results in the motor spinning faster than the specified maximum velocity. 2) The limit is set too low 3) Excessive noise on feedback 4) Improper grounding / shielding of feedback cable</td>
<td>1) Make sure motor is connected to load. Do not command a current that will result in the motor spinning too fast. 2) Verify the limit is set properly. 3) Verify proper grounding / shielding of motor feedback cable</td>
</tr>
<tr>
<td>Motor Over Temperature</td>
<td>A digital input or analog input assigned to be a motor over temperature is signaling the drive that the motor's temperature has been exceeded.</td>
<td>1) The motor has overheated 2) The temperature cutoff defined in software is artificially low 3) The sensor is faulty and/or disconnected</td>
<td>1) Check the motor for overheating 2) Check to ensure temperature cutoff defined in software is correct 3) Check to ensure that motor temperature sensor is not faulty or disconnected</td>
</tr>
<tr>
<td>Negative Stop Active</td>
<td>A drive event may be configured to halt motion in the negative direction. This is accomplished by assigning the event action &quot;Negative Stop&quot; to a drive event.</td>
<td>The drive's Negative Stop action is enabled. If assigned to a digital output, the digital output will be active also. This occurs when an active event has its action assigned to Negative Stop.</td>
<td>Check all active events. Check the settings for the event actions to see which event actions are assigned to Negative Stop.</td>
</tr>
<tr>
<td>Event</td>
<td>Description</td>
<td>Likely Cause</td>
<td>Recommended Actions</td>
</tr>
<tr>
<td>--------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>--------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Negative Velocity Limit              | The measured velocity has exceeded the negative limit set by software.      | 1) The magnitude of the velocity target is greater than the Negative Velocity Limit  
2) The Negative Velocity Limit is too small for the velocity that is being commanded | This is application dependent. Default event action is 'no action' which is informational only.  
Can be configured to perform an event action (i.e. disable bridge). |
| Non-Sinusoidal Commutation           | The drive is operating in the non-sinusoidal commutation mode (trapezoidal). | 1) Drive is configured for a Brushed motor  
2) Drive is configured to use only Hall Sensor commutation (trapezoidal)  
3) Drive powered up in trapezoidal mode.  
Relative position has not yet been determined by the drive.  
4) A synchronization error resulted in the drive being unable to synchronize properly | 1) Status only, no action needed  
2) Status only, no action needed  
3) Status only, no action needed  
4) Check encoder and Hall Sensors or index for noise, or misalignment of Hall Sensors |
| Over Current                         | The measured output current has exceeded the drive's rated current.          | 1) Inductance of motor is below drive's minimum  
2) Noise  
3) Current loop is over-tuned | 1) Make sure motor inductance is above drive minimum  
2) Check system for excessive electrical noise  
3) Make sure current loop is not tuned too aggressively |
| Over Voltage                         | The HV voltage (not logic power) is above the maximum HARDWARE specified voltage. | 1) Excessive HV power supply  
2) Drive is experiencing excessive regeneration | 1) Ensure that HV voltage is below drive's maximum voltage rating  
2) Make sure a shunt regulator is installed and sized to efficiently shut off regenerative energy |
| Parameter Restore Error              | The drive encountered an error when reading project file parameters from the drive's non-volatile memory. | 1) Computed non-volatile memory  
2) Defective Drive | 1) Return firmware  
2) Contact technical support |
| Parameter Store Error                | The drive encountered an error when writing project file parameters from the drive's non-volatile memory. | 1) Computed non-volatile memory  
2) Defective Drive | 1) Return firmware  
2) Contact technical support |
| Phase Detect Active                  | The drive is going into phase detection mode to determine proper phasing for commutation. | Phase Detect was invoked through a power-up option, digital input, network interface, or the setup software. | Status Only, no action needed. |
| Phase Detect Done                    | The phase detection algorithm is complete.                                 | Phase Detect was invoked through a power-up option, digital input, network interface, or the setup software. | Status Only, no action needed. |
| Phase Detect Error                   | The drive was unable to correctly determine the proper phasing following a phase detect routine. | 1) Phase detect current is excessive  
2) Encoder wires broken / disconnected  
3) Phase detection motion insufficient | 1) Check encoder wiring  
2) Check to see if phase detection motion is excessive. Lower current if necessary |
| Phase Synchronization Error          | Indicates the number of counts seen by the drive between synchronization markers was not consistent with what had been determined during AutoCommutation and/or the initial parameters. VALID ONLY IF DRIVE IS COMMUTATING SINUSODALLY AND IS USING EITHER INDEX SYNCHRONIZATION OR HALL EDGE SYNCHRONIZATION. | 1) The drive is not commutating properly  
2) The feedback sensor is faulty  
3) Excessive system noise  
4) Poor grounding / shielding of feedback cable | 1) Check to make sure commutation is established properly using AutoCommutation feature in the setup software  
(a) Check encoder feedback parameters (i.e, line count / rev)  
(b) Check for correct motor pole count  
2) Check to ensure that the feedback sensor is operating properly  
3) Check for excessive system noise  
4) Inspect for poor grounding / shielding of feedback cable |
| Position Following Error             | The measured position is outside of the position following error window defined in the software. | The magnitude of the difference between the position measured and the position target is greater than the Position Following Error value | This is application dependent. Can be configured to perform an event action (i.e. disable bridge). |
| Positive Stop Active                 | A drive event may be configured to halt motion in the positive direction. This is accomplished by assigning the event action "Positive Stop" to a drive event. | The drive's Positive Stop action is enabled. If assigned to a digital output, the digital output will be active also. This occurs when an active event has its action assigned to Positive Stop. | Check all active events. Check the settings for the event actions to see which event actions are assigned to Positive Stop. |
| Positive Velocity Limit              | The measured velocity has reached the positive velocity limit set by software. | 1) The velocity target is greater than the Positive Velocity Limit  
2) The Positive Velocity Limit is set too low for the velocity being commanded | This is application dependent. Default event action is 'no action' which is informational only.  
Can be configured to perform an event action (i.e. disable bridge). |
| PVT Buffer Empty                     | The PVT point buffer has no points in it. VALID ONLY IF COMMAND SOURCE IS PVT. | 1) The PVT point buffer has had no points sent to it | This is application dependent. Default event action is 'no action' which is informational only.  
Can be configured to perform an event action (i.e. disable bridge). |
| PVT Buffer Empty Stop                | The PVT buffer ran out of points and motion is stopped. VALID ONLY IF COMMAND SOURCE IS PVT. | 1) The drive ran out of points before seeing a PVT stop point  
2) The stop point sent down was not correct | 1) Make sure points are sent down continuously  
When motion is to be stopped, a PVT stop point is sent. |
<p>| PVT Buffer Failure                   | There is a failure in the PVT Buffer. VALID ONLY IF COMMAND SOURCE IS PVT. | The drive disabled while executing motion. | Check the drive status to see if there are any events causing the drive to disable. |
| PVT Buffer Full                      | The PVT point buffer has 16 points in it. VALID ONLY IF COMMAND SOURCE IS PVT. | 1) The PVT point buffer has been filled prior to a motion starting | Do not send more points down until PVT motion is started. |
| PVT Buffer Threshold                 | The drive has consumed points and has made the transition threshold that has been defined. VALID ONLY IF COMMAND SOURCE IS PVT. | The drive is expecting more points to be sent down. | Send more PVT Points. |</p>
<table>
<thead>
<tr>
<th>Event</th>
<th>Description</th>
<th>Likely Cause</th>
<th>Recommended Actions</th>
</tr>
</thead>
</table>
| PVT Sequence Number Error      | The drive has detected a sequence number error.  VALID ONLY IF COMMAND SOURCE IS PVT. | 1) User has sent down a PVT point with a discontinuous sequence number  
2) User sent two points with the same sequence number | Make sure the sequence number of the PVT point is correct. |
| PWM/DIR Broken Wire            | The drive has detected a PWM duty cycle input of 0% or 100%.  VALID ONLY IF COMMAND SOURCE IS CONFIGURED FOR PWM. | 1) Broken or disconnected PWM or Direction wire  
2) PWM frequency below drive's minimum value | 1) Check for broken or disconnected PWM or Direction wire  
2) Check to ensure that PWM frequency is above drive minimum value (typically 1kHz). |
| Registration Invalid           | Indicates no valid registration event was found in the defined target distance for the Registration Index Task. | No valid registration event was found within the Registration Limit Distance or Registration Window. | 1) Check that a valid registration event is set to occur within the Registration Limit Distance or registration window. |
| Reset Events                   | The Drive Status Panel event states have been reset.                        | The drive was commanded to execute a Reset Events command either through a digital input, network interface, or the setup software. | Status only, no action needed. |
| Set Position                   | The Set Position function has set the target position and measured position to the Preset Position value. | The drive was commanded to execute a Set Position command either through a digital input, network interface, or the setup software. | Status only, no action needed. |
| Set/Reset Capture A            | The Capture A function has been Set/Reset.                                  | The drive was commanded to execute a Set/Reset Capture command either through a digital input, network interface, or the setup software. | Status only, no action needed. |
| Set/Reset Capture B            | The Capture B function has been Set/Reset.                                  | The drive was commanded to execute a Set/Reset Capture command either through a digital input, network interface, or the setup software. | Status only, no action needed. |
| Set/Reset Capture C            | The Capture C function has been Set/Reset.                                  | The drive was commanded to execute a Set/Reset Capture command either through a digital input, network interface, or the setup software. | Status only, no action needed. |
| Sequence Active                | A motion task Sequence is currently active and has control of the axis. No other motion tasks can be executed while this is active. | The drive was commanded to execute a Sequence either through a digital input, network interface, or the setup software. | Status only, no action needed. |
| Sequence Done                  | The motion task Sequence has completed, including dwell time and no longer has control of the axis. | The drive was commanded to execute a Sequence either through a digital input, network interface, or the setup software. | Status only, no action needed. |
| Short Circuit                  | The drive has detected that there is an insufficient amount of resistance between the motor leads and ground. | 1) Inductance of motor is below drive's minimum  
2) Noise  
3) Short in the motor windings  
4) Defective power component in power section of drive | 1) Make sure motor inductance is above drive minimum  
2) Check system for excessive electrical noise  
3) Check for a short across the motor phases  
4) Contact technical support |
| Shunt Regulator Active         | The shunt regulator is active (if equipped).                                | 1) The drive is performing a regenerative operation and has engaged the shunt regulator  
2) Shunt turn on voltage is at or below nominal bus voltage | 1) Status Only, no action needed  
2) Check to make sure that the shunt turn on voltage is not set too low |
| Software Disable               | The drive has been commanded to disable via the communications channel or by clicking on the enable/disable icon on the toolbar. A Software Disable can also occur if the drive is configured to disable on power up. | A fault occurred or the host told the drive to disable the bridge. | 1) Check to see if the host disabled the drive  
2) Look for the presence of other faults  
3) Check if bridge state is Disabled on power up |
| Software Negative Limit        | Indicates the drive was commanded to disable the negative direction.       | Host commanded a Negative Limit over serial. | Verify if a Software Negative Limit is being commanded over the network. |
| Software Over Voltage          | The HV voltage (not logic power) is above the maximum SOFTWARE specified voltage. | 1) Drive is experiencing excessive regeneration  
2) The software 'Over Voltage Limit' is set too low | This is application dependent. Default event action is 'no action' which is informational only. Can be configured to perform an event action (i.e. disable bridge). |
| Software Positive Limit        | Indicates the drive was commanded to disable the positive direction.       | Host commanded a Positive Limit over serial. | Verify if a Software Positive Limit is being commanded over the network. |
| Software Stop                  | The drive was commanded to perform a Stop.                                 | An event action has been configured to perform a 'stop' when the event occurs. | 1) If in response to an event action, check to see what event caused this response.  
2) If commanded via network interface, then this is informational. |
| Software Under Voltage         | The HV voltage (not logic power) is below the minimum SOFTWARE specified voltage. | 1) The HV voltage is disconnected  
2) The power is off  
3) The software 'Under Voltage Limit' is set too high | This is application dependent. Default event action is 'no action' which is informational only. Can be configured to perform an event action (i.e. disable bridge). |
<p>| Stop Active                    | A drive event may be configured to halt motion. This is accomplished by assigning the event &quot;Stop&quot; to a drive event. | The drive's Stop action is enabled, if assigned to a digital output, the digital output will be active also. This occurs when an active event has its action assigned to Stop. | Check all active events. Check the settings for the event actions to see which event actions are assigned to Stop. |</p>
<table>
<thead>
<tr>
<th>Event</th>
<th>Description</th>
<th>Likely Cause</th>
<th>Recommended Actions</th>
</tr>
</thead>
</table>
| Under Voltage    | The HV voltage (not logic power) is below the minimum HARDWARE specified voltage. | 1) Insufficient power supply  
2) HV power is disconnected | 1) Ensure that HV voltage is above drive's minimum voltage rating  
2) Ensure HV power is connected  
3) Verify HV voltage is stable and does not drop, even momentarily, during system operation |
| User Aux. Disable| The drive has been commanded via a digital input to disable the drive.       | The User Aux. Disable input has been asserted.                               | 1) Verify under what system conditions the user-configured digital input will assert a User Aux. Disable.  
2) Verify that the digital input mapped to User Aux. Disable is wired correctly to the drive.  
3) Check to see that the input polarity for the digital input is configured correctly for the system (i.e. does the active low checkbox need to be checked?) |
| User Disable     | The drive has been disabled by a user-configured digital input.              | A digital input has been configured to disable the bridge.                   | 1) Verify under what system conditions the user-configured digital input will disable the bridge  
2) Verify that the user-configured digital input is wired correctly to the drive  
3) Check to see that the input polarity for the user-configured digital input is configured correctly for the system (i.e. does the active low checkbox need to be checked?) |
| User Negative Limit | The drive has hit a negative limit switch. A digital input must be configured to be a negative limit. | The axis has reached the physical end of travel and has hit a mechanical limit switch. | Clear the axis away from the limit switch. |
| User Positive Limit | The drive has hit a positive limit switch. A digital input must be configured to be a positive limit. | The axis has reached the physical end of travel and has hit a mechanical limit switch. | Clear the axis away from the limit switch. |
| User Stop        | A digital input has been assigned to perform a 'Stop' when asserted.        | A digital input triggered a Stop.                                            | 1) Ensure that a Stop was commanded via digital input. |
| Velocity Following Error | The difference between the target and measured velocity is outside of the velocity following error window defined in the software. | 1) The magnitude of the difference between the velocity measured and the velocity target is greater than the Velocity Following Error value  
2) The Velocity Following Error value is too small | This is application dependent. Default event action is 'no action' which is informational only. Can be configured to perform an event action (i.e. disable bridge). |
| Zero Velocity    | The measured motor velocity is within the Zero Velocity window as defined in the Velocity Limits. | The motor is not moving.                                                     | Status only, no action needed. |
Index Motion Done .......... 117
Indexing Tasks .............. 71
Input Type ................... 18
Integral Gain
   current loop tuning ....... 54
   velocity loop tuning ..... 65
Interface input .............. 18

J
Jog Active ................. 117
Jogs .................... 75

L
Latch ..................... 43
Limit Envelope ............. 94
Limits ..................... 38
Log Entry Missed .......... 117
Loop Configuration ........ 16

M
Manual Commutation ...... 59
Max Measured Position Limit . 117
Max Phase Detection Motion .. 63
Maximum Target Position ..... 117
Menu ....................... 3
Min Measured Position Limit .. 117
Minimum Target Position .... 117
Motion Engine Abort ...... 117
Motion Engine Error ...... 117
Motion Engine Executing ... 117
Motor
   rotation direction ... 22
Motor Over Speed .......... 117
Motor Over Temp. .......... 117
Motor Parameters .......... 22
Motor Ratings
   see Motor/Feedback
   Motor Selection .......... 22
Multimeter ............... 3, 84
   signal definitions ....... 88

N
Negative Stop .............. 43
Negative Velocity Limit .. 118
Network Settings .......... 45
No Action .................. 43
No Command ............... 16
Non-Sinusoidal Commutation 118

O
Open ...................... 3, 6
Oscilloscope ............... 80
   signal definitions ....... 88
Over Current .............. 118
Over Voltage .............. 118

P
Parameter Restore Error ... 118
Parameter Store Error ...... 118
PDO Configuration .......... 46, 47
Peak Current Time .......... 94
Phase Detect ............... 62–63
   max phase detection motion .... 63
   Phase Detect Active .......... 118
   Phase Detect Done .......... 118
   Phase Detect Error .......... 118
   Phase Sync. Error .......... 118
   Position Following Error .... 118
   Position Loop
      around torque ............ 66
      around velocity .......... 66
      command limiter control ... 19
      tuning .................. 66
   Position Measured .......... 67
   Position Target .......... 67
   Positive Stop ............ 43
   Positive Velocity Limit .... 118
   Power up or down the bridge .. 3
   Programmable Limit Switch ... 37
   Proportional Gain
      current loop tuning ....... 54
      velocity loop tuning ....... 64
      PVT Buffer Empty .......... 118
      PVT Buffer Empty Stop .... 118
      PVT Buffer Failure .......... 118
      PVT Buffer Full ............ 118
      PVT Buffer Threshold ...... 118
      PVT File Creation .......... 73
      PVT Generator ............. 73
      PVT Sequence Number ....... 119
      PWM & Direction .......... 17
      PWM/DIR Broken Wire .... 119

R
Recoveries ............... 44
Recovery Time .......... 44
Registration Invalid ...... 119
Restore .................. 3, 15
Rotation Direction .......... 22
RPDOs
   CANopen .................. 46
   EtherCAT ................. 47
   Ethernet Powerlink ...... 47

S
Safety .................. ii–iii
Sequence Active .......... 119
Sequence Done .......... 119
   Sequences ............... 75
Settings Menu ............. 3
Setup Panel ............... 4
Setup Software Files ...... 2
   Short Circuit ............ 119
   Shunt Regulator .......... 40–41
   Shunt Regulator Active ... 119
Signal Definitions ....... 88
   command limiter .......... 89
   commutation ............ 89
   current .................. 88
   deadband input .......... 90
   drive .................... 90
   interface input .......... 90
   position ................ 89
   temperature ............ 89
   torque .................. 90
   velocity ................. 88
   voltage ................. 89
Software Disable .......... 119
Software Negative Limit .. 119
Software Over Voltage .... 119
Software Positive Limit ... 119
Software Stop ............ 119
Software Under Voltage ... 119
Station Alias ............ 45
Status Bar ................ 4
Status Panel .............. 4
Step & Direction .......... 17
Stop ..................... 43
System Protection .......... 92
System Status .......... 92

T
Technical Support .......... 10
Time-Out ................. 44
Timer ................... 47
Toolbar .................. 3–4, 9
   icons .................... 3
   Tools Menu ............... 3
TPDO Events ............. 47
TPDOs
   CANopen .................. 46
   EtherCAT ................. 47
   Ethernet Powerlink ...... 47
   Tuning .................. 51
      position loop .......... 66
      velocity loop .......... 64

U
Under Voltage .......... 120
User Auxiliary Disable .... 120
User Disable ............ 120
User Negative Limit ...... 120
User Positive Limit ...... 120
User Stop ............... 120
User Units ............... 85

V
Value Changed .......... 47
Value Reached .......... 47
Velocity Following Error .. 120
Velocity Loop
   command limiter control ... 19
   feedback filter .......... 111–113
      derivative gain .......... 65
      feedback cutoff freq. ... 65
      feed-forward gain ....... 65
      integral gain .......... 65
      proportional gain ....... 64
   Velocity Measured ....... 64
   Velocity Target .......... 64
   View Menu ............... 4

W
Window Menu ............... 4
Z
Zero Velocity .......................... 120